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I Using This Online Manual

= Symbols Used in This Document
= Touch-enabled Device Users (Windows)

I Symbols Used in This Document

A Warning
Instructions that, if ignored, could result in death, serious personal injury, or property damage caused
by incorrect operation of the equipment. These must be observed for safe operation.

A\ Caution
Instructions that, if ignored, could result in personal injury or property damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

3% Important

Instructions including important information that must be observed to avoid damage and injury or
improper use of the product. Be sure to read these instructions.

»>» Note

Instructions including notes for operation and additional explanations.

Instructions explaining basic operations of your product.

»>» Note

* lcons may vary depending on your product.

I Touch-enabled Device Users (Windows)

For touch actions, you need to replace "right-click” in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."
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I Trademarks and Licenses

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

» Microsoft Edge is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, macOS, OS X, AirPort, App Store, AirPrint, the AirPrint logo, Safari, Bonjour, iPad, iPad
Air, iPad mini, iPadOS, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and
other countries.

» 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Drive, Google Apps
and Google Analytics are either registered trademarks or trademarks of Google Inc. Google Play and
Google Play Logo are trademarks of Google LLC.

» Adobe, Acrobat, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB
(1998) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

* Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

» Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its
subsidiaries and/or affiliates in the USA and/or other countries.

* QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and in other
countries.

* USB Type-C™ is a trademark of USB Implementers Forum.

» The Mopria® word mark and the Mopria® Logo are registered and/or unregistered trademarks of Mopria
Alliance, Inc. in the United States and other countries. Unauthorized use is strictly prohibited.

»» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2015 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS I1S" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
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NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,

OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License
Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by nhame)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work

and any modifications or additions to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or

Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this
definition, "submitted” means any form of electronic, verbal, or written communication sent to the
Licensor or its representatives, including but not limited to communication on electronic mailing lists,
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source code control systems, and issue tracking systems that are managed by, or on behalf of,
the Licensor for the purpose of discussing and improving the Work, but excluding communication
that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except
as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute
patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that
the Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and

2. You must cause any modified files to carry prominent notices stating that You changed the files;
and

3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works
that You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in
at least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works;
or, within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications,

or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions
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of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR

22



PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c¢) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ""AS IS" AND ANY EXPRESS

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
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IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright ¢ 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.
This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----
Copyright (c) 2003-2012, Sparta, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----
Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com
Author: Bernhard Penz <bernhard.penz@fabasoft.com>

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
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* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ""AS IS" AND ANY EXPRESS

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----
Copyright (c) 2007 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS I1S" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN

NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,

OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: SciencelLogic, LLC copyright notice (BSD) -----
Copyright (c) 2009, Sciencelogic, LLC
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:
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* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Sciencelogic, LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

LEADTOOLS
Copyright (C) 1991-2009 LEAD Technologies, Inc.

CMap Resources

Copyright 1990-2009 Adobe Systems Incorporated.
All rights reserved.

Copyright 1990-2010 Adobe Systems Incorporated.
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of Adobe Systems Incorporated nor the names
of its contributors may be used to endorse or promote

products derived from this software without specific prior

written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
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DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

MIT License
Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright 2000 Computing Research Labs, New Mexico State University
Copyright 2001-2015 Francesco Zappa Nardelli

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COMPUTING
RESEARCH LAB OR NEW MEXICO STATE UNIVERSITY BE LIABLE FOR ANY CLAIM, DAMAGES

OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.
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Written by Joel Sherrill <joel@OARcorp.com>.
COPYRIGHT (c) 1989-2000.
On-Line Applications Research Corporation (OAR).

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby
granted, provided that this entire notice is included in all copies of any software which is or includes a
copy or modification of this software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.
IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE.

(1) Red Hat Incorporated
Copyright (c) 1994-2009 Red Hat, Inc. All rights reserved.

This copyrighted material is made available to anyone wishing to use, modify, copy, or redistribute it
subject to the terms and conditions of the BSD License. This program is distributed in the hope that it

will be useful, but WITHOUT ANY WARRANTY expressed or implied, including the implied warranties of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at
http://www.opensource.org/licenses. Any Red Hat trademarks that are incorporated in the source code or
documentation are not subject to the BSD License and may only be used or replicated with the express
permission of Red Hat, Inc.

(2) University of California, Berkeley
Copyright (c) 1981-2000 The Regents of the University of California.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project LICENSE
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2006-Jan-27
Copyright 1996-2002, 2006 by
David Turner, Robert Wilhelm, and Werner Lemberg

Introduction

The FreeType Project is distributed in several archive packages; some of them may contain, in addition to
the FreeType font engine, various tools and contributions which rely on, or relate to, the FreeType Project.

This license applies to all files found in such packages, and which do not fall under their own explicit
license. The license affects thus the FreeType font engine, the test programs, documentation and
makefiles, at the very least.

This license was inspired by the BSD, Artistic, and IJG (Independent JPEG Group) licenses, which
all encourage inclusion and use of free software in commercial and freeware products alike. As a
consequence, its main points are that:

o We don't promise that this software works. However, we will be interested in any kind of bug reports.
(Cas is' distribution)

o You can use this software for whatever you want, in parts or full form, without having to pay us.
(‘royalty-free' usage)

o You may not pretend that you wrote this software. If you use it, or only parts of it, in a program, you
must acknowledge somewhere in your documentation that you have used the FreeType code. ('credits')

We specifically permit and encourage the inclusion of this software, with or without modifications, in
commercial products.

We disclaim all warranties covering The FreeType Project and assume no liability related to The FreeType
Project.

Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance with this
license. We thus encourage you to use the following text:

Portions of this software are copyright © <year> The FreeType
Project (www.freetype.org). All rights reserved.
Please replace <year> with the value from the FreeType version you actually use.

Legal Terms

Throughout this license, the terms “package’, "FreeType Project', and "FreeType archive' refer to the set
of files originally distributed by the authors (David Turner, Robert Wilhelm, and Werner Lemberg) as the
‘FreeType Project’, be they named as alpha, beta or final release.
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“You' refers to the licensee, or person using the project, where “using' is a generic term including
compiling the project's source code as well as linking it to form a “program' or “executable’'.

This program is referred to as “a program using the FreeType engine'.

This license applies to all files distributed in the original FreeType Project, including all source code,
binaries and documentation, unless otherwise stated in the file in its original, unmodified form as
distributed in the original archive.

If you are unsure whether or not a particular file is covered by this license, you must contact us to verify
this.

The FreeType Project is copyright (C) 1996-2000 by David Turner, Robert Wilhelm, and Werner Lemberg.
All rights reserved except as specified below.

1. No Warranty

THE FREETYPE PROJECT IS PROVIDED "AS IS' WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL ANY OF THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY DAMAGES CAUSED BY THE USE OR THE INABILITY
TO USE, OF THE FREETYPE PROJECT.

2. Redistribution

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to use, execute,
perform, compile, display, copy, create derivative works of, distribute and sublicense the FreeType Project
(in both source and object code forms) and derivative works thereof for any purpose; and to authorize
others to exercise some or all of the rights granted herein, subject to the following conditions:

o Redistribution of source code must retain this license file (FTL.TXT') unaltered; any additions, deletions
or changes to the original files must be clearly indicated in accompanying documentation. The copyright
notices of the unaltered, original files must be preserved in all copies of source files.

o Redistribution in binary form must provide a disclaimer that states that the software is based in part of
the work of the FreeType Team, in the distribution documentation. We also encourage you to put an URL
to the FreeType web page in your documentation, though this isn't mandatory.

These conditions apply to any software derived from or based on the FreeType Project, not just the
unmodified files. If you use our work, you must acknowledge us. However, no fee need be paid to us.

3. Advertising

Neither the FreeType authors and contributors nor you shall use the name of the other for commercial,
advertising, or promotional purposes without specific prior written permission.

We suggest, but do not require, that you use one or more of the following phrases to refer to this software
in your documentation or advertising materials: "FreeType Project', 'FreeType Engine', "FreeType library',
or "FreeType Distribution'.

As you have not signed this license, you are not required to accept it. However, as the FreeType Project
is copyrighted material, only this license, or another one contracted with the authors, grants you the right
to use, distribute, and modify it.
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Therefore, by using, distributing, or modifying the FreeType Project, you indicate that you understand and
accept all the terms of this license.

4. Contacts
There are two mailing lists related to FreeType:
o freetype@nongnu.org

Discusses general use and applications of FreeType, as well as future and wanted additions to the library
and distribution.

If you are looking for support, start in this list if you haven't found anything to help you in the
documentation.

o freetype-devel@nongnu.org

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.
Our home page can be found at

http://www.freetype.org

---end of FTL.TXT ---

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit expressly
disclaim all implied, express or statutory warranties including, without limitation, the implied warranties

of merchantability, noninfringement of third party rights and fitness for a particular purpose. Neither the
developers nor the distributors will be liable for damages, whether direct, indirect, special, incidental, or
consequential, as a result of the reproduction, modification, distribution or other use of the TWAIN Toolkit.

JSON for Modern C++
Copyright (c) 2013-2017 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2011 - 2015 ARM LIMITED

All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

- Neither the name of ARM nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL COPYRIGHT HOLDERS AND CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2014, Kenneth MacKay
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2006, CRYPTOGAMS by <appro@openssl.org> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain copyright notices, this list of conditions and the following
disclaimer.
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* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the CRYPTOGAMS nor the names of its copyright holder and contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

ALTERNATIVELY, provided that this notice is retained in full, this product may be distributed under the
terms of the GNU General Public License (GPL), in which case the provisions of the GPL apply INSTEAD
OF those given above.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER AND CONTRIBUTORS "AS IS"

AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ISC License
Copyright (c) 2013-2017
Frank Denis <j at pureftpd dot org>

Permission to use, copy, modify, and/or distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH
REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY SPECIAL, DIRECT,
INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE

OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

Copyright (c) 2008 The NetBSD Foundation, Inc.
All rights reserved.

This code is derived from software contributed to The NetBSD Foundation
by Lennart Augustsson (lennart@augustsson.net) at
Carlstedt Research & Technology.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.
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2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS
AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2000 Intel Corporation
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

* Neither name of Intel Corporation nor the names of its contributors

may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTEL OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Lua
Copyright © 1994-2014 Lua.org, PUC-Rio.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation
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the

rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and
to

permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED,

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN

ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH

THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LuaSocket

LuaSocket 2.0.2 license
Copyright © 2004-2007 Diego Nehab

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation

the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

LuneScript
Copyright (c) 2018 ifritdP

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:
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The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

The following applies only to products supporting Wi-Fi.
(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.

* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS

IS," AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

37



I Basic Operation

» Printer Parts

@ Printer Parts

@ Optional accessories

> Printing procedure
» Canceling print jobs

*» Pausing Printing
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I Printer Parts

» Printer Parts

Front

Side

Top Cover (Inside)

Roll Paper Cover (Inside)
Carriage

Ink Tank Cover (Inside)

Operation Panel

» Optional accessories

Stand

Roll Holder Set
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I Printer Parts

>

>

>

¥

Front

Side

Top Cover (Inside)

Roll Paper Cover (Inside)
Carriage

Ink Tank Cover (Inside)

Operation Panel
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I Front

(A) Top Cover

Open this cover to install the print head and remove any jammed paper from inside the printer, as
needed. (See "Top Cover (Inside).")

(B) Roll Paper Cover
Open this cover to load rolls. (See "Roll Paper Cover (Inside).")

(C) Width Guide
When loading the sheets , move the guide to match the paper size.

(D) Paper Alignment Line
A white line for alignment of paper.

(E) Ink Tank Cover
Open this cover to replace the ink tank. (See "Ink Tank Cover (Inside).")

(F) Operation Panel
Use this screen to operate the printer and check the printer status. (See "Operation Panel.")

(G) Release Lever
When releasing the Paper Retainer, push this lever back.

(H) Output Guide
Supports output paper.
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(I) Maintenance Cartridge
Ink used for maintenance purposes such as head cleaning is absorbed. (Replace the cartridge when it
is full.)

(J) Maintenance Cartridge Cover
Open this cover to replace the maintenance cartridge.

(K) Stand
A stand that holds the printer. Equipped with casters to facilitate moving it. (See "Stand.")
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(A) Power Cord Connector
Connect the power cord to this connector.

(B) Carrying Grips
When carrying the printer, have three or more people hold it by these handles under both sides.
Furthermore, hold the left and right of these parts when moving the printer with a stand.

(C) Wired LAN Connector
Connect an Ethernet cable to this port. The lamp is lit if the Ethernet cable is connected correctly and
communication is possible between the computer and printer.

(D) USB Port
Connect a USB cable to this port. The printer is compatible with Hi-Speed USB connections.
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I Top Cover (Inside)

(A) Platen
The print head moves across the platen to print.

(B) Paper Retainer
Important in supplying the paper. This retainer holds paper as it is fed.

(C) Linear Scale
The linear scale serves a key role in detecting the carriage position.

(D) Carriage Shaft

The Carriage slides along this shaft.
(E) Carriage

Moves the print head. The carriage serves a key role in printing. (See "Carriage.")
(F) Cleaning Brush

When cleaning inside the printer under the top cover, use this brush to sweep away paper dust on the
platen.

(G) Cutter Blade
A round-bladed cutter for automatic paper cutting.
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I Roll Paper Cover (Inside)

(A) Slide Guide
Move the roll holder along this guide.

(B) Roll Holder Slot
Slide the roll holder into this slot.

(C) Holder Stopper
Secure the roll on the roll holder with this part.

(D) Roll Holder
Load the roll on this holder.
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I Carriage

(A) Print Head
The print head is equipped with ink nozzles. The carriage serves a key role in printing.

(B) Print Head Locking Cover
Secures the print head.

(C) Angle Adjustment Lever
Fine-tunes the line misalignment when printing.

(D) Print Head Lock Lever
Lock print head locking cover.
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I Ink Tank Cover (Inside)

(A) Ink Tank
Cartridges of ink in various colors.

(B) Ink Tank Lock Lever
A lever that locks the ink tank in place and protects it. Lift and press down the lever when replacing an
ink tank.
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I Operation Panel

A B cCD

(i) x \
&Ll e

F E

A: HOME button
The HOME screen appears.

= Home Screen Menu Composition

B: Back button
Displays the screen before the current screen.

C: Stop button
Cancels print jobs in progress and ends the ink drying period.

D: ON button/ON lamp
Turns the printer on and off.

= Turning the Printer On and Off

The ON lamp is lit when the printer is on or in Sleep mode.

E: Touch Screen
Shows printer menus, as well as the printer status and messages. You can select menu items and
display buttons by gently touching the screen with your fingertip.

= Home Screen Menu Composition

F: Status lamp
* Flashing (white)

During printing, this lamp flashes when the printer is receiving or processing print jobs. Otherwise,
this lamp flashes when the print job is paused or the printer is updating the firmware.

* Lit (orange)

A warning message is displayed.
* Flashing (orange)

An error message is displayed.
» Off

There are no active print jobs, warnings, or errors.
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»» Note

* When the printer is in Sleep mode, to restore the display, press the buttons on the operation panel or
touch the touch screen.

» When Operation panel lock is enabled, touch screen operations are invalid. For details on Operation
panel lock, see Changeable Setting Items Using Remote UI.
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I Optional accessories

» Stand

» Roll Holder Set
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I Stand

The following Stand can be used with the printer.

» GP-300/ GP-5300 : Printer Stand SD-33

GP-200 / GP-5200 : Printer Stand SD-24

(A) Stand
A stand that holds the printer. It is equipped with casters to facilitate movement.
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(B) Basket
Catches the ejected printed documents.

(C) Locking Caster
The casters can be locked securely. When moving the printer, be sure to unlock the 4 casters. If you
move it while the locking casters are locked, the floor may become scratched.

»» Note

* For instructions on how to use the basket, see "Using the Basket".

* Depending on the product, a stand may not be provided.
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| Roll Holder Set

Load roll paper on the roll holder and then load the holder in the printer. You can use the roll holder with

both 2-inch and 3-inch paper cores. However, if using 3-inch core roll paper, attach the 3-inch paper core
attachment. (See "Loading Rolls on the Roll Holder.").

» GP-300 / GP-5300 : Roll Holder Set RH2-35
» GP-200 / GP-5200 : Roll Holder Set RH2-28
o Roll Holder (for 2- and 3-inch paper cores)
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I Printing procedure

» Turning the Printer On and Off
» Loading and Printing on Rolls
» Loading and Printing on Sheets
» Printing in Windows

» Printing from macOS
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I Turning the Printer On and Off

I Turning the printer on

1. Press ON button to turn on printer.

The ON button lights up and the printer will now start up.

The Canon logo appears on the operation panel, and then "Starting the system...Please wait
momentarily" appears.

® @

—

When startup is finished, the printer enters standby mode.

' -®-
®

—

Ready to print

£ Plain Paper
A3 Roll

— Replace . l\:!,Fe.-e-ﬂ,.l"'(:ut
= paper s

E—
= | 6 | &
The printer will not enter standby mode in the following situations. Take action as necessary.

* The top cover is open

Close the top cover.

* The ink tank cover is open

Close the ink tank cover.

* The print head is not installed

= Replacing the Print Head
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¢ The ink tank is not installed

= Replacing Ink Tanks

« If "Error" is shown on the operation panel
Check the message on the operation panel and take action as necessary.

* The ON button and Status lamp never light up, and nothing appears on the operation
panel

Check the connection at the plug and electrical outlet.

I Turning the printer off
22 Important

* Never disconnect the printer's power supply or unplug it during a print job. This may damage the
printer.

1. Make sure no print jobs are in progress.

While the Status lamp is flashing, the printer is running. The color of the lamp indicates the following
states.

Liardhdhd
¥ e
) Iy
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e

If the Status lamp is flashing orange, check the message on the operation panel and take action as
necessary.

_
®©

If the Status lamp is flashing white, the printer is printing, receiving data, etc. Turn off the power after
the Status lamp turns off.

2. Hold down the ON button for more than a second.

"Turning off... Please wait momentarily" appears on the operation panel, and the printer turns off.
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I Loading and Printing on Rolls

These are the basic steps for loading and printing on rolls.
Follow these steps to load and print on rolls.

2> Note

» For details on roll paper sizes and types that can be used, see "Paper Sizes" or "Paper Information
List".

* To wait until the ink dries after printing before cutting the roll, set Drying Time in the printer driver. (See
"Specifying the Ink Drying Time.")

» Once you have used all the paper on a roll, clean the platen. If the platen inside the top cover becomes
dirty, it may soil the underside of paper. (See "Cleaning Inside the Top Cover.").

1. Turn the printer on. (See "Turning the Printer On and Off.")

3. Load the Roll Media in the printer. (See "Loading Rolls in the Printer")
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4. Select the type of paper. (See "Changing the Type of Paper.")
222 Note

+ If no barcode has been printed on the roll paper and you have set Manage remaining roll
amount to Barcodes, specify the roll length after selecting the media type. (See "Specifying the
Paper Length.")

5. Complete settings in the printer driver for the type of paper and other details.

= How to Open the Printer Driver Setup Window (Windows)

= How to Open the Printer Driver Setup Window (macOS)

6. Send the print job.

= Printing in Windows

= Printing from macOS
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Start printing.
3% Important

» Do not move the release lever during printing.
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I Loading and Printing on Sheets

These are the basic steps for loading sheets and then printing.

Follow the steps below to load and print on sheets.

»» Note

 For details on paper sizes and types that can be loaded, see "Paper Sizes" or "Paper Information List".

» Borderless printing is not supported on sheets.

1. Turn the printer on. (See "Turning the Printer On and Off.")

3. Complete settings in the printer driver for the type of paper and other details.

= How to Open the Printer Driver Setup Window (Windows)

= How to Open the Printer Driver Setup Dialog (macOS)

4. Send the print job.

= Printing in Windows

= Printing from macOS

Start printing.
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2% Important

* Do not move the release lever until instructions (guidance) for removing the paper are displayed.
Moving the release lever during printing will cause printing to stop.
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I Printing in Windows

Print from the application menu.

22 Important

» We recommend exiting unnecessary applications before printing. Running several applications while
printing may interrupt the transfer of print data and affect printing quality.

1. In the source application, select Print from the File menu to display the dialog box for
printing conditions.

2. After confirming that the printer is selected in the dialog box, click Print or OK to start
printing.
> Note

* The appearance of the dialog box varies depending on the software application. In most cases,
the dialog box includes basic printing options and enables you to choose the printer, specify the
range of pages, number of copies, and so on.

Example: Print dialog box displayed by the application

= Print >
General
Select Printer
— Canon SETES — Canon SEres
L Canon SEries i Canon SEres
Canon SEries i Canon
£ >
Status: Ready [ |Prnttofile | Prefersnces
Location:
[ . Find Prirter...
Page Range
@Al MNumber of copies: |1 =
Selectior Cumrent Page
Pages: Collate
1.1 2:7- 3;3:
Print Cancel Apphy

« If another printer is selected, select the printer you want to use under Select Printer or in the
dialog box displayed after clicking Printer.
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You can use the printer driver dialog box to configure various printing settings such as for enlarged or
reduced printing and borderless printing. You can open the printer driver dialog box from the application
software or from the operating system menu. For details, see "How to Open the Printer Driver Setup
Window" (Windows) or "How to Open the Printer Driver Setup Dialog" (macOS).
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I Printing from macOS

Print from the application menu after registering the printer.

22 Important

» We recommend exiting unnecessary applications before printing. Running several applications while
printing may interrupt the transfer of print data and affect printing quality.

I Registering the printer

The printer needs to be registered in Print & Scan (identified as Printers & Scanners or Print & Fax in
other versions of macOS X) in System Preferences before printing.
For instructions on registering printers, see "Sharing the Printer on a Network (macOS)."

32 Important

» During this setup process, the printer will not be listed among available printers if it is off or
disconnected.

I Printing from the application software

1. In the application software, select Print from the File menu to display the dialog box for
printing conditions.

»» Note

* This dialog box includes basic printing options and enables you to choose the printer, specify
the range of pages, number of copies, and so on.

= Print Dialog (macOS)

2. Select the printer in the Printer list.

3. Click Print to start printing.

You can make various settings from the print dialog box pop-up menu to change the printing method,
including enlarged and reduced printing, and borderless printing.
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I Canceling print jobs

» Canceling Print Jobs from the Control Panel
» Canceling Print Jobs from Windows

» Canceling Print Jobs from macOS
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I Canceling Print Jobs from the Control Panel

To cancel printing or reception of print jobs, press the Stop button on the operation panel.

/ x|
g

When you press the Stop button during printing, the printer operation varies depending on the current
status.

/

* You press the Stop button before printing starts

Pressing the Stop button before printing starts displays a confirmation message. To cancel the print job,
select Yes.

* You press the Stop button during printing

Pressing the Stop button during printing displays a confirmation message. To cancel the print job
immediately, select Yes.
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I Canceling Print Jobs from Windows

In the printer window, you can cancel jobs that are being sent to the printer.

Using Canon IJ Status Monitor, you can cancel print jobs that have already been received by the printer or
that are currently being printed.

1. Click the printer icon in the taskbar to display the printer window.

»» Note
* You can proceed from the folder for configuring the printer settings in the OS you are using.

For example, in Windows 7, open the Devices and Printers window from the start menu and
double-click the printer icon.

2. Right-click the job to cancel and select Cancel.

g Canon - O 4
Printer Docurnent  View
Document Mame Status Orwinver Pages Size Submitted
BE = — Printing 1 ST3KE

Pause

Restart

L !
Properties

< >

Cancels the selected documents.

3. If job to be canceled is not shown in printer window (that is, if print data has already been
received by printer), click taskbar icon to display Canon |J Status Monitor.

4. Click Cancel Printing.
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& Canon ™ — - - *
Option  Remote Ul Help

Document Mame: - —
Cwmer: - —
Printing Page: 141

Remaining Printing Time of Cument Page:  Printing wil finksh soon.

(#  Estimated Maintenance Caridge Usage

23 Note

* The screen may differ slightly depending on the model you are using.
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I Canceling Print Jobs from macOS

In the printer window, you can cancel jobs that are being sent to the printer.

»>» Note
* Print jobs are shown in the printer window while they are being sent from the computer. After
transmission, jobs are not displayed even during printing.

1. Click the printer icon in the Dock to display the printer window.

2. Either click x for the job to cancel printing or select the job to cancel printing and then click

Delete to delete the job.
@00 = Canon - 1Job

® O

Pause Settings

Printing -

2> Note

« |f the job to be canceled is not shown in the printer window (that is, if the print data has already
been received by the printer), you can cancel printing from the operation panel on the printer or
from Remote Ul. For details, "Canceling Print Jobs from the Control Panel" or see "Deleting Print

Jobs."
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I Pausing Printing

» Pausing Printing
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I Pausing Printing

During printing, if you set Pause printing to Enable, the printer enters a state in which printing is paused,
after the completion of the printing process when this setting was made.

In this state, all printing is not executed.

To restore normal operation after pausing printing, set Pause printing to Disable.

»>» Note

* In the following cases, the status is cleared even if you do not set Pause printing to Disable.

— When paper is advanced

— If you changed the media type from the paper settings display area

1. Tap (Jobs) on Home screen during printing.

Printing...

BE- =D

+ If the Home screen does not appear, press the HOME button.

»» Note

2. Tap Pause printing.

3. Tap Enable or Disable.
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I Handling and Use of Paper

» Paper

@« Types of Paper

Paper Sizes

Using Paper Other Than Genuine Paper and feed confirmed Paper

Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing
Settings

Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding a
Media Type

Paper Information List

Updating paper information
» Handling rolls

@ Loading Rolls on the Roll Holder

Loading Rolls in the Printer

« Changing the Type of Paper

@« Specifying the Paper Length

@« Removing the Roll from the Printer

« Removing Rolls From the Roll Holder

« Remove Jammed Roll Paper

@« Feeding Roll Paper Manually

@« Keeping Track of the Amount of Roll Paper Left

@« Specifying the Amount of Extension for Borderless Printing
@ Specifying the Ink Drying Time

@« Specifying the Cutting Method for Rolls

@« Cutting the Leading Edge of Roll Paper Automatically

@ Reducing Dust from Cutting Rolls

@ Detecting Roll Paper was Replaced While the Power was Off

» Handling sheets
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]

Loading Sheets in the Printer
Changing the Type of Paper

Printing From a Desired Starting Point
Removing Sheets

Remove a Jammed Sheet

Specifying the Ink Drying Time

» Basket

]

Using the Basket

» Adding/Editing Media Information
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I Paper

» Types of Paper
» Paper Sizes
» Using Paper Other Than Genuine Paper and feed confirmed Paper

& Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using
Existing Settings

& Printing on Paper Other Than Genuine Paper and feed confirmed Paper by Adding
a Media Type

» Paper Information List

¥

Updating paper information
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I Types of Paper

The following media types are supported by the printer. For details on the media types supported by the
printer, see "Paper Information List."
* Plain Paper
+ Coated Paper
» Photo Paper
* Glossy Paper
* Proofing Paper
+ CAD-dedicated Paper Etc.
The Paper Information List includes the following information.
» Types of paper
» Paper handling
» Paper product specifications
* Use precautions
+ Setting of printer driver, operation panel etc.

»» Note

* For instructions on using paper not included in the Paper Information List, see "Using Paper Other Than
Genuine Paper and feed confirmed Paper."

* Method of Updating Supported Paper
Paper that is supported by the printer may be newly released on the Canon website.

To use newly released paper, register the latest paper information on the printer with the Media
Configuration Tool. (See "Updating paper information.")

3% Important

» Even if you are not using the printer driver, you should install the Media Configuration Tool in order
to register the media types for your region in the printer.

(See "Media Configuration Tool Guide" .)
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I Paper Sizes

| Rolis

Rolls that meet the following conditions are supported.

 Outer diameter is 5.9 inches (150 mm) or less

* Inner diameter of paper core: 2 or 3 inches

* Printing side out

Roll Paper Width

GP-300 / GP-5300 : 36.11 in. (917.0 mm) to 8.00 in. (203.2 mm)
GP-200 / GP-5200 : 24.02 in. (610.0 mm) to 8.00 in. (203.2 mm)

Roll paper width recommended
for borderless printing(*1,*2)

36 in Roll (914.4mm)
AO0/A1 Roll (841.0mm)
B1/B2 Roll (728.0mm)
24 in Roll (609.6mm)
A1/A2 Roll (594.0mm)
B2/B3 Roll (515.0mm)
17 in Roll (431.8mm)
14 in Roll (355.6mm)
10 in Roll (254.0mm)

Minimum Paper Length

8.00 in. (203.2 mm)

Excludes cloth/canvas paper.

Maximum Printable Length

59 feet (18 m)

depends on the OS and application.

Thickness

3 mil (0.07 mm) to 31 mil (0.8 mm)

*1:Borderless printing may not be available depending on the media type. For details on media types that

can be used for borderless printing, see "Paper Information List."

*2:You can perform borderless printing without specifying Roll paper width recommended for it. As
opposed to standard borderless printing, there will be a small margin on the left and right because the

paper width is set a little bit smaller than the width of the document.

I Sheets

Sheets of the following sizes are supported.

Sheet Width

GP-300/ GP-5300 : 36.11 in. (917.0 mm) to 8.00 in. (203.2 mm)
GP-200 / GP-5200 : 24.02 in. (610.0 mm) to 8.00 in. (203.2 mm)

Minimum Paper Length

11.00 in. (279.4 mm)

Maximum Printable Length

5.2 feet (1.6 m)
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Thickness 3 mil (0.07 mm) to 31 mil (0.8 mm)

»» Note

» For details on non-standard sizes, see "Setting Paper Dimensions (Custom Size)" (Windows) or
"Setting Paper Dimensions (Custom Size)" (macOS).

» Borderless printing is not supported on sheets.
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Using Paper Other Than Genuine Paper and feed confirmed
Paper

When using this printer to print on paper other than genuine Canon paper and feed confirmed paper, use
paper that meets the following conditions.

»» Note

* For Canon genuine paper/feed confirmed paper, see "Paper Information List."

» Paper where the size is described in "Paper Sizes" (See "Paper Sizes.")
» Paper where bleeding and ink overflow does not occur when printing
» Paper that does not warp severely when loading the paper or printing

22 Important

* If you use paper other than Canon genuine paper and feed confirmed paper, Canon provides
absolutely no guarantees regarding print quality or paper feed properties. For Canon genuine paper/
feed confirmed paper, see "Paper Information List."

After loading the paper in the printer, select the media type in the operation panel and printer driver and then
perform the printing. For the media type, you can select easily from existing settings or you can create and
use settings for the paper you are using.

| Printing Using Existing Settings

You can print easily by selecting from existing settings provided in the operation panel and printer driver.
(See "Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings.")

I Printing Using Additional Settings

You can use the Media Configuration Tool function for adding custom paper to create settings suitable for
non-Canon genuine paper/feed confirmed paper and add as a new media type to the printer's operation
panel and the printer driver for printing. (See "Printing on Paper Other Than Genuine Paper and feed
confirmed Paper by Adding a Media Type.")
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Printing on Paper Other Than Genuine Paper and feed
confirmed Paper Using Existing Settings

You can easily print on paper other than genuine Canon paper and feed confirmed paper without making
complicated settings by selecting the existing settings provided in the operation panel and printer driver
depending on the media type you are using. The existing settings consist of general-purpose paper settings
provided for different media types.

3% Important

+ The Canon genuine paper settings provided in the operation panel and printer driver are optimized for
Canon genuine paper. If these settings are selected for printing on paper other than Canon genuine
paper, the ink may bleed or the print head may rub against the paper. To easily print on paper other
than Canon genuine paper and feed confirmed paper, we recommend that you select one of the
following general-purpose paper settings.

2> Note
» For an overview of the media types, see "Types of Paper."

» For instructions on selecting the media type with the operation panel, see "Types of Paper". For
instructions on selecting the media type with the printer driver, see "How to Open the Printer Driver
Setup Window" (Windows) or "How to Open the Printer Driver Setup Dialog" (macOS).

I Choosing General-Purpose Paper Settings

These settings anticipate a wide variety of paper other than Canon genuine paper and feed confirmed
paper, and, therefore, these settings make it difficult for bleeding ink and print head rubbing to occur. For
details on the relationships between the conditions of paper other than Canon genuine paper and feed
confirmed paper and the media type to select, see "Paper Information List."

»>» Note

« If you cannot obtain the desired results by selecting the general-purpose paper settings, use the
custom paper adding function in Media Configuration Tool to create settings suitable for the paper
you are using. For details, see "Printing on Paper Other Than Genuine Paper and feed confirmed
Paper by Adding a Media Type."
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Printing on Paper Other Than Genuine Paper and feed
confirmed Paper by Adding a Media Type

Media Configuration Tool provides a function for adding custom paper for better print quality and improved
paper feed properties when printing on paper other than Canon genuine paper/feed confirmed paper than
when printing with general-purpose settings. You can use this function to configure settings such as the
amount of ink used and the height of the print head according to the characteristics of the paper being used,
and thereby realize higher print quality. Also, you can add the settings created with this function as a new
media type to the operation panel and printer driver.

For details on Media Configuration Tool, refer as follows.

= Media Configuration Tool Guide

22 Important
* For details on how to select the added media type in the operation panel, see "Changing the Type of
Paper."

* You can select the media type to be used in printing from Media Type in the Main sheet (Windows) or
Quality & Media (macOS) in the printer driver. For details, see "Main Tab Description" (Windows) or
"Quality & Media" (macOS).

* We recommend that you use an ICC profile created using commercially available profile creation
software to perform color management accurately on paper other than Canon genuine paper and feed
confirmed paper. You can register the ICC profile you created when creating a custom paper with
Media Configuration Tool. See "Adding Custom Paper" in Media Configuration Tool Guide.
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I Updating paper information

You can update the printer's media information to the latest information by applying the latest version of the
Media Information File.

For details on the procedure for applying the Media Information File, refer to the following.

= Media Configuration Tool Guide

22 Important

* If you are using the Media Configuration Tool, the new Media Information File is downloaded

automatically when released on the Canon website. A computer connected to the Internet is required to
download the Media Information File.
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I Handling rolis

>

>

Loading Rolls on the Roll Holder

Loading Rolls in the Printer

Changing the Type of Paper

Specifying the Paper Length

Removing the Roll from the Printer

Removing Rolls From the Roll Holder

Remove Jammed Roll Paper

Feeding Roll Paper Manually

Keeping Track of the Amount of Roll Paper Left
Specifying the Amount of Extension for Borderless Printing
Specifying the Ink Drying Time

Specifying the Cutting Method for Rolls

Cutting the Leading Edge of Roll Paper Automatically
Reducing Dust from Cutting Rolls

Detecting Roll Paper was Replaced While the Power was Off
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I Loading Rolls on the Roll Holder

When printing on roll paper, attach the roll paper to the roll holder.

Roll paper comes in two types: 2-inch and 3-inch cores. If using 3-inch core roll paper, attach the 3-inch
paper core attachment to the roll holder and holder stopper.

A Caution

+ Set the roll on its side on a table or other flat surface so that it does not roll or fall. Rolls are heavy, and
dropping a roll may cause injury.

22 Important

* When handling the roll, be careful not to soil the printing surface. This may affect the printing quality.
We recommend wearing clean cloth gloves when handling rolls to protect the printing surface.

» Cut the edge of the roll paper if it is uneven, dirty, or has tape residue. Otherwise, it may cause feeding
problems and affect the printing quality. Be careful not to cut through any barcodes printed on the roll.

« If a feeding problem occurs, release the release lever and reload the roll paper.

»» Note

 For details on roll paper sizes and types that can be used, see "Paper Sizes" or "Paper Information
List".
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1. Rotate the holder stopper lever (A) towards ‘P to release the lock, and while holding it in
position (B), remove holder stopper from the roll holder.

2. If using 3-inch core paper, align 3-inch paper core attachment tabs (A) with roll holder holes
(B) and insert firmly.

3. With leading edge of roll paper facing forward as shown, insert Roll Holder from right side of
roll. Insert firmly until roll paper touches flange (A) of roll holder.
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3% Important

* When loading a roll, be careful to avoid hitting the printer hard with the roll. This may damage the
roll holder.

« If you stand the roll holder vertically and set the roll paper by dropping, the roll holder may be
damaged.

4. If using 3-inch core paper, align 3-inch paper core attachment tabs (A) with holder stopper
holes (B) and insert firmly.

5. Insert holder stopper from left into roll holder as shown, and then while holding in position
(B), push firmly until holder stopper flange (A) touches roll paper. Lock the holder stopper

lever (C) by rotating it towards ﬁ
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I Loading Rolls in the Printer

Follow these steps to load rolls in the printer.

22 Important

» Before loading a roll, confirm whether the inside of the top cover or the output guide is soiled. If these
areas are dirty, we recommend cleaning them in advance. (See "Cleaning Inside the Top Cover.")

1. Tap Load paper or Replace paper on the Home screen of the operation panel.
Ready to print

' There is no paper.

_, Load
T paper
5 é o]

»» Note

« If the Home screen does not appear, tap the HOME button.

2. Tap Load roll paper.
»» Note

« If any paper has been advanced that will not be used, a message is shown requesting you to
remove it.

After following the instructions on the screen to remove the paper, go to the next step.

3. Positioning your hands as shown, open the roll paper cover.
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4. Holding the roll holder flange (A), rest the roll holder shaft on the roll holder resting ledge
(B).

At this time, position the holder as shown in the illustration so that the R label (C) on the roll holder
flange is aligned with the R label (D) on the printer.

C

22> Note

 For the procedure for attaching the roll paper to the Roll Holder, see "Loading Rolls on the Roll

Holder."
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5. Holding the roll holder flange (A), guide the holder along the slide guides (B) on both ends,
keeping the holder level as you load it in the roll holder slot.

A Caution

» Do not force the roll holder into the printer with the right and left ends reversed. This may damage
the printer and roll holder.

» Do not release the flanges until the holder is loaded in the roll holder slot.

» Be careful not to pinch your fingers between the slide guides (B) and the roll holder shaft (C) when
loading rolls.

3% Important

« If the leading edge of the roll paper is cut crooked or folded, it may not be fed correctly. Cut the
leading edge of the roll paper with scissors or the like and straighten it.

» Load the roll paper so that it is not loaded in the opposite direction.

6. Insert the edge of the roll in the feed slot (A) and advance the roll until you hear the feed
tone.
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2% Important
« If the roll paper has become unwound, remove the slack before loading the roll paper.

» Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect

the printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the
printing surface.

« |If the paper is wrinkled or warped, straighten it out before loading it.

* Load the roll so that there is no gap between the right edge of the paper and the roll holder.

&

7. After paper feeding has started, do the following operations based on the Manage
remaining roll amount setting and the barcode printed on the roll paper (see "Keeping
Track of the Amount of Roll Paper Left").

* When selecting Disable or Warning message only in Manage remaining roll amount.

A menu for selecting the media type appears on the operation panel. Operate the operation panel
and select the media type to be used.

* When selecting Barcodes in Manage remaining roll amount and if the barcode is printed.

The type and amount of paper left is automatically detected based on the barcode printed on the
roll. There is no need to specify the type and length of the paper.
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* When selecting Barcodes in Manage remaining roll amount and if the barcode is not
printed.

A menu for selection of the media type and length is shown on the operation panel. Operate the
operation panel, select the media type to be used, and enter its length.
3% Important
» When selecting Enable in Keep media type, there is no need to specify the type of the paper.

» Cut the edge of the roll using the Cut paper function if the edge is creased or soiled. (See
"Specifying the Cutting Method for Rolls.")

* When selecting the media type on the operation panel, make sure the media type set in the printer
driver and the media type loaded on the printer match.

»» Note

 For details on media types that you can select, see "Paper Information List."

. Holding it at the positions indicated, close the roll paper cover.

»» Note

» Cut the edge of the roll after the paper is advanced if it is soiled or if there are cuts from scissors
or the blade after removing creased edges. (See "Specifying the Cutting Method for Rolls.")

 Adjusting the print head alignment with the type of paper to be used in printing may enhance
printing quality. (See "Automatic Adjustment to Straighten Lines and Colors.")
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I Changing the Type of Paper

Follow these steps to change the type of paper specified on the printer after you have loaded paper.

If you continue using the same type of paper and set Keep media type to Enable, when you load paper, the
media type selected before Enable was set is selected automatically, eliminating the need to set the media
type. (See "Using the Same Type of Paper Regularly.")

32 Important

* For best printing results, the printer fine-tunes the print head height and the feed amount for each type
of paper. Be sure to select the type of paper to use correctly before printing.

» Because the printer fine-tunes the feed amount for each type of paper, the margins and the size of
printed images may vary depending on the type of paper used. If margins and the size of images are
not as you expected, adjust the paper feed amount.

(See "Adjusting Feed Amount.")

* Rolls and sheets have different printing areas, and sheets having a larger bottom margin than rolls.

(See "Print Area.")

I Changing the Type of Paper
»» Note

* When you load roll paper, a menu for selecting the media type appears on the operation panel. Tap
the media type.

If no barcode has been printed on the roll paper and you have set Manage remaining roll amount to
Barcodes, specify the roll length after selecting the media type. (See "Specifying the Paper Length.")

1. Tap paper settings display area on Home screen of operation panel.

Ready to print

f ,“ Plain Paper

A3 Roll
— Replace 3 Feed/Cut
- +
paper
T & B
> Note

« If the Home screen does not appear, press the HOME button.

2. Tap Paper settings.

3. Tap Type.
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4. Tap media type of roll paper loaded in printer.

5. Tap Register.
32 Important

» Be sure to select the correct paper type. If this setting does not match the loaded paper, it may
cause feed errors and affect printing quality.

»» Note

» For details on media types, see "Paper Information List." At the factory default settings, Plain
Paper is selected for the media type.

* When the release lever is operated, the settings automatically return to the last selected media
type.

I Using the Same Type of Paper Regularly

Configure this setting so that current media type settings will be automatically selected when you load the
same type of paper later.

1. Tap 0 (Setup) on Home screen of operation panel.
Ready to print

f _‘I: Plain Paper
A3 Rell

— Replace g Feed/Cut
" paper s
T 6 (%]
> Note

« If the Home screen does not appear, press the HOME button.

2. Tap Printer settings.
3. Tap Paper-related settings.
4. Tap Keep media type.

5. Tap Enable.
»» Note

» The specified media type setting is updated in the following situations.
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— When using sheets, if you send a print job before loading a sheet, the media type setting is
updated to match the type of paper specified by the print job.

— If a barcode is printed on the roll paper and you have set Manage remaining roll amount to

Barcodes in the operation panel menu, the media type setting is updated to match the media
type specified by the barcode.

» To change the media type setting, see "Changing the Type of Paper."
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I Specifying the Paper Length

When changing the length of paper after the paper has been advanced, specify the length as follows.

»>» Note

» Specify the roll paper length when you have set Manage remaining roll amount to Barcodes. (See
"Keeping Track of the Amount of Roll Paper Left.")

1. Tap paper settings display area on Home screen of operation panel.

Ready to print

£ Plain Paper
= A3 Rl

- Replace 3¢ Feed/Cut
paper

G 0
> Note

« If the Home screen does not appear, press the HOME button.

2. Tap Paper settings.
3. Tap Advanced.
4. Tap Roll length (change default).

5. Enter roll paper length.
Specify the roll length as follows.
1. Tap the numerical input field.
2. Tap the keypad appearing on the operation panel, enter the roll paper length, and then tap OK.
3. Check the entered length and tap OK.
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I Removing the Roll from the Printer

Remove rolls from the printer as follows.

»>» Note
* If you need to cut a printed roll, select Feed/Cut in the printer menu and cut the roll paper at the desired
position. (See "Specifying the Cutting Method for Rolls.")

1. Tap paper settings display area on Home screen of operation panel.

Ready to print

£ Plain Paper
A3 Roll
R
- eplace 3¢ Feed/Cut
paper
G 0
> Note

« If the Home screen does not appear, press the HOME button.

2. Tap Remove paper.

3. Tap Yes.
The roll is rewound.

32 Important
+ If Manage remaining roll amount is set to Barcodes in the operation panel menu, a barcode is
printed on the leading edge of the roll paper.

Do not remove the roll before the barcode is printed. You will be unable to keep track of the
amount of roll paper left. (See "Keeping Track of the Amount of Roll Paper Left.")

Bose o e,
I ZE™ “reeiE e om el

Pl Papar -

4. Positioning your hands as shown, open the roll paper cover.
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6. Hold roll holder by its flanges (A) and remove from roll holder slot.

A
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23 Note

 For instructions on removing the roll holder from rolls, see "Removing Rolls From the Roll Holder."

7. Holding it at the positions indicated, close the roll paper cover.

123> Note

* To load new roll paper in the printer at this point, see "Loading Rolls in the Printer."

» Clean inside the top cover before loading paper.

(See "Cleaning Inside the Top Cover.").
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I Removing Rolls From the Roll Holder

1. Rotate the holder stopper lever (A) towards 'P to release the lock, and while holding it in
position (B), remove holder stopper from the roll holder.

2. Remove roll holder from roll paper.

Y

3. To remove 3-inch paper core attachment, press tabs (A) inward and remove attachment.

« roll holder Side
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* holder stopper Side

32 Important

« Store the roll in the original bag or box, away from high temperature, humidity, and direct sunlight. If
paper is not stored properly, the printing surface may become scratched, which may affect the printing
quality when you use it again.
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I Feeding Roll Paper Manually

After feeding the roll paper, you can move it forward and back.

1. Tap paper settings display area on Home screen of operation panel.

Ready to print

\f.ut Plain Paper

A3 Roll
- Replace 3¢ Feed/Cut
paper
AR EE:
»» Note

« If the Home screen does not appear, press the HOME button.

2. Tap Feed/Cut.

3. Tap or touch Advance and Rewind to move roll paper forward or back.

2> Note
» Tapping Advance or Rewind moves the roll paper approximately 0.04 inch (1 mm).

Touching Advance or Rewind moves the roll paper until you release the key. If "Cannot advance
the paper any further." appears on the operation panel, release the key.

4. Tap OK when you have determined position of roll paper.
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I Keeping Track of the Amount of Roll Paper Left

There are two methods of managing the amount of roll paper left: by using the barcode and by estimating
the amount of roll paper left.

I Managing by the Barcode for the Amount of Roll Paper Left

When you set Manage remaining roll amount to Barcodes in Printer settings on the Home screen, the
amount of remaining roll paper and the media type information are printed as a barcode and text when the
paper is removed. When Manage remaining roll amount is set to Barcodes and you load roll paper with
a printed barcode, the media type and remaining amount are automatically detected after the roll paper is

loaded. The barcode will be cut off after it has been read.

W4 LR L W
22 Important

« |If the barcode on the roll is not detected, enter the type and length of paper on the operation panel.
The length of the paper at this time can be set in Roll length (change default).

= Setting the Default Value of the Amount of Roll Paper Left when Managing by the Barcode

Follow the steps below when setting Manage remaining roll amount to Barcodes.

1. Tap 0 (Setup) on Home screen of operation panel.
Ready to print

f ,“ Plain Paper

A3 Roll
— Replace 3 Feed/Cut
- +
paper
T 6 (%]
> Note

* If the Home screen does not appear, press the HOME button.

2. Tap Printer settings.
3. Tap Paper-related settings.
4. Tap Manage remaining roll amount.

5. Tap Barcodes.
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6. Check the length of the roll paper and tap OK.

2> Note
» The length of the roll paper to be displayed can be set in Roll length (change default).

= Setting the Default Value of the Amount of Roll Paper Left when Managing by the Barcode

« If the length of the roll paper to be displayed is different from the length of the roll paper actually
used, set the actual length.

7. Select the timing when the warning message appears.

Setting the Default Value of the Amount of Roll Paper Left when Managing by the
Barcode

When you select Barcodes in Manage remaining roll amount and if you feed roll paper on which no
barcode is printed, such as new roll paper, the screen to enter the roll paper length (remaining amount)
appears.

In this screen, the length (remaining amount) of default value appears. If the length is not correct, tap the
screen and enter a correct length.

When you want to change the length (remaining amount) of default value, follow the steps below.

1. Tap paper settings display area on Home screen of operation panel.

Ready to print

€ Plain Paper
A3 Roll

— Replace 3 Feed/Cut
e E
paper
= é o
»» Note

* If the Home screen does not appear, press the HOME button.

2. Tap Paper settings.
3. Tap Advanced.
4. Tap Roll length (change default).

5. Specify the length of the roll paper and tap OK.
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I Managing by Estimating the Amount of Roll Paper Left

When you set Manage remaining roll amount to Warning message only in Printer settings on the
Home screen, if the amount of roll paper left decreases, the Status lamp on the operation panel lights up
orange and the warning message is displayed. The barcode is not printed.

The time to display warning message can be set in Roll amount warning settings. If you increase the
level in Roll amount warning settings, the warning message appears sooner.

32 Important

« If the type of paper is not selected correctly, the amount of roll paper left may not be estimated
correctly.

» When using the types of paper which are not displayed on "Paper Information List," set the paper
thickness and the size of paper core with Media Configuration Tool.

= Media Configuration Tool Guide
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I Specifying the Amount of Extension for Borderless Printing

Borderless printing may leave margins on the left and right sides of the paper or soil the back of the paper.
Adjusting the amount of extension may improve these problems.

Each paper width is shown as being a recommended width for borderless printing ( Paper with
recommended width ), or as having sufficient width for borderless printing ( Paper of sufficient width ).
The procedure for specifying the amount of extension differs depending on Paper with recommended
width and Paper of sufficient width.

= Specifying Amount of Extension for Paper with recommended width.
= Specifying Amount of Extension for Paper of sufficient width.

For more information on a paper width recommended for borderless printing, see Paper Sizes.

I Specifying Amount of Extension for Paper with recommended width.

1. Tap paper settings display area on Home screen of operation panel.

Ready to print

€ Plain Paper
\ % A3 Roll

— Replace g Feed/Cut
" paper s

= | & | &
2. Tap Paper settings.
3. Tap Advanced.
4. Tap Extension for borderless printing.

5. Tap Paper with recommended width.

6. Select amount of extension.

Select Large, Standard, or Small.

2> Note
» When selecting Large, the printed area will be wider. Select this if there are margins.

» When selecting Small, the printed area will be narrower. Select this if there are stains.
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I Specifying Amount of Extension for Paper of sufficient width.

In case of Paper of sufficient width, the width of the original is set to be slightly smaller than the paper,

and there are margins on the left and right. You can reduce the margins by increasing the amount of
extension.

On the other hand, if the amount of extension is too large, the back side of the paper will be easily soiled
with the overflowed ink. When performing borderless printing with specifying the amount of extension for
Paper of sufficient width, clean the platen regularly.

= Cleaning Inside the Top Cover

1. Tap paper settings display area on Home screen of operation panel.

Ready to print

£ Plain Paper
A3 Roll

—. Replace 3 Feed/Cut
= paper s

> ¢ o =

2. Tap Paper settings.

3. Tap Advanced setup.

4. Tap Extension for borderless printing.
5. Tap Paper of sufficient width.

6. Select the adjustment value.

3> Note
» The larger the set adjustment value, the wider the printed range.
« After setting, we recommend to perform borderless printing to check the margin status.

If the margin remains, set a larger adjustment value. If the back of the paper is soiled, set a
smaller adjustment value.

« After borderless printing for confirmation, we recommend to clean the platen.

= Cleaning Inside the Top Cover
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I Specifying the Ink Drying Time

When you are using paper that takes longer for ink to adhere, ink may be transferred onto the paper surface
during ejection, soiling it. In that case, you may be able to improve the condition by setting the time to wait
for the ink to dry after printing.

22 Important

* Printer settings are applied when the ink drying time is not set in the printer driver. If the ink drying time
is set in the printer driver, that setting has priority.

»>» Note

« If the cutter touches the print surface on which the ink is not dry, the paper surface may become
scratched or soiled, or the paper surface may rub when the paper falls and the surface may become
soiled.

To wait for the ink to dry without allowing printed materials to fall after printing, set Cutting mode on the
printer menu to Eject cut. (See "Specifying the Cutting Method for Rolls.")

» The ink drying time for sheets can also be set using this procedure.

I Set on the Printer

Set with the operation panel of the printer.

1. Tap paper settings display area on Home screen of operation panel.

Ready to print

€ Plain Paper
A3 Roll

— Replace 3 Feed/Cut
" paper s

2 ¢ o =

2. Tap Paper settings.
3. Tap Advanced.

4. Scroll the screen, tap Pause between scans or Pause between pages.
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Advanced paper settings

Roll paper tension {printing)

Roll paper tension (feeding)

Pause between scans

Pause between pages

Pause between scans
Specify the waiting time between printing one scan on a page and printing the next one.

Pause between pages
Specify the waiting time between printing one page and ejecting the paper. If there is a next page,
it will be printed after the ink drying time has elapsed.

I Set on your Computer

Refer to the followings for how to set from your computer.

= Main Tab Description (Windows)

= Advanced Paper Settings (macOS)

108



I Specifying the Cutting Method for Rolls

How rolls are cut after ejection varies depending on printer settings.

+ Automatic cut
The roll is automatically cut by the cutter blade according to the printer driver settings.
o Printer Setting
Tap paper settings display area >Paper settings>Advanced>Cutting mode>Automatic cut
o Driver Setting
Automatic Cutting>Yes

= See "Cutting Roll Paper after Printing" (Windows).

= See "Cutting Roll Paper after Printing" (macOS).

» Eject (when the paper surface is being scratched / to wait for ink to dry)

Select this to move the cutter by operation panel operation and cut paper. With Automatic cut, the
paper drops and may rub against the basket, resulting in damage to the print surface, but you can cut
using this method and supporting the paper so that it does not drop to avoid damage to the paper. Also,
you can prevent paper that has not dried from dropping by visually checking the ink has dried, and then
cutting the paper.

After printing, tap Cut paper and cut the roll paper on the cutter blade.
o Printer Setting
Tap paper settings display area >Paper settings>Advanced>Cutting mode>Eject cut
o Driver Setting
Automatic Cutting>Yes

= See "Cutting Roll Paper after Printing" (Windows).

= See "Cutting Roll Paper after Printing" (macOS).

+ Manual (when using media that cannot be cut with the cutter blade)

Select this if the paper cannot be cut on the cutter blade.

Cut each page from the roll using scissors. For continuous printing (if you will cut each page later),
select Automatic Cutting>Yes or select Print Cut Guideline.

o Printer Setting

Tap paper settings display area >Paper settings>Advanced>Cutting mode>User cut
o Driver Setting

Automatic Cutting>No, Yes, Print Cut Guideline

= See "Cutting Roll Paper after Printing" (Windows).

= See "Cutting Roll Paper after Printing" (macOS).
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» Paper cutting (to have the roll cut at your specified position)

Select this when you want to cut the roll paper by operating the cutter blade using the operation panel
after printing with No or Print Cut Guideline selected in Automatic Cutting in the printer driver.

Otherwise choose this option if you want to cut the roll edge after loading a roll.
o Printer Setting
Tap paper settings display area >Feed/Cut>Cut paper>Yes
o Driver Setting
Automatic Cutting>No, Yes, Print Cut Guideline

= See "Cutting Roll Paper after Printing" (Windows).

= See "Cutting Roll Paper after Printing" (macOS).
3> Note

» Automatic and Eject are valid only when you have selected Automatic Cutting>Yes in the printer
driver.

» With Eject, printing does not resume after a series of jobs have been printed continuously until the roll is
cut.

* Eject cut or User cut is the preset selection in Cutting mode for some types of paper. For this paper,
we recommend keeping the preset cutting mode.

+ If documents printed using Automatic, Eject, or manual cutting are short, rolls are advanced a specific
amount before cutting to prevent problems with cutting and paper ejection. This may create a wider
bottom margin, in some cases.

Cut rolls manually in the following cases:

I Eject (when the paper surface is being scratched / to wait for ink to dry)

2% Important

» When cutting wide printed documents after ejection, have two people support the documents. If the
paper drops, printed documents may be damaged.

» Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect
the printing quality or cause rough cut edges.

3> Note
* Once the following step has been performed, the procedure can be started from step 7 the next time.
— Printing the second and subsequent times

— Printing after replacing with the same type of paper

1. Tap paper settings display area on Home screen of operation panel.
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Ready to print

r&‘: Plain Paper

A3 Roll
- Replace 3¢ Feed/Cut
paper
= & O
»>» Note

* If the Home screen does not appear, press the HOME button.

2. Tap Paper settings.
3. Tap Advanced.

4. Tap Cutting mode.
5. Tap Eject cut.

6. Print the job.

When printing is finished, the printer will stop without cutting.

7. While holding the printed document from the bottom edge to prevent it from dropping, tap
Cut paper to cut the roll paper.

I Manual (when using media that cannot be cut with the cutter blade)

2> Note
» Once the following step has been performed, the procedure can be started from step 8 the next time.
— Printing the second and subsequent times

— Printing after replacing with the same type of paper

1. Tap paper settings display area on Home screen of operation panel.

Ready to print

{_£ Plain Paper
** A3 Roll

—. Replace 3o Feed/Cut
" paper s

= 8| 0] B
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23 Note

* |If the Home screen does not appear, press the HOME button.

N

. Tap Paper settings.

w

. Tap Advanced.

F N

. Tap Cutting mode.

5. Tap User cut.

N

. When Do you want to set to detect the leading edge of the paper? is displayed, select
Detect (recommended).

N

. Print the job.

The printer stops advancing the paper after printing.

©0

. Tap Advance paper.

Roll paper is fed to the specified cut position and then automatically stopped.

©

. Cut the roll paper manually with scissors or the like.

10. Tap OK.

After the roll is rewound, it stops automatically.

I Paper cutting (to have the roll cut at your specified position)

1. Tap Feed/Cut on Home screen of operation panel.
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Ready to print

f Ht- Plain Paper

A3 Roll
- Replace 3¢ Feed/Cut
paper ‘
T 6| & E
3> Note

* If the Home screen does not appear, press the HOME button.

2. Tap or touch Advance or Rewind to feed roll paper to desired cutting position.
3. Tap Cut paper.

4. Tap Yes.

After the roll paper is cut, it is rewound automatically.
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I Cutting the Leading Edge of Roll Paper Automatically

If the leading edge of the paper is cut crooked or is not cut straight when roll paper is loaded, it will not print
correctly. If this happens, you can cut the leading edge of the paper straight when loading a paper roll by
using Trim edge first in the operation panel menu.

The following settings are available for Trim edge first.

* Auto

If the leading edge of the paper is cut crooked and is not cut straight when loading roll paper, cut the
leading edge straight and eject the fragment of paper to prevent printing on the platen and soiling the
printer.

* On(Preset Length)
The amount to cut from the leading edge of the paper varies depending on the media type and is cut to
a prescribed length. For the leading edge precut length, see "Paper Information List".

* On(Input Length)

The amount to cut from the leading edge of paper is specified in the operation panel. The amount to
cut from the leading edge can be specified in the range of lengths displayed in the operation panel. The
range of lengths differs according to the media type.

»» Note

» The amount to cut from the leading edge of paper cannot be set shorter than the length displayed in
the operation panel.

* Manual
The amount to cut from the leading edge of paper can be adjusted by using the operation panel.
To cut the paper after adjusting, tap Cut paper and select Yes.

After cutting the paper, tap Complete paper loading.
3> Note

+ If you do not tap Complete paper loading after cutting the paper, you cannot print the next job.

+ Off

The edge is not cut and scraps are not removed.

Follow these steps to change the Trim edge first setting.

1. Tap paper settings display area on Home screen of operation panel.
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Ready to print

f ﬂi- Plain Paper

A3 Roll
- Replace e Feed/Cut
paper
T 6|
»» Note

« If the Home screen does not appear, press the HOME button.

. Tap Paper settings.
. Tap Advanced.
. Tap Trim edge first.

. Tap desired Trim edge first settings.

This setting takes effect the next time you load a roll.
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I Reducing Dust from Cutting Rolls

If the paper tends to generate dust when cut, such as with Backlit Film, you can reduce flying dust by setting
Cut-dust reduction to ON from the operation panel menu, which will coat the leading and trailing edges

of the printed document with ink. As a result, you can reduce problems with the print head. You can set
Cut-dust reduction according to the media type.

[ _4@

\Cut Paosition
The ink is
coated.
32 Important

* Do not set Cut-dust reduction to ON for paper that wrinkles easily, such as Plain Paper or lightweight
paper. If not cut properly, the paper may jam.

» Borderless printing is not available when Cut-dust reduction is set to ON. When performing borderless
printing, set Cut-dust reduction to OFF.

Follow these steps to set Cut-dust reduction to ON.

1. Tap paper settings display area on Home screen of operation panel.

Ready to print

f dt- Plain Paper

A3 Roll
- Replace = lp Feed/Cut
paper
T 60| B
»>» Note

« |f the Home screen does not appear, press the HOME button.

2. Tap Paper settings.
3. Tap Advanced.

4. Tap Cut-dust reduction.

116



5. Tap ON.
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I Detecting Roll Paper was Replaced While the Power was Off

When you turn the printer on, it can confirm whether the roll paper was replaced while the power was off.

From Printer settings on the Home screen, set Auto feed at power on to Enable to detect the position

of the roll paper's leading edge when the power is turned on. If the position of the roll paper's leading edge
is over 1 mm since the last time the power was turned off, the printer determines that the roll paper has
been replaced, and then starts feeding paper automatically to detect the paper width and the barcode for the
management of unused roll paper.

»» Note

+ Setting Auto feed at power on to Enable causes the operations that can be done after turning on the
power to take longer since the printer must detect the leading edge of the roll paper.

+ Auto feed at power on is set to Disable when you buy the printer.
Follow these steps to set Auto feed at power on to Enable as follows.
1. Tap Q (Setup) on Home screen of operation panel.

Ready to print

f._‘t Plain Paper

A3 Roll
- Replace 3¢ Feed/Cut
paper
2 o6 [0]
»» Note

« |If the Home screen does not appear, press the HOME button.

2. Tap Printer settings.
3. Tap Paper-related settings.
4. Tap Auto feed at power on.

5. Tap Enable.
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I Handling sheets

» Loading Sheets in the Printer

» Changing the Type of Paper

» Printing From a Desired Starting Point
» Removing Sheets

» Remove a Jammed Sheet

» Specifying the Ink Drying Time
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I Loading Sheets in the Printer

Follow these steps to load sheets in the printer.

22 Important

* One sheet of paper can be loaded in the feed slot at a time. Do not load more than one sheet at a time.
This may cause paper jams.

» Before feeding paper or printing, make sure the sheet is flat against the roll paper cover. The sheet may
jam if it curls before feeding or printing and the trailing edge drops toward the front.

» Paper that is wrinkled or warped may jam. If necessary, straighten the paper and reload it.

* Load the paper straight. Loading paper askew will cause an error. (See "1317.")

»» Note

» Before loading cut sheets, check whether or not the inside of the top cover or the output guide is
soiled. If these areas are dirty, we recommend cleaning them in advance. (See "Cleaning Inside the

Top Cover.").

 Store unused paper in the original package, away from high temperature, humidity, and direct sunlight.

1. Select sheets as the paper source.

« If a print job was received

Sheets are automatically selected, and the media type and size specified by the print job are
shown on the operation panel.

Tap OK and Load paper.

* If no print job was received

1. Tap Load paper or Replace paper.
Ready to print

' There is no paper.

il

_, Load
= paper
T é o

2. Tap Load cut sheet or Replace cut sheet.

»» Note

* If the Home screen does not appear, press the HOME button.

> Note

« If any paper has been advanced that will not be used, a message is shown requesting you to
remove it.
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Follow the instructions on the screen to remove the paper, and redo the operation.

2. Slide the width guide (A) to align it with the mark for the size of paper you will load.

3. Load a single sheet printing-side up in the feed slot, with the right edge aligned with the
paper alignment line (A) to the right of the roll paper cover.

Insert the paper until the leading edge makes contact.

4. Move the width guide (A) carefully to match the size of paper loaded.

Set the width guide against the edge of the paper to prevent the paper from becoming crooked or
wrinkled.
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5. Tap Start feeding.

« If a print job was received

Tap Start feeding to feed the paper and begin printing.

* If no print job was received
A menu for selecting the media type appears.
Select the media type loaded and tap OK.

The printer now starts feeding the paper.

»» Note

* For details on media types that you can select, see "Paper Information List."

122



I Printing From a Desired Starting Point

Print on sheets from a desired starting point as follows.

I Setting Detect paper width to Disable

1. Tap paper settings display area on Home screen of operation panel.

Ready to print

\ { dl: Flain Paper

A3 Roll
—. Replace ip Feed/Cut
e ¥
paper
T b o2
»» Note

* |If the Home screen does not appear, press the HOME button.

2. Tap Paper settings.
3. Tap Advanced.

4. Select Detect paper width and tap Disable.

I Load paper in the desired position to start printing from

Follow these instructions to load paper at the desired starting position for printing when Detect paper
width is set to Disable.

1. If you did not send a print job in advance, a menu for selection of the type of paper is
displayed.
Tap media type loaded.
»» Note

« If a print job was received before the paper was fed, the media type and size specified by the
job are shown on the operation panel.

Go to step 2.

2. When "[Detect paper width] is disabled. Do you want to keep it disabled and
continue?" appears on operation panel, tap Keep it disabled and continue.
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3. Open top cover and check position where paper is loaded.

To start printing from the current position, close the top cover.

To reposition the paper, push the release lever back.

4. Load paper keeping right edge of paper aligned with extended line of paper alignment line
(A) on right side of printer and position from which to start printing aligned with groove (B)
at far end of platen.
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6. When screen for selecting paper size appears, select size of paper loaded.
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I Removing Sheets

Remove sheets from the printer as follows.

1. Tap paper settings display area on Home screen of operation panel.

Ready to print

s FPlain Paper
= Ad

. Replace
" paper

T 6| & | E

12> Note

« |If the Home screen does not appear, press the HOME button.

2. Tap Remove paper.

3. Check operation panel message and tap Yes.

The paper is ejected from the front of the printer.

4. Holding the paper, push the release lever back and remove the sheet.

5. Pull the release lever forward.
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I Basket

» Using the Basket
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I Using the Basket

You can store printed documents in the basket.

When storing printed documents in the basket, use the basket in position (1).

When you are not using the basket, store it in position (2).

32 Important

* When storing printed documents on the basket, always use it in position (1). If you do not, printed
documents may not be dropped into the basket, and the printed surface may become soiled.

* To store printed documents in the basket, first pull down the side rod (B) evenly so that the front rod (A)
is not askew, and then use the basket.

* The number of sheets that can be collected in the basket is one. If printing multiple pages, print after
removing each sheet.

* The basket can hold printed documents from paper up to 48 inches (1219.2 mm) long.

* When moving the stand, make sure that the basket does not graze the floor and that all four of the
casters are unlocked before moving the stand. Not doing so may damage the basket, scratch the floor,
or cause injuries.
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« If the cloth part of the basket becomes dirty, wipe off the dirt without washing. Washing it may affect the
performance of the basket.
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I Changing Printer's Setting

» Changing Settings from Operation Panel
« Home Screen Menu Composition

Menu Structure

Setting Items on Operation Panel

Setting Administrator Password on Operation Panel

Erasing Data on Printer's Hard Disk

Status Print

» Changing Printer's Setting Using Web Browser
« Start up Remote Ul
« Changeable Setting Items Using Remote Ul
@ Setting Passwords Using Remote Ul
« Registering Printer's Root Certificate to Web Browser for SSL Communication
« Registering Printer's Root Certificate to Local Computer for SSL Communication
@« Generating Server Certificate

@ Setting Mail Server

Receiving Printer Status by E-mail
» Migrating Printer's Setting

» Initializing Printer's Setting
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I Changing Settings from Operation Panel

» Home Screen Menu Composition
» Menu Structure

» Setting Items on Operation Panel

¥

Setting Administrator Password on Operation Panel
» Erasing Data on Printer's Hard Disk

» Status Print
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I Home Screen Menu Composition

After the printer starts up, the HOME screen appears on the touch screen.

From the HOME screen, you can check the printer status and select the maintenance, paper operations,
settings, and other menus.

= Basic Touch Screen Operations

Ready to print — A
(€ Plain Paper

= A3 Roll

B

- Replace 3 Feed/Cut

= paper ¥
RN

| | I I

c D E F

A: Printer Information Display Area

Displays the printer status, messages, and other information. Tap this item when a message appears to
view the message on the list screen and to jump to the screen with detailed information and operations.

= Notification Messages

B: Paper Setting Display Area
Displays the information on loaded paper on the upper area. Tapping this option displays the menu

relating paper and allows the paper settings. Replace paper and Feed/Cut frequently used in the menu
appears on the lower area, and you can directly select.

C: Network

Displays the current network status. Select to display the basic network information or to change the
network settings.

The icon differs depending on the network of use or the network status.
=
®  Wi-Fiis enabled and the printer is connected to the wireless router.
»» Note
» Depending on the signal state, the icon will change.
=
¥ (Signal strength: 81 % or more): You can use the printer over a Wi-Fi without any problems.
—
(Signal strength: 51 % or more): The problem such as the printer cannot print may occur
according to the network status. We recommends placing the printer near the wireless router.
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o)

(Signal strength: 50 % or less): The problem such as the printer cannot print may occur.
Place the printer near the wireless router.

—_

* X Wi-Fi is enabled but the printer is not connected to the wireless router.

Wired LAN is enabled.

Wireless Direct is enabled.

Py e |

N S

¢ E\L“ Wi-Fi and Wired LAN are disabled.

D: Ink information
Selects when checking current estimated ink levels or replacing ink tanks.

E: Setup
Selects when changing the printer settings, performing maintenance, or checking printer information.

F: Job management
Select when setting up print job managements or printing data on a USB flash drive.

»» Note

» By default, menu settings apply to all print jobs. However, for settings that are also available in the
printer driver, the values specified in the printer driver take priority.

I Basic Touch Screen Operations
You can select various functions and settings by gently touching and swiping the touch screen with your
fingertip.

32 Important

» Take the following precautions when operating the touch screen. Otherwise, the touch screen may
malfunction or become damaged.

— Do not forcibly press the touch screen with your finger.

— Do not press the touch screen with an object other than your finger (such as a ballpoint pen,
pencil, fingernail, or other object with a sharp tip).

— Do not operate the touch screen with wet or dirty hands.

— Do not place objects on top of the touch screen.

» Do not place a protective film over the touch screen. Removing it can damage the touch screen.

Tap
Gently touch with your fingertip and then release.

Use this when selecting an item on the screen.
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Touch
Gently touch with your fingertip.

To go (or return) to a menu or list, touch the directional mark.

Flick
Drag and release your finger up, down, left, or right.

Use this to quickly scroll through a menu or list.

Drag
Move your finger up, down, left, or right while gently keeping it in contact with the touch screen.

Use this to move a menu or list while viewing it.
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I Notification Messages

When the ink is low or there is another notification, New notice appears in the printer information display
area. Tap this to display the Notice list screen to view messages with the newest one appearing first. Tap
a message to display the message details screen to view the details and take action.

Example: Notices on the maintenance cartridge

I New notice >

r‘_t Flain Paper
= A3 Roll

- Replace R Feed/Cut

= paper
10
.

= b
Notice list

! The maintenance
cartridge is
almast full,

te

Maintenance cartridge info

Maintenance cartridge usage

@®

Replace
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I Menu Structure

The * on the right side of an item indicates the default value.

Values may vary depending on your model and firmware version.

» Paper menu (when roll paper is loaded)

This menu is displayed by tapping paper information area.

Replace paper

Feed/Cut

Remove paper

Paper settings

Width

Type

Advanced

Buy paper

* Paper menu (when cut sheet is loaded)

This menu is displayed by tapping paper information area.

Replace paper

Remove paper

Paper settings

Page size

Type

Advanced

Buy paper

* Replace paper

* Feed/Cut

This menu is displayed when roll paper is loaded.

* LAN settings

This menu is displayed by tapping Network icon.

Wi-Fi

Connection

Network name (SSID)

Communication mode

Channel

Wi-Fi security
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IPv4 address

IPv4 subnet mask

IPv4 default gateway

IPv4 DNS dynamic settings

IPv4 DNS host name

IPv4 DNS domain name

IPv6 link-local address

IPv6 link-local prefix length

IPv6 manual address

IPv6 manual prefix length

IPv6 stateless address 1

IPv6 stateless prefix length 1

IPv6 stateless address 2

IPv6 stateless prefix length 2

IPv6 stateless address 3

IPv6 stateless prefix length 3

IPv6 stateless address 4

IPv6 stateless prefix length 4

DHCPv6

DHCPv6 stateful address

DHCPv6 stateful prefix length

IPv6 default gateway 1

IPv6 default gateway 2

IPv6 default gateway 3

IPv6 default gateway 4

IPv6 primary DNS server address

IPv6 secondary DNS server add.

IPv6 DNS dyn. update: manual

IPv6 DNS dyn. update: stateless

IPv6 DNS dyn. update: stateful

IPv6 Use IPv4 host/domain name

IPv6 DNS host name

IPv6 DNS domain name

MAC address

IPsec settings

Printer name
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Bonjour service name
Settings
Enable/disable Wi-Fi
Enable / Disable
Wi-Fi setup
Easy wireless connect
Manual connect
WPS (Push button method)
Other connection types
Manual connect (adv.)
WPS (PIN code method)
Advanced

Wireless Direct

Connection

Network name (SSID)

Password

Communication mode

Channel

Wi-Fi security

IPv4 address

IPv4 subnet mask

IPv4 default gateway

IPv4 DNS dynamic settings

IPv4 DNS host name

IPv4 DNS domain name

IPv6 link-local address

IPv6 link-local prefix length

MAC address

IPsec settings

Printer name

Bonjour service name

Settings

Enable/disable Wireless Direct

Yes / No

Update SSID/password

Yes / No
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Wireless Direct network (SSID)

Connection request confirmation

ON*/ OFF

Advanced

Wired LAN

Connection

IPv4 address

IPv4 subnet mask

IPv4 default gateway

IPv4 DNS dynamic settings

IPv4 DNS host name

IPv4 DNS domain name

IPv6 link-local address

IPv6 link-local prefix length

IPv6 manual address

IPv6 manual prefix length

IPv6 stateless address 1

IPv6 stateless prefix length 1

IPv6 stateless address 2

IPv6 stateless prefix length 2

IPv6 stateless address 3

IPv6 stateless prefix length 3

IPv6 stateless address 4

IPv6 stateless prefix length 4

DHCPv6

DHCPv6 stateful address

DHCPv6 stateful prefix length

IPv6 default gateway 1

IPv6 default gateway 2

IPv6 default gateway 3

IPv6 default gateway 4

IPv6 primary DNS server address

IPv6 secondary DNS server add.

IPv6 DNS dyn. update: manual

IPv6 DNS dyn. update: stateless

IPv6 DNS dyn. update: stateful
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IPv6 Use IPv4 host/domain name

IPv6 DNS host name

IPv6 DNS domain name

MAC address

IPsec settings

Printer name

Bonjour service name

Settings

Enable/disable Wired LAN

Enable / Disable

Advanced

Print details

* Ink information

This menu is displayed by tapping Ink icon.

Current estimated ink levels

Replace

Order ink now

» Setup
This menu is displayed by tapping Setup icon.

Printer settings

Test print

Nozzle Check

Status print

Status print (administrator)

Print LAN details

Print the print settings

Print advanced paper settings

Print job history

Print menu map

Print the color chart

Print settings

Print head movable width setting

Data width* / Maximum movable width / Paper width

Prioritize paper size
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Enable / Disable*

Magnification level for borderless

Large / Medium* / Small / Minimum

PDF print settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) /
Monochrome / FL spot color

Print quality

5 (Fast) /4 /3*/2/1 (High)

Input resolution

600 dpi / 300 dpi*

Print target

Photo / Poster (fluorescent)*

Paper settings

Paper src

Auto select* / Roll paper / Manual

Margin

3mm*/ 5mm

Border

Borderless / Bordered*

Oversize

Enable / Disable*

Save paper

ON / OFF*

Rotate

0 degrees* / 90 degrees

Auto rotation

ON / OFF*

Enlarge/Reduce

Fit paper size* / Same size / Scaling

Print centered

ON / OFF*

Cut to standard size

ON / OFF*

Line & pen manager
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Width corre

ction

Black/gray

Color

Processing options

Warning display

Enable / Disable*

JPEG print settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) /
Monochrome / FL spot color

Print quality

5 (Fast) /4 /3*/2/1 (High)

Input resolution

600 dpi / 300 dpi* / Specify print job

Print target

Photo / Poster (fluorescent)*

Paper settings

Paper src

Auto select* / Roll paper / Manual

Margin

3mm* / 5mm

Border

Borderless / Bordered*

Rotate

0 degrees* / 90 degrees

Auto rotation

ON / OFF*

Enlarge/Reduce

Fit paper size* / Same size / Scaling

Print center

ed

ON / OFF*

Cut to standard size

ON / OFF*

Print from USB flash settings

Print quality settings
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Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) /
Monochrome / FL spot color

Print quality

5 (Fast) /4 /3*/ 2/ 1 (High)

Print target

Photo / Poster (fluorescent)*

Paper settings

Paper src
Auto select* / Roll paper / Manual
Margin
3mm*/ 5mm
Border
Borderless / Bordered*®
Rotate

0 degrees* / 90 degrees

Auto rotation

ON / OFF*

Enlarge/Reduce

Fit paper size* / Same size / Scaling

Print centered

ON / OFF*

Cut to standard size

ON / OFF*

AirPrint

print settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) /
Monochrome / FL spot color

Print resolution

Standard* / Speed priority / Print priority

Print target

Photo / Poster (fluorescent)*

Paper settings

No Top/Btm Space (Save Paper)

ON / OFF*

144




Unidirectional printing

Enable / Dis

able*

Direct p

rint settings from FTP

Print settings 1

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color
(correct off) / Monochrome / FL spot color

Print quality

5 (Fast) / 4/ 3*/ 2 /1 (High)

Input resolu

tion

600 dpi / 300 dpi* / Specify print job

Print target

Photo / Poster (fluorescent)*

Paper settings

Paper src

Auto select* / Roll paper / Manual
Margin

3mm*/ 5mm
Border

Borderless / Bordered*
Oversize

Enable* / Disable
Save paper

ON / OFF*
Rotate

0 degrees™ / 90 degrees

Auto rotatio

n

ON / OFF*

Enlarge/Reduce

Fit paper size* / Same size / Scaling

Print centered

ON / OFF*

Cut to standard size

ON / OFF*

Line & pen manager
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Width corr

ection

Black/gray

Color

Processing options

Warning display

Enable / Disable*

Print settings 2

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color
(correct off) / Monochrome / FL spot color

Print quality

5 (Fast) /4 /3*/ 2/ 1 (High)

Input resolution

600 dpi / 300 dpi* / Specify print job

Print target

Photo / Poster (fluorescent)*

Paper settings

Paper src

Auto select* / Roll paper / Manual
Margin

3mm* / 5mm
Border

Borderless / Bordered*
Oversize

Enable* / Disable
Save paper

ON / OFF*
Rotate

0 degrees* / 90 degrees

Auto rotation

ON / OFF*

Enlarge/Reduce

Fit paper size* / Same size / Scaling

Print centered

ON / OFF*
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Cut to standard size

ON / OFF*

Line & pen manager

Width correction

Black/gray

Color

Processing options

Warning display

Enable / Disable*

Print sett

ings 3

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color
(correct off) / Monochrome / FL spot color

Print quality

5 (Fast) /4 /3*/ 2/ 1 (High)

Input resolu

tion

600 dpi / 300 dpi* / Specify print job

Print target

Photo / Poster (fluorescent)*

Paper settings

Paper src

Auto select* / Roll paper / Manual
Margin

3mm*/ 5mm
Border

Borderless / Bordered*
Oversize

Enable* / Disable
Save paper

ON / OFF*
Rotate

0 degrees* / 90 degrees

Auto rotatio

n

ON / OFF*

Enlarge/Reduce
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Fit paper size* / Same size / Scaling

Print centered

ON / OFF*

Cut to standard size

Line & pen

ON / OFF*
manager
Width correction
Black/gray
Color

Processing options

Warning display

Enable / Disable*

Print sett

ings 4

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color
(correct off) / Monochrome / FL spot color

Print quality

5 (Fast) /4 /3*/ 2/ 1 (High)

Input resolution

600 dpi / 300 dpi / Specify print job*

Print target

Photo / Poster (fluorescent)*

Paper settings

Paper src

Auto select* / Roll paper / Manual
Margin

3mm*/ 5mm
Border

Borderless / Bordered*®
Oversize

Enable* / Disable
Save paper

ON / OFF*
Rotate

0 degrees* / 90 degrees
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Auto rotation

ON / OFF*

Enlarge/Reduce

Fit paper size* / Same size / Scaling

Print centered

ON / OFF*

Cut to standard size

ON / OFF*

Line & pen manager

Width correction

Black/gray

Color

Processing options

Warning display

Enable / Disable*

Default print settings

Print quality settings

Color mode

Color (perceptual) / Color (saturation)* / Color (correct off) /
Monochrome / FL spot color

Print quality

5 (Fast) / 4/ 3*/ 2/ 1 (High)

Print target

Photo / Poster (fluorescent)*

Print the print settings

LAN settings
The lower items of this menu are the same as the lower items of LAN settings displayed by tapping
Network icon.

Web service setup

Web service usage registration / Web service usage cancellation

Issue registration code

DNS server setup

Auto setup* / Manual setup

Proxy server setup

Use / Do not use*

Web service inquiry

Print from Canon server
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Paper-related settings

Keep media type

Enable / Disable*

Manage remaining roll amount

Barcodes / Warning message only / Disable*

Roll amount warning settings

Roll amount 6 (earlier warning) / Roll amount 5/ Roll amount 4 / Roll amount 3
(standard)* / Roll amount 2 / Roll amount 1 (later warning)

Detect paper setting mismatch

Pause / Display warning* / Do not detect / Hold job

Advanced paper settings

Paper size recognition settings

Roll paper setting 1

Roll paper setting 2

Roll paper setting 3

Roll paper setting 4

Roll paper setting 5

Roll paper setting 6

Roll paper setting 7

Keep margin at cut sheet end

Enable / Disable*

Auto feed at power on

Enable* / Disable

Add priority roll paper width

Setting 1

Setting 2

Setting 3

Print advanced paper settings

Reset paper settings for all paper

Auto maintenance settings

Auto nozzle check

Standard* / 1 page / 10 pages / Disable

Nozzle check error display

Enable / Disable*

System Cleaning frequency

Standard* / Short
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Print pattern after new head

ON*/ OFF

Hard disk settings

Output method

Print* / Print (auto delete) / Save to job box

Save first and print

ON / OFF*

Common job box settings

Print* / Print (auto delete)

File deletion settings

Fast* / Fast secure / Secure / Secure (VSITR)

Data deletion

Fast

Fast secure

Secure

Secure (VSITR)

Monitoring service settings

Enable/disable monitoring service

Enable / Disable*

Communication test

Communication log

Warning notification settings

Enable* / Disable

Other

printer settings

Energy saving settings

Auto power off

5 minutes / 10 min. / 30 min. /1 hour /4 hours / 8 hours / 12 hours / OFF

Sleep timer

5 minutes*/ 10 min. / 15 min. / 20 min. / 30 min. / 40 min. / 50 min. / 60 min.

Use USB connection

Use* / Do not use

Date/time settings

Date display format

YYYY/MM/DD / MM/DD/YYYY / DD/IMM/YYYY

Time zone (GMT)

0/+1/../+12/-12/../1
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Sound control

Keypad sound

ON/ OFF*

Alarm sound

ON*/ OFF

Length unit settings

Meters* / Feet/inches

EOP timer settings

1 minute / 2 minutes / 5 minutes / 10 minutes* / 30 minutes / 60 minutes

Job history sending settings

Send / Do not send”

Language selection

Firmware update

Install update

Check current version

Update notification settings

Yes*/ No

DNS server setup

Auto setup* / Manual setup

Proxy server setup

Use / Do not use*

Security settings

Administrator password settings

Remote Ul and other tools .~ LCD, Remote Ul, and other tools

Operation restrictions

Job history

Restrict / Do not restrict®

Remote Ul

Restrict / Do not restrict*

Print from USB flash drive

Restrict / Do not restrict*

IEEE802.1X settings

Authentication

Do not use*/ TLS / TTLS / PEAP

EAP-TTLS internal auth. method

MSCHAPv2* / PAP
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Weak encryption restriction

Restrict* / Do not restrict

Weak certificate restriction

Restrict* / Do not restrict

Advanced setup

User-ID

Username

Password

Authentication server name

Verify auth. server name

Verify auth. server certificates

Last authentication result

Import/export settings

Import

Export

Initialize printer settings

Maintenance

Troubleshooting

Nozzle Check

Print Head Cleaning

Cleaning

All colors / Pattern 1 / Pattern 2

Deep Cleaning

All colors / Pattern 1 / Pattern 2

System Cleaning

All colors / Pattern 1 / Pattern 2

Print Head Alignment

Auto (standard)

Auto (advanced)

Manual

Print head angle adjustment

Paper feed adjustment

Set priority

Auto / Prioritize print quality / Prioritize length accuracy

Adjust print quality

Auto
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Manual

Adjust feed length

Print alignment pattern

Change adjustment values

-0.70% / -0.68% /

...10.68% /0.70%

Maintenance cartridge info

Maintenance cartridge usage

Replace

Head Replacement

Start head replacement.

Replace cutter blade unit

Platen cleaning

Prepare to move

Move on the same floor

Transport outdoors

Printer information

System information

Current version

Printer name

Serial number

MAC address (Wi-Fi)

MAC address (Wired LAN)

Root cert. thumbprint (SHA-1)

Root cert. thumbprint (SHA-256)

Hard disk information

Hard disk capacity

Job box free space

Error history

Hardware error

Recoverable error

Paper feed/transfer error

Usage

Total print area

Ink consumed

Duty counter

Head information
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Serial number

Installation date

Dot count (million dots)

Head alignment performance log

Values applied with auto settings

Paper thickness (head height)

Transport unit vacuum strength

Total print area

+ Job management

This menu is displayed by tapping Jobs icon.

Print job

List of print jobs

Saved job

Job box list

Job list

Print the job list

Print from USB flash drive

Folderffile list

Copies

Preview

Settings
The lower items of this menu are the same as the lower items of Print from USB flash settings.

Start print

Job history

Display job history

Print job history

Pause printing

Enable / Disable*

Delete all print jobs
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I Advanced (Paper settings)

Tap the paper

information area and tap Paper settings to display this menu.

Advanced

Roll length (change default)

Paper thickness (head height)

Auto / -4 (Low) / -3 / -2 / 0 (Standard) / +1 / +2 / +3 (High)

Skew detection accuracy

Standard / Loose / OFF

Cutting mode

Automatic cut / Eject cut / User cut

Cut speed

Fast / Standard / Slow

Trim edge first

Auto / Off / On(Preset Length) / On(Input Length) / Manual

Cut-du

st reduction

ON / OFF

Transport unit vacuum strength

Auto / Strong / Medium-strong / Standard / Medium-weak / Weak

Roll paper tension (printing)

High / Standard / Low

Roll paper tension (feeding)

High / Standard / Low

Pause

between scans

Ink drying wait time

OFF / 0.5 seconds / 1 second / 3 seconds / 5 seconds / 7 seconds / 9 seconds

Ink drying target area

Overall / Leading edge

Pause

between pages

OFF / 30 seconds / 1 minute / 3 minutes / 5 minutes / 10 minutes / 30 minutes / 60 minutes

Leadin

g edge margin (roll)

3mm/20mm

Leadin

g edge margin (sheet)

3mm/20mm

Extens

ion for borderless printing

Paper with recommended width
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Large / Standard / Small

Paper of sufficient width

Select extension amount

1(min)/2/3/4/5/6/7/8 (max)

Detect paper width

Enable / Disable

Reset paper settings by paper
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I Advanced (LAN settings)

This menu is displayed by tapping Network icon > Wi-Fi / Wireless Direct / Wired LAN > Settings >
Advanced.

The * on the right side of an item indicates the default value.

Advanced
Set printer name
TCPI/IP settings
IPv4
IP address
Auto setup* / Manual setup
DNS server
DNS server setup
Auto setup” / Manual setup
Dynamic update settings
Enable / Disable*
Host name
Domain name
Proxy server
Use / Do not use*
DHCP option settings
Acquire host name
Enable / Disable*
DNS dynamic update
Enable / Disable*
Acquire domain name
Enable / Disable*
IPv6
Enable/disable IPv6
Enable* / Disable
IPsec settings
Enable / Disable*
Use DHCPv6
Use* / Do not use
Manual address
Use / Do not use*
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DNS server

DNS server setup

Auto setup” / Manual setup

Dynamic update settings

IPv6 DNS dyn. update: manual

Enable / Disable*

IPv6 DNS dyn. update: stateless

Enable / Disable*

IPv6 DNS dyn. update: stateful

Enable / Disable*

IPv6 Use IPv4 host/domain name

Enable / Disable*

IPv6 DNS host name

IPv6 DNS domain name

DHCP option settings

Acquire host name

Enable / Disable*

DNS dynamic update

Enable / Disable*

Acquire domain name

Enable / Disable*

WSD settings

Enable/disable WSD

Enable / Disable*

Optimize inbound WSD

Enable* / Disable

Timeout settings

20 minutes / 15 minutes” / 10 minutes / 5 minutes / 1 minute

Bonjour settings

Enable/disable Bonjour

Enable* / Disable

Service name

SNTP settings

Client operation status

Enable / Disable*

NTP server address
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Polling interval

Spanning tree settings

Enable / Disable*

LPR protocol settings

Enable* / Disable

RAW protocol

ON*/ OFF

LLMNR

ON* / OFF

Gigabit Ethernet settings

Autonegotiation* / 10 Mbps half duplex / 10 Mbps full duplex / 100 Mbps half duplex / 100 Mbps
full duplex / 1 Gbps full duplex

Use Dedicated Port

ON*/ OFF

IPP settings

Enable/disable IPP

Enable* / Disable

Security Print

Enable* / Disable

Wi-Fi DRX settings

Enable* / Disable

Wired LAN DRX settings

Enable* / Disable

Reset SSL certificates

Reset LAN settings
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I Setting Items on Operation Panel

»» Note

* The administrator password is required to change some setting items if it is enabled for changing
settings using the operation panel.

For more on setting items which the administrator password is required:

= Setting Administrator Password on Operation Panel

Ready to print

(& Plain Paper
>* A3 Roll

- Replace 3p Feed/Cut
= e
paper

= 6|0 | E

= (Network)
!’:}—-(Setup)

* Printer settings
> Test print
o Print settings
o LAN settings

o Web service setup

o Paper-related settings

o Auto maintenance settings

o Hard disk settings

o Monitoring service settings

o Other printer settings

o Language selection

o Firmware update

o Security settings
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o Import/export settings

= Migrating Printer's Setting

o Initialize printer settings

= |nitializing Printer's Setting

¢ Maintenance

¢ Printer information

(Jobs)
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I Maintenance

It will be displayed whenyoutap.____— | (Setup) on HOME screen.

* Nozzle Check
Prints out the nozzle check pattern.

= Checking for Nozzle Clogging

* Print Head Cleaning
Select this to clean the print head.

= Cleaning the Print Head

* Print Head Alignment
Adjusts the alignment of print head.

= Automatic Adjustment to Straighten Lines and Colors
= Manual Adjustment to Straighten Lines and Colors

* Print head angle adjustment
Adjusts the print head angle.

= Adjusting Line Misalignment

* Paper feed adjustment
Adjusts the paper feed amount.

= Adjusting Feed Amount

* Maintenance cartridge info

Displays the estimated usage of maintenance cartridge. Select Replace to replace the maintenance
cartridge.

= Replacing the Maintenance Cartridge

* Head Replacement
Select this to replace the print head.

= Replacing the Print Head

* Replace cutter blade unit
Select this to replace the cutter blade.

= Replacing the Cutter Blade

* Platen cleaning
Select this to clean inside the top cover.

= Cleaning Inside the Top Cover
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* Prepare to move
Select this to prepare for transporting the printer.

= Preparing to Transfer the Printer
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I Job management

It will be displayed when you tap L (Jobs) on HOME screen.

Print job

Displays the print job list. Tapping a job displays the details. You can also delete or preempt jobs on this
menu.

Saved job

Displays the saved print job list. You can print / delete saved jobs and print job list on each job box.

»» Note

» Enter the password if it is enabled for a personal job box using Remote Ul.

Print from USB flash drive
Displays a list of the data saved on the USB flash drive. You can set the print settings and print the data

from this menu.

Job history
32 Important

» The administrator password is required to display the job history if it is enabled for changing
settings using the operation panel.

o Display job history
Displays the print job history. Tapping a print job displays the details.

o Print job history
Prints out the print job history.

Pause printing

Selecting Enable while a print job is in progress pauses the print job after the current job is completed.

Delete all print jobs

Deletes all jobs in the job queue.
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I LAN settings

This setting item is displayed by tapping Printer settings after tappingL_____ | (Setup) on the HOME
screen.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.
3> Note
—_—
* You can also enter LAN settings by tapping ¥ (Network) on the HOME screen.
* Wi-Fi

The following setting information on the Wi-Fi connection is displayed. (Some items are not displayed
depending on printer settings.)

Items Setting

Connection Enabled (connected) / Enabled (disconnected) / Disa-
ble

Network name (SSID) XXXXXXXXXXXXXXXX
XXXXXXXXXXXXXXXX (up to 32 characters)

Communication mode Infrastructure

Channel 1-13

Wi-Fi security Disable / WEP (64 bit) / WEP (128 bit) / WPA-PSK
(TKIP) / WPA-PSK (AES) / WPA2-PSK (TKIP) / WPA2-
PSK (AES)

IPv4 address XXX XXX, XXX. XXX (12 characters)

IPv4 subnet mask XXX, XXX. XXX. XXX (12 characters)

IPv4 default gateway XXX, XXX. XXX. XXX (12 characters)

IPv4 DNS dynamic settings Enable / Disable

IPv4 DNS host name XXX XXXXXXXXX

IPv4 DNS domain name XXXXXXXXXXXX

IPv6 link-local address XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 link-local prefix length XXX (up to 3 digits)

IPv6 manual address XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 manual prefix length XXX (up to 3 digits)

IPv6 stateless address 1 XXXX: XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX: XXXX (32 characters)
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IPv6 stateless prefix length 1

XXX (up to 3 digits)

IPv6 stateless address 2

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 2

XXX (up to 3 digits)

IPv6 stateless address 3

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 3

XXX (up to 3 digits)

IPv6 stateless address 4

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 4

XXX (up to 3 digits)

DHCPv6

Enable / Disable

DHCPv6 stateful address

XXXXXXXXXXXX

DHCPvV6 stateful prefix length

XXX (up to 3 digits)

IPv6 default gateway 1

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 default gateway 2

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 default gateway 3

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 default gateway 4

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 primary DNS server address XXXXXXXXXXXX
IPv6 secondary DNS server add. XXXXXXXXXXXX
IPv6 DNS dyn. update: manual Enable / Disable
IPv6 DNS dyn. update: stateless Enable / Disable
IPv6 DNS dyn. update: stateful Enable / Disable
IPv6 Use IPv4 host/domain name Enable / Disable
IPv6 DNS host name XXXXXXXXXXXX
IPv6 DNS domain name XXXXXXXXXXXX

MAC address

XXXX XX XX:XX: XX (12 characters)

IPsec settings

Enable (ESP) / Enable (ESP & AH) / Enable (AH) /

Disable

Printer name

XXXXXXXXXXXXXXX (up to 15 characters)

Bonjour service name

XXXXXXXXXXXXX
XXXXXKXXKXXXX
XXXXXKXXKXXXX

XXXXXXXXXXXXX (up to 52 characters)

("XX" represents alphanumeric characters.)

To change the setting, tap Settings.
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o Enable/disable Wi-Fi

Select Enable to wirelessly connect via wireless router.

o Wi-Fi setup
Select how to setup Wi-Fi.

= Easy wireless connect

Select if you specify the settings of the access point information to the printer directly from a
device (e.g. smartphone, or tablet) without operating the wireless router. Follow the on-screen
instructions of the connecting device for the setup procedure.

= Manual connect

Select when you perform settings for Wi-Fi manually using the operation panel of the printer.

= WPS (Push button method)

Select when you perform settings for Wi-Fi using a wireless router supporting a Wi-Fi Protected
Setup (WPS) push button method. Follow the on-screen instructions during setup.

= Other connection types

= Manual connect (adv.)

Select when you perform settings for Wi-Fi manually. You can specify multiple WEP keys.

= WPS (PIN code method)

Select when you perform settings for Wi-Fi using a wireless router supporting a Wi-Fi
Protected Setup (WPS) PIN code method. Follow the on-screen instructions during setup.

»» Note

» By tapping Advanced, you can set LAN in detail.

For the items that can be set, see the following.

= Advanced

* Wireless Direct

The following setting information on the Wireless Direct connection is displayed. (Some items are not

displayed depending on printer settings.)

Items

Setting

Connection

Enable / Disable

Network name (SSID)

DIRECT-XXXX-GP-NNNN*1

Password

XXXXXXXXXX (10 characters)

Communication mode

Wireless Direct

Channel 3
Wi-Fi security WPAZ2-PSK (AES)
IPv4 address XXX, XXX, XXX. XXX (12 characters)

IPv4 subnet mask

XXX, XXX, XXX. XXX (12 characters)

IPv4 default gateway

XXX, XXX, XXX. XXX (12 characters)
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IPv4 DNS dynamic settings Enable / Disable

IPv4 DNS host name XXXXXXXXXXXX
IPv4 DNS domain name XXXXXXXXXXXX
IPv6 link-local address XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX: XXXX: XXXX (32 characters)

IPv6 link-local prefix length XXX (up to 3 digits)
MAC address XX XX XX XX:XX: XX (12 characters)
IPsec settings Disable
Printer name XXXXXXXXXXXXXXX (up to 15 characters)
Bonjour service name XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX

XXXXXXXXXXXXX (up to 52 characters)

*1 means printer's model name
("XX" represents alphanumeric characters.)
To change the setting, tap Settings.
o Enable/disable Wireless Direct
Select Enable to wirelessly connect without wireless router.
o Update SSID/password
Updates the identifier (SSID) and password.
o Wireless Direct network (SSID)
Changes the name (device name) of the printer displayed on Wi-Fi Direct compatible device.
o Connection request confirmation

Changes the display / non-display of the confirmation screen when Wi-Fi Direct compatible devices
are connected to the printer.

»>» Note
» By tapping Advanced, you can set LAN in detail.
For the items that can be set, see the following.

= Advanced

* Wired LAN

The following setting information on the Wired LAN connection is displayed. (Some items are not
displayed depending on printer settings.)

Items Setting

Connection Enabled (connected) / Enabled (disconnected) / Disa-
ble

IPv4 address XXX, XXX, XXX. XXX (12 characters)

IPv4 subnet mask XXX XXX, XXX. XXX (12 characters)
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IPv4 default gateway

XXX, XXX. XXX. XXX (12 characters)

IPv4 DNS dynamic settings Enable / Disable
IPv4 DNS host name XXXXXXXXXXXX
IPv4 DNS domain name XXXXXXXXXXXX

IPv6 link-local address

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 link-local prefix length

XXX (up to 3 digits)

IPv6 manual address

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 manual prefix length

XXX (up to 3 digits)

IPv6 stateless address 1

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 1

XXX (up to 3 digits)

IPv6 stateless address 2

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 2

XXX (up to 3 digits)

IPv6 stateless address 3

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 3

XXX (up to 3 digits)

IPv6 stateless address 4

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 stateless prefix length 4

XXX (up to 3 digits)

DHCPv6

Enable / Disable

DHCPv6 stateful address

XXXXXXXXXXXX

DHCPv6 stateful prefix length

XXX (up to 3 digits)

IPv6 default gateway 1

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 default gateway 2

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 default gateway 3

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 default gateway 4

XXXX: XXXX: XXXX:
XXXX: XXXX: XXXX:

XXXX:
XXXX (32 characters)

IPv6 primary DNS server address XXXXXXXXXXXX
IPv6 secondary DNS server add. XXXXXXXXXXXX
IPv6 DNS dyn. update: manual Enable / Disable
IPv6 DNS dyn. update: stateless Enable / Disable
IPv6 DNS dyn. update: stateful Enable / Disable
IPv6 Use IPv4 host/domain name Enable / Disable
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IPv6 DNS host name XXXXXXXXXXXX
IPv6é DNS domain name XXXXXXXXXXXX
MAC address XXXXXXXX:XX: XX (12 characters)
IPsec settings Enable (ESP) / Enable (ESP & AH) / Enable (AH) /
Disable
Printer name XXXXXXXXXXXXXXX (up to 15 characters)
Bonjour service name XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX
XXXXXXXXXXXXX (up to 52 characters)

("XX" represents alphanumeric characters.)
To change the setting, tap Settings.
o Enable/disable Wired LAN
Select Enable when connecting to wired LAN.
3> Note
» By tapping Advanced, you can set LAN in detail.
For the items that can be set, see the following.

= Advanced

* Print details

Prints out the LAN setting information of the printer with Wi-Fi connection, wired LAN connection,
wireless direct connection.

For the items that can be checked, see the following.
= Printing Network Settings
22 Important

+ Important information on your computer is stated on the paper on which the LAN setting information
is printed. Please handle with care enough.

»» Note

* You can also print out the LAN setting information by tapping in the following order.

&

(Setup) > Printer settings > Test print > Print LAN details

« Advanced

By tapping Advanced on each setting screen of Wi-Fi connection, wired LAN connection, wireless direct
connection, LAN information can be set in detail.

32 Important

« If the LAN is disabled, the following items can not be selected.
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o Set printer name
Specifies the printer name. You can use up to 15 characters for the name.

»» Note

* You cannot use the same printer name as that already used for other LAN connected devices.
* You cannot use a hyphen for the initial or last character of the printer name.
o TCP/IP settings
Performs IPv4 or IPv6 setting.
o WSD settings

Setting items when you use WSD (one of the network protocols supported in Windows 10, Windows
8.1, and Windows 7).

= Enable/disable WSD
Selects whether WSD is enabled or disabled.
»>» Note

* When this setting is enabled, the printer icon is displayed on the Network Explorer in
Windows 10, Windows 8.1, and Windows 7.
= Optimize inbound WSD
Selecting Enable allows you to receive the WSD printing data faster.
» Timeout settings
Specifies the timeout length.
o Bonjour settings
Setting items for LAN using Bonjour.
= Enable/disable Bonjour
Selecting Enable allows you to use Bonjour to perform the network settings.
= Service name
Specifies the Bonjour service name. You can use up to 48 characters for the name.

»» Note

* You cannot use the same service name as that already used for other LAN connected
devices.
o SNTP settings
Performs various settings for SNTP (Simple Network Time Protocol).
o Spanning tree settings
Enables/Disables spanning tree. Selecting Enable avoids circulating data on a network.
o LPR protocol settings
Enables/Disables the LPR setting.
> RAW protocol
Enables/Disables RAW printing.
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LLMNR

Specifies ON/OFF of LLMNR (Link-Local Multicast Name Resolution). Selecting ON allows the
printer to detect printer's IP address from the printer name without a DNS server.

Gigabit Ethernet settings

Specifies the communication speed and communication method when using Gigabit Ethernet.

Use Dedicated Port

Selects whether to use a dedicated port for a command sent from a Canon application to the printer.
Selecting ON allows you to use the dedicated port.

IPP settings

Selecting Enable allows you to print via the network with the IPP protocol.

If you use the security print function when printing using IPP protocol in AirPrint etc., select Enable
for Security Print.

Wi-Fi DRX settings
Selecting Enable allows you to activate discontinuous reception when using Wi-Fi.
Wired LAN DRX settings

Selecting Enable allows you to activate discontinuous reception when the printer is connected to a
device compatible with wired LAN.

Reset SSL certificates

Initializes SSL certificate information.

Reset LAN settings

Initializes the network settings on the printer.

After resetting, perform setup again as necessary.
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I Test print

This setting item is displayed by tapping Printer settings after tappingL.____—_ | (Setup) on the HOME
screen.

* Nozzle Check
Prints out the nozzle check pattern.

= Checking for Nozzle Clogging

+ Status print

Prints out the printer status and setting value information.

»» Note

 Status print (administrator) is also displayed if the administrator password is enabled for
changing settings using the operation panel.

= Status Print

* Print LAN details
Prints out the network setting information.

= Printing Network Settings

* Print the print settings

Prints out the print settings list.

* Print advanced paper settings

Prints out the setting values specified by Advanced paper settings.

* Print job history

Prints out a record of print jobs, including the paper type and size, amount of ink consumed, and so on.
Ink consumption indicates a rough estimate of the amount of ink consumed per print job.

= Job management

* Print menu map

Prints out the menu list.

* Print the color chart

Prints out the color chart.
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I Print settings

This setting item is displayed by tapping Printer settings after tappingL.____—_ | (Setup) on the HOME
screen.
» Print head movable width setting

Adjusts the print head movable width.

* Prioritize paper size
This is a setting item for roll paper.

Select Enable to use the paper size setting as the basis for printing instead of other settings. The text or
images in the margin are not printed.

Select Disable to give priority to printing text or images.

»» Note

» The printed paper length is longer than the actual paper length. This is because the printed paper
includes the upper/lower margins specified by Roll Paper Safety Margin and Near End Margin in
the printer driver and excludes the paper margins.

» Magnification level for borderless
Sets magnification level when performing borderless printing in the following print method.

Normally, the image is enlarged slightly and printed so that there is no border. If the border remains,
change this setting.

° Printing JPEG file
o Printing using AirPrint
o Printing PDF file
o Printing data saved on the USB flash drive directly
o Printing directly from FTP
* PDF print settings

Performs PDF print settings.

* JPEG print settings
Performs JPEG print settings.

* Print from USB flash settings

Performs settings for printing data saved on the USB flash drive.

* AirPrint print settings

Performs AirPrint print settings when printing with AirPrint.

* Direct print settings from FTP

Performs print settings when printing directly from FTP. You can perform four settings individually.
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+ Default print settings

Prints out the default values of print settings.

* Print the print settings

Prints out the print settings list.
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I Web service setup

This setting item is displayed by tapping Printer settings after tappingL_____ | (Setup) on the HOME
screen.

32 Important

The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

Web service usage registration/Web service usage cancellation

Registers/Deletes Web service usage to use the printer device information to/from PIXMA/MAXIFY
Cloud Link.

Issue registration code

In order to link the web service and printer, obtain the registration code from the service origin.

DNS server setup

Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup,
follow the display on the touch screen to perform settings.

Proxy server setup

Performs settings for a proxy server. Follow the display on the touch screen to perform settings.
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I Paper-related settings

This setting item is displayed by tapping Printer settings after tappingL.______ | (Setup) on the HOME
screen.
* Keep media type

Select Enable to keep using the same type of paper.

* Manage remaining roll amount

Selects the method to manage remaining roll amount and that to display warning when the roll is
running short.

o Barcodes
Manages remaining roll amount by using a barcode.

By using the barcode every time you replace a roll, you can manage remaining roll amount properly.
Specify the roll length properly when you load a new roll.

o Warning message only

Estimates remaining roll amount by using media type and roll diameter information. A warning
appears when remaining roll amount comes closer to the specified value.

Depending on the environment you are using the printer, selecting this setting may not manage
remaining roll amount as precisely as you expected. We recommend you select a higher value for
this setting item.

o Disable

Select to disable managing remaining roll amount.

* Roll amount warning settings

Specifies when to warn the remaining roll paper amount.

» Detect paper setting mismatch
Selects printer action when you start printing with the paper size, the media type, and print settings
different from those registered.

+ Advanced paper settings

Specifies advanced paper settings for each paper type.

* Paper size recognition settings
Selects which size is preferred when paper size detection is enabled.
o Roll paper setting 1
Select whether B4 or 10 inch is applied when a roll of an intermediate size is detected.
o Roll paper setting 2
Select whether A3 or 300 mm is applied when a roll of an intermediate size is detected.

o Roll paper setting 3
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Select whether 300 mm or 12 inch is applied when a roll of an intermediate size is detected.
o Roll paper setting 4

Select whether 500 mm or 20 inch is applied when a roll of an intermediate size is detected.
o Roll paper setting 5

Select whether B2 or 20 inch is applied when a roll of an intermediate size is detected.
o Roll paper setting 6

Select whether A1 or 600 mm is applied when a roll of an intermediate size is detected.
o Roll paper setting 7

Select whether 600 mm or 24 inch is applied when a sheet of an intermediate size is detected.

* Keep margin at cut sheet end
When printing on the sheet using AirPrint, selecting Enable sets the trailing edge of the paper to 20 mm.
Select Enable if printing on the trailing edge of the paper is disturbed.

» Auto feed at power on

When Enable is selected, the printer judges the existence of paper exchange when starting up, and if
paper has been exchanged, paper feeding operation is performed.

It may take time to judge paper exchange.
When Disable is selected, the printer does not judge whether or not to change the paper when starting
up, and waits with the current paper feed setting.

* Add priority roll paper width
When paper size is detected, set the width of the roll paper to be recognized first. Judge in order from 1
in the list.

* Print advanced paper settings

Tapping Yes prints out each setting specified in Advanced paper settings.

* Reset paper settings for all paper
Tapping Yes initializes each setting specified in Advanced paper settings.
Entering the administrator password is required if it is enabled.

22 Important

* When you set the paper settings back to the factory default, added or updated paper information
using Media Configuration Tool is erased.

179



I Auto maintenance settings

This setting item is displayed by tapping Printer settings after tappingL_____ | (Setup) on the HOME
screen.

32 Important

The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.
Auto nozzle check

Enables/Disables automatic nozzle checking. You can also select the page interval to perform automatic
nozzle checking.

Nozzle check error display

Enables/Disables displaying the nozzle check error.

System Cleaning frequency

Specifies the frequency of automatic system cleaning.

»» Note

» To maintain print quality, we recommend you select Short if you use the printer at a higher place.

Print pattern after new head

Selects whether you print an adjustment pattern after replacing the Print head.
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| Hard disk settings

This setting item is displayed by tapping Printer settings after tappingL_____ | (Setup) on the HOME
screen.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

* Output method

Selects the printing method for jobs received from software other than the printer driver. When using the
printer driver, configure settings on the printer driver.

o Print

Performs printing as usual.
o Print (auto delete)

Deletes the data from the printer's hard disk after printing is completed.
o Save to job box

Only saves the print job in job box without printing it.

+ Save first and print
A setting for jobs received from software other than the printer driver. When using the printer driver,
configure settings on the printer driver. Select ON to print the job after it has been saved.

+ Common job box settings

Select Print (auto delete) to print without saving jobs in common job box.

* File deletion settings

Selects the data erasing method when deleting a Print job or Saved job, or when Print (auto delete) is
selected in Output method or Common job box settings.

o Fast

Erases file management data for print job data stored on the printer's hard disk. Choose this method
for relatively fast erasure. Because only the file management data is erased, the print job data itself
is not erased.

o Fast secure

Erases the data encryption key specified for the hard disk drive. Specifying the encryption key again
does not allow you to read and use data saved in the past safely and fast. Select to erase highly
confidential data.

o Secure

Overwrites the entire hard disk with 00, FF, and random data (one time each) after the data
encryption key specified for the hard disk drive is erased. Verification is performed to check if the
data was correctly written. Choose this method to erase especially confidential data. It is virtually
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impossible to recover the overwritten data. Conforms to the DoD5220.22-M standard of the U.S.
Department of Defense.

o Secure (VSITR)

Overwrites the entire hard disk with 00 next overwrites with FF after the data encryption key
specified for the hard disk drive is erased. After repeating this process three times, the entire hard
disk is overwritten with AA. It is virtually impossible to recover the overwritten data. Conforms to the
guidelines of German Federal Government (VS-ITR).

+ Data deletion
Selects the method to delete data on printer's hard disk.

= Erasing Data on Printer's Hard Disk
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I Monitoring

service settings

This setting item is displayed by tapping Printer settings after tappingL.______ | (Setup) on the HOME

screen.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using the

operation panel.

* Enable/disable monitoring service

Selecting Enable allows the printer to send error details to the service center.

When selecting Enable, perform a communication test.

« Communication test

Performs a communication test with the service center.

+ Communication log

Displays the list of error numbers (up to 30), error code, and time the error occurs. Tapping an item

displays the error

details.

Main errors and countermeasures

Error code Error detail Countermeasure

0xxx0003 Communication test is not performed. Perform the communication test.

8xxx0003 E-RDS switch is setting OFF. Enable monitoring service.

8xxx2003 Network is not ready, try later. Check the network settings.

8xxx200A Server connection error Check the network settings.

8xxx2014 Proxy connection error Check the proxy server address etc.

8xxx201E Proxy authentication error Check the user name and password to log in to the proxy
server.

8xxx2046 Server certificate expired The server certificate has expired.Set the correct date
and time on the printer.

8xxx2047 Server response time out Check the network settings. Check the proxy server ad-
dress. Make sure that the correct date and time is set on
the printer.

8xxx2058 Unknown error Wait a while, and then try the communication test again.

* Warning display

Displays a message on the touch screen selecting Enable when communication with the service center

fails.
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I Other printer settings

This setting item is displayed by tapping Printer settings after tappingL_____ | (Setup) on the HOME
screen.

32 Important

The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

Energy saving settings

To save electricity, enable this setting to turn off the printer automatically or to enter sleep mode when
specified length of time has elapsed.

o Auto power off

Sets the time until the printer turns off automatically. If no operations are performed on the printer for
the specified duration of the time after entering Sleep mode, the printer automatically turns off.

o Sleep timer
Specifies the length of time to enter sleep mode automatically when no operation is made.

»» Note

If the print job contains a pending job or a security print job, the printer does not enter sleep
mode.

Use USB connection

Use / Do not use USB connection.

Date/time settings

Sets the current date and time.

Date display format

Sets the format of dates displayed on the touch screen and printed on photos.

Time zone (GMT)
Specifies the time zone according to a country or region you live in.

Specifying the time zone allows you to display the correct time and date an e-mail was sent on your mail
software.

Select the time difference from GMT (Greenwich mean time) according to a country or region you live in.

Sound control

Select whether to sound / not sound for key touch sound and alarm sound.

Length unit settings

Selects the length unit (meter or feet/inch).
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+ EOP timer settings

Specify the timeout period before cancellation of print jobs that cannot be received by the printer.

* Job history sending settings

Select Send to send the information to the printer management and job management systems.
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I Language selection

This setting item is displayed by tapping Printer settings after tappingL_____ | (Setup) on the HOME
screen.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

Changes the language for the messages and menus on the touch screen.
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Firmware update

This setting item is displayed by tapping Printer settings after tappingL.____—_ | (Setup) on the HOME
screen.

32 Important

The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

You can update the firmware of the printer, check the firmware version, or perform settings of a notification
screen, a DNS server and a proxy server.

»» Note

If LAN is disabled, you can not use Install update, DNS server setup, Proxy server setup.

Install update
Performs the firmware update of the printer.

= Firmware update

Check current version

You can check the current firmware version.

Update notification settings

When Yes is selected and the firmware update is available, the screen to inform you of the firmware
update is displayed on the touch screen.

DNS server setup

Performs settings for a DNS server. Select Auto setup or Manual setup. If you select Manual setup,
follow the display on the touch screen to perform settings.

Proxy server setup

Performs settings for a proxy server. Follow the display on the touch screen to perform settings.
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I Security settings

This setting item is displayed by tapping Printer settings after tappingL_____ | (Setup) on the HOME
screen.

32 Important

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

+ Administrator password settings
You can specify or disable the administrator password.
If you specify the administrator password, select the range and specify the administrator password.

Remote Ul and other tools
Entering the administrator password is required to change the setting items using Remote Ul or
some software.

LCD, Remote Ul, and other tools
Entering the administrator password is required to change the setting items using the operation
panel of the printer, Remote Ul, or some software.

For details:

= Setting Administrator Password on Operation Panel

* Operation restrictions
Restricts the following operations.

o Job history
Restricts to display or print the print job history.

> Remote Ul
Restricts to use Remote Ul.

o Print from USB flash drive
Restricts to print data on USB flash drive.

* IEEE802.1X settings
Performs various settings for IEEE802.1X.
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I Printer information

It will be displayed whenyoutap.____— | (Setup) on HOME screen.

+ System information

Displays printer's system information.

* Hard disk information

Displays the total or free space of the printer hard disk.

* Error history
Displays the error history.

o Hardware error
Displays the hardware error codes (up to 5).

o Recoverable error
Displays the recoverable error (e.g. paper or ink related error) codes (up to 5).

- Paper feed/transfer error
Displays the error codes for errors which occur during paper feed/transfer (up to 5).
Tapping an error code displays the error details.

For more on the error code, refer to List of Support Code for Error.

* Usage
Displays the printer's record of use such as total print area or the amount of ink consumption.

» Head information

Displays the Print head serial number, elapsed days since the current Print head was installed, and dot
count.

» Head alignment performance log

Displays the Print head alignment performance log (up to 5).

* Values applied with auto settings

Displays the print settings applied the last print job.
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I Setting Administrator Password on Operation Panel

You can specify or disable the administrator password.

Specifying the administrator password requires you to enter the password to use the items or change the
settings below.

* LAN settings

+ Web service setup

+ Auto maintenance settings
* Hard disk settings

* Monitoring service settings
» Other printer settings

+ Language selection

* Firmware update

» Security settings

* Import/export settings

* Initialize printer settings

+ Status print (administrator)

Follow the procedure below to specify the administrator password.

22 Important

» The administrator password is set at the time of purchase. The printer's serial number is used as the
password.

<

1. TapL___— [ (Setup) on HOME screen.

= Home Screen Menu Composition

2. Tap Printer settings.

3. Tap Security settings.

If you specify the administrator password, enter the password.

4. Tap Administrator password settings.

If you specify the administrator password, enter the password.
5. Tap Change administrator password.

6. Select range where administrator password is valid.

Remote Ul and other tools
Entering the administrator password is required to change the setting items using Remote Ul or
some software.
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LCD, Remote Ul, and other tools
Entering the administrator password is required to change the setting items using the operation
panel of the printer, Remote Ul, or some software.

7. Enter new administrator password.

2» Important
» The following character restrictions apply to the password:

— Set the password by using 4 to 32 characters.

— The allowed characters are single-byte alphanumeric characters, blank space, umlaut
characters, and the below characters.
Sl@#S WM&, =+ (O){ 1< >

— For security reasons, we recommend you use 8 and more alphanumeric characters.

8. Tap Apply.
9. Enter administrator password you specified again.

10. Tap Apply.

The administrator password is enabled.

I When You Want to Disable the Administrator Password:

After tappingl____— | (Setup) on HOME screen, select Printer settings > Security settings >
Administrator password settings > Remove administrator password. Select either item and follow
the on-screen instructions to perform settings.
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I Erasing Data on Printer's Hard Disk

22 Important

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

» For a more secure method of preventing data recovery, we recommend physically or magnetically
destroying the hard disk. In this case, the hard disk can no longer be used.

* You cannot erase HDD data if there is a job queue. Additionally, print jobs are not processed while data
erasing is in progress.

<&

1. Tap_ — [ (Setup) on HOME screen.

= Home Screen Menu Composition

2. Tap Printer settings.

3. Tap Hard disk settings.

If an administrator password is set, enter the password.
4. Tap Data deletion.

5. Tap erasing method.

Fast
Erases file management data for print job data stored on the printer's hard disk. Choose this method

for relatively fast erasure. Because only the file management data is erased, the print job data itself
is not erased.

Fast secure
Erases the data encryption key specified for the hard disk drive. Specifying the encryption key again
does not allow you to read and use data saved in the past safely and fast. Select to erase highly
confidential data.

Secure
Overwrites the entire hard disk with 00, FF, and random data (one time each) after the data
encryption key specified for the hard disk drive is erased. Verification is performed to check if the
data was correctly written. Choose this method to erase especially confidential data. It is virtually
impossible to recover the overwritten data. Conforms to the DoD5220.22-M standard of the U.S.
Department of Defense.

Secure (VSITR)
Overwrites the entire hard disk with 00 next overwrites with FF after the data encryption key
specified for the hard disk drive is erased. After repeating this process three times, the entire hard
disk is overwritten with AA. It is virtually impossible to recover the overwritten data. Conforms to the
guidelines of German Federal Government (VS-ITR).

6. Confirm displayed message and tap Yes.
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Data on the hard disk are erased.
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I Status Print

You can print a "Status Print" report indicating the current status of the printer.

With "Status Print", information is printed regarding the printer firmware version, various settings, and the
status of consumables.

Follow the procedure below to print.

&

1. Onthe HOME screen,tap.____— [ (Setup).

= Home Screen Menu Composition

2. Tap Printer settings.
3. Tap Test print.

4. Tap Status print.
»» Note

* If you specify the administrator password, tap Status print (administrator).

5. Tap Yes.
The printer starts printing.

The following information is included.

Canon XXXXXXXXXXXXXXXXXXXX Status Print Printer model
S/N Printer serial number
Firm Firmware version
Boot Boot ROM version
Date Date and time when the status print was output
Paper Info

Roll Media Type of roll paper

Cut Sheet Type of cut sheet
Job Menu

Job History
Log * Details of up to 5 jobs (Job name is printed as "™*".)

*Printed only when Status print (administrator) is selected.

Settings

Printer settings
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Print settings

Setting values of Print head movable width setting and
Prioritize paper size

Paper-related settings

Setting values of Paper-related settings

Device settings

Auto maintenance settings

Setting values of Auto maintenance settings

Hard disk settings

Setting values of Hard disk settings

Device user settings

Setting values of Other printer settings

Language selection

Setting value of Language selection

Firmware update notification

Setting values of Update notification settings

Monitoring service settings

Setting values of Enable/disable monitoring
service

Usage Condition

Hard disk information

Values of Hard disk capacity and Job box free space

Hardware error

History information of Hardware error

Error History information of Recoverable error
Warning Warning history information
Jam History information of Paper feed/transfer error

Maintenance cartridge usage / Remaining ink lev-
el

Values of Ink consumed

Duty counter

Values of Duty counter

PARTS STATUS

COUNTER

Part status

Head information

HEAD LOT NUMBER/ DATE OF INSTALLATION

Information of Head information

Head alignment performance log

History information of Head alignment performance log

COUNTER

MEDIA

Usage status by media

THE NUMBER OF CUTS

Total number of cuts

AFTER INSTALLATION

Number of days from the use start date
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I Changing Printer's Setting Using Web Browser

» Start up Remote Ul

» Changeable Setting Items Using Remote Ul

» Setting Passwords using Remote Ul

» Registering Printer's Root Certificate to Web Browser for SSL Communication

» Registering Printer's Root Certificate to Local Computer for SSL Communication
» Generating Server Certificate

» Setting Mail Server

» Receiving Printer Status by E-mail

196



I Start up Remote Ul

You can check the printer status and change the printer settings using the web browser on your
smartphone, tablet, or computer.

To check the printer status and to change the printer settings, display "Remote UI" on the web browser.

»>» Note

* Remote Ul is a software that enables you to perform operations, which are usually performed on the
printer's operation panel, using a Web browser over a network.

LAN connection with the printer is required to use Remote UlI.
* You can use Remote Ul on the following OS and the web browser.
— iOS device
0S:i0S 12.0 or later
Web browser: iOS standard Web browser (Mobile Safari)
— iPadOS device
OS: iPadOS 13.0 or later
Web browser: iPadOS standard Web browser (Mobile Safari)
— Android device
OS: Android 5.1 or later
Web browser: Android standard Web browser (Browser or Chrome)
— macOS device
OS: macOS Sierra 10.12 or later
Web browser: Safari 10.0 or later
— Windows device
OS: Windows 7 SP1 or later
Web browser: Microsoft Edge, Internet Explorer 11, Mozilla Firefox, Google Chrome

» Enable JavaScript and cookies in the web browser.

1. Check printer's IP address.

g, 8
0

1. Tap (Network) on HOME screen.

= Home Screen Menu Composition

2. Tap the enabled LAN.

Diagonal lines are displayed for disabled LAN icons.

3. Check IPv4 address.
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2. Open web browser on your smartphone, tablet, or computer and enter IP address.
Enter as following in the URL field of the web browser.
http://XXX. XXX XXX
Enter the IP address of the printer in "XXX. XX. X XXX".
2> Note

* If you have set a DNS host name, you can also enter this.

When you access, "Remote UI" will be displayed on the web browser on your smartphone, tablet, or

computer.
— Fezdy 1o print
W & paddword (& 881, ol
wiill be requested to enber your
password. Estimated ink levels
]
Manuzal (Ondine)
I —
For setune communication
Doamicnd Saftwane
Inic medel nuesber Oirder My Ink Now
Roll paper (g Plain Pager
= Ai1Rcd
ki . Thama |8 ne pEper
Purchaslng okhar
»>» Note

* If you display Remote Ul for the first time on your smartphone, tablet, or computer, download the
root certificate, and then register it.
= Registering Printer's Root Certificate to Web Browser for SSL Communication

« If the root certificate is not registered, a message to warn you that the secure connection is not
guaranteed may appear.

3. Select Log in.
The password authentication screen appears.
»» Note

¢ When the standard user mode is enabled, choose either administrator mode or standard user
mode to log on.

After choosing a mode and selecting Log in, the password authentication screen of each mode
appears.

4. Enter password.

When the password authentication is complete, the menus that can be utilized are displayed on the web
browser.

198



2% Important

* The password is set at the time of purchase. The password is the printer serial number. The
printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters (four alphabets followed by five numbers).

For details on setting password, see Setting Passwords Using Remote UI.

5. Confirm that the main screen of Remote Ul is displayed.
For changeable setting items, see below.

= Changeable Setting Iltems Using Remote Ul

When you finish checking printer status and changing printer settings, select Log out.
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I Changeable Setting Items Using Remote Ul

»» Note

* The item which can be used is different in administrator mode or in standard user mode.

Printer stabus

Printer sltatus Fiaadly & pring
Usilitios
Printer 2 i Eafimaind ink avals

" - .
AirPrint sattmgs

- .
Jeia management - |
Securily
System info and LAN settings —_—
Forvmare update Ink medel numier | | Crdes My Ink Mow
Languags sslection
Roll papsr a7 Plain Paper
Manizal (Oinlire] f A1 Rl
Demnlasd Softwarne Manual

» There I3 no paper.

Purchasing oaner

Printer status
This function displays printer information such as the remaining ink amount, the status, and detailed
error information.

You can also connect to the ink purchase site or support page, and use Web Services.
Utilities
This function allows you to set and perform maintenance such as cleaning.

Printer settings
This function allows you to change the printer settings such as the energy saving settings and the
print settings.

Additionally, this function allows you to receive the printer status information such as the remaining
ink level and the error.

= Setting Mail Server
= Receiving Printer Status by E-mail

You can disable any operations using the operation panel from Operation panel lock on Custom
settings.

»» Note

» Some of the menu is available only when you logged on in administrator mode.
AirPrint settings
This function allows you to specify the AirPrint settings when printing with AirPrint.

Job management
This function allows you to display the job history and print it.

In addition, you can delete jobs from this item.
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»» Note

* When you are logging on in administrator mode, you can restrict this function in standard user
mode.

Security (Item for administrator)
This function allows you to specify the password, the standard user mode settings, the operation
restrictions, and SSL/TLS settings of certificate for encrypted communication.

System info and LAN settings
» Confirm system information
» LAN settings(ltem for administrator)

Firmware update

You can update the firmware of the printer, check the firmware version, or perform settings of a DNS
server and a proxy server.

= Firmware update

Language selection (Item for administrator)
This function allows you to change the language on the display.

Manual (Online)
This function displays the Online Manual.
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I Security

+ Administrator password setting

= Setting Passwords Using Remote Ul

» Operation restrictions
Restricts the following operations.
o Job history
Restricts to display or print the print job history.
> Print from USB flash drive

Restricts to print data on USB flash drive.

* SSL/TLS settings

Perform settings of a certificate for encrypted communication.

Available TLS settings enables you to specify the range of the version used for SSL/TLS

communication.
+ IEEE802.1X settings

o Authentication
Enables/Disables IEEE802.1X certificate.
2> Note

* In the case of using IEEE802.1X certificate, Security > IEEE802.1X settings > CA certificate,
and register the CA certificate.

» Supported authentication method
— EAP-TLS(Extensible Authentication Protocol-Transport Level Security)
— EAP-TTLS(EAP-Tunneled TLS)
— PEAP(Protected EAP)

o Weak encryption restriction
Selecting Do not restrict enables communication using the 3DES or RC4 encryption algorithm.
o Weak certificate restriction

Selecting Do not restrict enables certificate authentication using the public key algorithm of RSA
(512 bit) or RSA (1024 bit).

- Key and certificate settings
Perform settings for key and client certificate.
o CA certificate

Perform settings for the CA certificate that verifies a server certificate.
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| LAN settings

Wi-Fi

Enables/Disables Wi-Fi.

Wireless Direct

Enables/Disables Wireless Direct.

Wired LAN

Enables/Disables Wired LAN.

Confirm LAN settings

The LAN setting information is displayed.

Advanced setup

o

Set printer name

Specifies the printer name. You can use 2 to 15 characters for the name.

»» Note

* You cannot use the same printer name as that already used for other LAN connected devices.
* You cannot use a hyphen for the initial or last character of the printer name.

TCPI/IP settings

Performs IPv4 or IPv6 setting.

WSD settings

Perform settings to use WSD.

Bonjour settings

Perform settings to use Bonjour.

LPD print

Perform settings for printing with LPD.

SNMP settings

Perform settings for using SNMP to manage and control the printer.
SNTP settings

Perform settings for using SNTP to adjust the time on the printer.
FTP settings

Perform settings for printing with FTP.

IPP Settings

Perform settings for printing with IPP.

CHMP settings

Perform settings for communication at the time when printer drivers or applications acquire the

information on status, paper, and job log, from the printer.
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Selecting Enable HTTPS redirection redirects the communication using CHMP to encrypted
communication.

»» Note

» To use CHMP for encrypted communication, you need to register the printer's root certificate to

your computer.
= Registering Printer's Root Certificate to Local Computer for SSL Communication

* CHMP is a Canon proprietary protocol.

o Network interface settings
To connect to a hub that supports STP, select Enable.
Selecting Enable perform the intermittent data reception when connecting to the network.
o DRX settings
Selecting Enable perform the intermittent data reception when connecting to the network.
o |P filtering
Allows or denies access for specific IP addresses.
Settings for both IPv4 and IPv6 addresses can be specified.
22 Important
—
+ If the device address for administrator has been set to rejection by mistake, tap ”
(Network) on the HOME screen of the operation panel, and then tap LAN settings > Wi-Fi /

Wireless Direct / Wired LAN > Settings > Advanced setup > Reset LAN settings, and
initialize network information of the printer.

After resetting, perform setup again as necessary.

o MAC address filtering settings
Allows or denies access for specific MAC addresses.
32 Important
—_
+ If the device address for administrator has been set to rejection by mistake, tap .
(Network) on the HOME screen of the operation panel, and then tap LAN settings > Wi-Fi /

Wireless Direct / Wired LAN > Settings > Advanced setup > Reset LAN settings, and
initialize network information of the printer.

After resetting, perform setup again as necessary.

o Reset LAN settings
Initializes the network settings on the printer.

After resetting, perform setup again as necessary.
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I Setting Passwords using Remote Ul

Each of passwords for administrator and standard user can be set.

When logging on with password for administrator, all settings can be changed.

When logging on with password for standard user, some of the settings can be changed.

When logging on with password for administrator, you can restrict the function for standard user.

= Setting Administrator Password
= Setting Standard User Password

»>» Note

» Password can be set only when you are logged in administrator mode.

I Setting Administrator Password

Change the administrator password by following the steps below.

32 Important

» The password is set at the time of purchase. The password is the printer serial number. The
printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters (four alphabets followed by five numbers).

1. Start up Remote Ul.

= Start up Remote Ul

2. Select Security.
3. Select Administrator password setting.

4. Select Change administrator password.

If an administrator password is not specified, the confirmation message appears. Confirm the
message and select Yes. When message appears again, confirm it and select OK.

5. Select range where administrator password is valid and select OK.

Remote Ul and other tools

Entering the administrator password is required to change the setting items using the Remote Ul
or some software.

Operation panel/Remote Ul/other tools
Entering the administrator password is required to change the setting items using the operation
panel of the printer, the Remote Ul, or some software.

6. Enter password and select OK.

32 Important

» The following character restrictions apply to the password:
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— Set the password by using 4 to 32 characters.

— The allowed characters are single-byte alphanumeric characters, blank space, umlaut
characters, and the below characters.
-l@#S WM& =+ () {1 <>

— For security reasons, we recommend you use 8 and more alphanumeric characters.
7. When completion message appears, select OK.

I Setting Standard User Password

For restricting the function for standard user, enable the standard user mode and set a standard user
password by following the steps below.

1. Start up Remote Ul.

= Start up Remote Ul

2. Select Security.

The menus appear.
3. Select Standard user mode settings.
4. When confirmation message appears, select Yes.

5. Enter password and select OK.

22 Important
» The following character restrictions apply to the password:

— Set the password by using 4 to 32 characters.

— The allowed characters are single-byte alphanumeric characters, blank space, umlaut
characters, and the below characters.
-l@#S%N& =+ () {1 < >

— For security reasons, we recommend you use 8 and more alphanumeric characters.

6. When completion message appears, select OK.
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Registering Printer's Root Certificate to Web Browser for SSL
Communication

If the printer's root certificate has not been registered to the web browser, a message to warn you that the
secure connection is not guaranteed may appear.

When you display Remote Ul for the first time on your smartphone, tablet, or computer, download the root
certificate, and then register it to the web browser. The secure connection will be confirmed and a message
will not appear. However, the message may appear depending on a web browser even after you have
registered the root certificate.

How to register the root certificate varies depending on the web browser.

= For Microsoft Edge

= For Safari

= For Chrome on Android
= For Mobile Safari on iOS

Operating procedure may differ depending on the version of your web browser. For other web browser, refer
to each help.

3% Important

» Make sure that you have accessed to the printer IP address correctly by checking the URL field of the
web browser before registering the root certificate.

« If the printer is connected via IPv6 using Windows, you need to generate a server certificate using
Remote UI.

For details, see Generating Server Certificate.

I For Microsoft Edge

1. Select For secure communication on Remote Ul.

2. Select Download.

Downloading the root certificate is started.

3. If confirmation screen appears, select Open.
Certificate screen is displayed.

»» Note

» To save the certificate file and register it, select Save. To register, select Control Panel >
Network and Internet > Internet Options, and register the root certificate from Certificates on
Content sheet.

4. Select Install Certificate.

Certificate Import Wizard screen is displayed.
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5. Select Next.
6. Select Place all certificates in the following store.

7. Select Browse.

Select Certificate Store screen is displayed.
8. Select Trusted Root Certification Authorities and OK.
9. Select Next on Certificate Import Wizard screen.

10. If Completing the Certificate Import Wizard appears, select Finish.

Security Warning screen is displayed.

11. Make sure that thumbprint on Security Warning screen matches printer's thumbprint.

To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.

thumbprint (SHA-256), tapL__ (Setup) on HOME screen of the operation panel, and then tap
Printer information > System information.

12. If thumbprint on Security Warning screen matches printer's thumbprint, select Yes.

13. Select OK on Certificate Import Wizard screen.

The root certificate registration is completed.

I For Safari

1. Select For secure communication on Remote Ul.

2. Select Download.

Downloading the root certificate is started.

3. Open the downloaded file.

Keychain access starts up and Add Certificates screen is displayed.

4. Select Add.
Information on the certificate is displayed.

»» Note

* You can also add the certificate by selecting Show Certificate, checking certificate name to
add, and then selecting the same certificate on Keychain access.
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5. Make sure that fingerprint of certificate detail information matches printer's thumbprint.

To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.

thumbprint (SHA-256),tap._ (Setup) on HOME screen of the operation panel, and then tap
Printer information > System information.

6. If fingerprint of certificate detail information matches printer's thumbprint, display
information on certificate from the menu or by double-clicking the certificate, and select
Always Trust on Trust.

The root certificate registration is completed.

> Note

« |If a password is set on your device, entering a password may be required.

I For Chrome on Android

1. Select For secure communication on Remote UI.

2. Select Download.

Downloading the root certificate is started and then Name the certificate screen is displayed.

3. As entering the root certificate name is required, enter an arbitrary certificate name and
select OK.

The root certificate registration is completed.

> Note

« If PIN or password is not set as security type, the attention screen may appear. Select OK, and
then set the security type to PIN or password.

After Root Certificate Registration
We recommend that you make sure that the correct root certificate has been registered.

To make sure that the correct root certificate has been registered, make sure that thumbprint of
certificate information matches printer's thumbprint. Follow the steps below.

»» Note

+ Some Android devices cannot be checked the thumbprint of a registered route certificate.

1. From Settings menu on your device, select Security, Trust credentials, and USER.

The list of downloaded certificates appears.

2. Select downloaded certificate.

The certificate information appears.
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3. Make sure that thumbprint of certificate information matches printer's thumbprint.

To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.

thumbprint (SHA-256),tap._ |(Setup) on HOME screen of the operation panel, and then
tap Printer information > System information.

4. If thumbprint of certificate information screen matches printer's thumbprint, select OK.

The root certificate registration is completed.

If the message to warn you that the secure connection is not guaranteed appears when you select
Log in on Remote Ul after registering the root certificate, restart the web browser. The message will
not appear on the web browser.

»» Note

» Depending on the Android device, a warning may appear even after registering the proper root
certificate.

I For Mobile Safari on iOS

1. Select For secure communication on Remote UlI.

2. Select Download.

Downloading the root certificate is started and then Install Profile screen is displayed.

3. Select Install.

Warning screen is displayed.

»» Note

« If a password is set on your device, entering a password may be required.

4. Select Install.

5. Select Install on displayed dialog.

The root certificate registration is completed.
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Registering Printer's Root Certificate to Local Computer for
SSL Communication

To use Device Management Console or Accounting Manager, etc. when you connect the printer to a
computer using SSL encrypted communication, you need to register (import) the printer's root certificate to
your computer.

Procedure to register the certificate varies depending on your operation environment.

32 Important

« If the printer is connected via IPv6 using Windows, you need to generate a server certificate using
Remote Ul.

For details, see Generating Server Certificate.

= For Windows 10/Windows 8.1
= For Windows 7
= For macOS

Operation procedure may differ depending on your OS version.

| For Windows 10/Windows 8.1

The procedure below describes how to import a root certificate in Windows 10/Windows 8.1.

1. Start up Remote UI.

= Start up Remote Ul

2. Select For secure communication.

> Note

* You can download a certificate from Status Monitor.

1. Open status monitor.

Open the Printing preferences, and select Status Monitor... on Main.
2. Download a certificate.
Select Download Security Certificate from the Remote Ul menu.
3. Select Download.

The root certificate will be downloaded.

4. When download confirmation screen is displayed, select Open.

The Certificate screen appears.

5. Select Install Certificate.
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The Certificate Import Wizard screen appears.

6. Select Local Machine.

1. Select Local Machine on the startup screen of Certificate Import Wizard.

*

&= Cenificate impon Wizard

Waelcomae to the Certificate Import Wizard
Thi witard helos you copy certificabes, certificate trost fsls, and cerlificals revocation

fxte from your disk to & cerlificabe sinre

A certificate, which is ssued by a cersficason authonity, & a confrmaton of your idenbity
and contains informabon used fo protect data or 5o establish secre neteork
pomnectons, A cerbficate store is the system area where certofcates are kept.

Store Location

i l:__l.rn:nr |

T corvbirue, chok Next.

Fhent Cancel

2. Select Next.

3. Select Yes on the displayed screen.

The Certificate Store screen appears.
7. Select Place all certificates in the following store.
8. Select Trusted Root Certificate Authorities.

1. Select Browse to open the Select Certificate Store screen.
2. Select Trusted Root Certificate Authorities from the list and select OK.

3. Select Next on the Certificate Store screen.

9. Select Finish.

When the Completing the Certificate Import Wizard screen appears, check the settings and select
Finish.

I For Windows 7

The procedure below describes how to import a root certificate in Windows 7.
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3% Important

 Be sure to create a certificate snap-in before importing a root certificate.

The root certificate will be registered to the local user if you import it without creating a certificate
snap-in.

Creating Certificate Snap-in

1. Start up Microsoft Management Console.

Enter MMC on Search programs and files in the Start menu and press the Enter key.
2. Select Yes on displayed screen.

3. Select Add/Remove Snap-in from File menu.

The Add or Remove Snap-ins screen appears.

4. Add Certificate snap-in.

1. Select Certificates from Available snap-ins list and select Add.

2. Select Computer account for This snap-in will always manage certificates for on the Certificates
snap-in screen and select Next.

3. Select Local computer on the Select computer screen and select Finish.

—
Salect Computer [

Sedect the compuber you wart this snap-n io manags
This snap-n will abueys manags:
[ﬂ iLosal compubsr. e comper this cansole !S.rl-.rn.r-g.m)]

{other compuler:

Aoy the selacied compuberio be changad when lsunching Irom the commend s, Thes
only apples f you save the consals.

« Eacic Frish | | Cancel |

4. Select OK on the Add or Remove Snap-ins screen.

Downloading Certificate

1. Start up Remote UlI.

= Start up Remote Ul
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2. Select For secure communication.

> Note

* You can download a certificate from Status Monitor.

1. Open status monitor.

Open the Printing preferences, and select Status Monitor... on Main.
2. Download a certificate.

Select Download Security Certificate from the Remote Ul menu.

3. Select Download.

4. Select Save.

Importing Certificate
1. Open Certificate Import Wizard.
1. On the left window, open Trusted Root Certificate from Certificate on Console Root.
2. Right-click Certificates and select Import from All tasks.
2. Specify certificate file to import.
1. Select Next.
2. Specify the certificate file to import on File name and select Next.
3. Specify certificate store.
1. Select Place all certificates in the following store.
2. Select Trusted Root Certificate Authorities for Certificates Store.
4. Finish certificate import wizard.
1. Select Next and check the specified settings.

2. Select Finish to finish the wizard.

3. Select OK on the displayed screen.

Checking Imported Certificate

Make sure the imported certificate has been registered to your computer.
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1. Display certificate list.

On the left window of Microsoft Management Console, select Console Root > Certificates (Local
Computer) > Trusted Root Certificate Authorities in this order, and Select Certificates to display
the certificate list.

2. Check registered certificate.
Make sure the imported certificate name is displayed on the list.

»» Note

» Make sure you can see the registered certificate from Current user by creating the Current
user snap-in.

»>» Note

* When you finish Microsoft Management Console, a message asking you whether to save the console
setting. If you continue to apply the same settings next, select Yes to save.

I For macOS

The procedure below describes how to import a root certificate in macOS.

1. Start up Remote UI.

= Start up Remote Ul

2. Select For secure communication.

3. Select Download.

The root certificate will be downloaded.

4. Open downloaded certificate file.
When the download procedure is completed, a downloaded item pops up on the right of the screen.

Double-click the downloaded certificate on the list starts up Keychain Access and the Add
Certificates screen appears.

»» Note

« If the downloaded item does not pop up, select the Show Downloads 0 button on the
right.

» Selecting the magnifying glass icon on the right of download list displays the folder containing
the certificate.

5. Select Add.
Select the destination for the certificate on Keychain.

Selecting Add displays information on the certificate.
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»» Note

* You can add the certificate by selecting the same certificate on Keychain Access. Check the
name of certification to add after selecting View Certificates.

6. Check certificate.

Make sure the fingerprint of certificate shown on Details corresponds with the root certificate
thumbprint of the printer.

To display the printer's root certificate thumbprint in Root cert. thumbprint (SHA-1) or Root cert.

thumbprint (SHA-256), tap___________(Setup) on HOME screen of the operation panel, and then tap
Printer information > System information.

7. Select Always Trust.

If the fingerprint of certificate detail information matches printer's thumbprint, display information on
certificate from the menu or by double-clicking the certificate, and select Always Trust on Trust.

The root certificate has been registered.

»» Note

» Entering the password may be required if you specify it for your printer.
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I Generating Server Certificate

When you use SSL connection via IPv6 network, you need to generate an IPv6 server certificate using the
printer.

Generate the server certificate from Remote Ul.
Follow the procedure below.

1. Checking Printer's IP Address

2. Generating Server Certificate

3. Checking Generated Server Certificate

32 Important

—
» To reset the IPv6 server certificate, tap » (Network) on the HOME screen of the operation panel,
and then tap in the following order.

LAN settings > Wi-Fi / Wireless Direct / Wired LAN > Settings > Advanced > Reset SSL
certificates > Yes

I Checking Printer's IP Address
—_—
0}

1. Tap (Network) on HOME screen.

= Home Screen Menu Composition

2. Tap the enabled LAN.

Diagonal lines are displayed for disabled LAN icons.

3. Check the value on IPv6 link-local address.

Write down the value on IPv6 link-local address for your reference when you open Remote Ul and
generate a server certificate.

I Generating Server Certificate

1. Open web browser on your smartphone, tablet, or computer and enter the printer IP
address.

Enter as following in the URL field of the web browser.
http://TXXXX:: XXX XXX X XXX XXXX]
On "XXXX:: XXXXXXXXXXXX:XXXX", enter the IPv6 link-local address in abbreviated form.

The top screen of Remote Ul appears.

2. Select Log in on Remote UL.
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»» Note

* If you specify the administrator password, enter the password.

. Select Security.

. Select SSL/TLS settings.

. Select Generate key and certificate.
. Select Generate self-signed cert.

. Specify each setting item.

» Signature algorithm
Select SHA256.
* Public key length (bits)
Select 2048 bits.
» Specify the expiration date.
Enter the date you generated the server certificate on Valid from.
Enter the date the server certificate expires on Valid to.
» Enter the common name.
On Common name, enter the IPv6 link-local address you checked in abbreviated form.

> Note

* When you enter the common name, add [ ] to each end of the abbreviation value of the
printer's IPv6 address.
* Do not use a comma or make a space for the common name.

8. Select Next.

10.

You need not enter anything on Country, State or province, Locality, Organization, or
Organizational unit.

. Select Generate.

The server certificate starts to be generated.

When the server certificate has been generated, Generated a self-signed certificate. appears.

Select Restart LAN.
LAN will be restarted.

When LAN has been restarted, Printer status on Remote Ul appears.

»» Note

« If you cannot access to Remote Ul after you restart LAN, reload your web browser.
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I Checking Generated Server Certificate
1. Select Security on Remote Ul.
2. Select SSL/TLS settings.

3. Select Check key and certificate.

Make sure the issuer of the root certificate is displayed on Issued by, and the value you entered is
displayed on Common name on Subject.
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I Setting Mail Server

To use mail function, specify the mail server settings.
*This function may not be available depending on the country or region of purchase.

»» Note

+ If you did not specify the time zone setting using the printer's operation panel, a message to inform you
that the correct time may not be reflected on the sent e-mail appears. We recommended that you set
the time zone setting using the printer's operation panel.

For the time zone setting, see Other printer settings.

» These functions can be set only when you are logged in administrator mode.

1. Start up Remote UL.

= Start up Remote Ul

2. Select Printer settings.

3. Select Set mail server.

The setting items for mail server appear.

4. Specify mail server settings.
Specify the following items.

Sender address
Enter the e-mail address of the sender (this printer).

Outgoing mail server (SMTP)
Enter the address of your SMTP server.

Port number (SMTP)
Enter the port number of your SMTP server.

Secure connection (SSL)
Select if you use the secure connection (SSL).

Don't verify certificates
Select if you do not verify the certificate.

Authentication
Select one of the following authentication methods.

SMTP authentication
Select if you send e-mail with SMTP authentication.

Then select OK, and then make the following settings.

Outgoing account
Enter the account name for sending to perform the authentication.
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Outgoing password
To set / change the password for sending in order to perform the authentication, check the
Set/change password and then enter the password.

POP before SMTP
Select if you send e-mail with POP before SMTP authentication.

Then select OK, and then make the following settings.

Incoming mail server (POP3)
Enter the address of your POP3 server.

Port number (POP3)
Enter the port number of your POP3 server.

Incoming account
Enter the account name for receiving to perform the authentication.

Incoming password
To set / change the password for receiving in order to perform the authentication, check the
Set/change password and then enter the password.

Use APOP authentication
Select if you send the password by the encryption transmission.

Clear mailbox
Select if you delete the e-mails that remain in the POP3 server.

3% Important

* When this setting is enabled, e-mail in the Inbox on the server will have all been
removed. If you specify the e-mail address of your everyday, be sure to disable this
setting as unread e-mail is not deleted. We recommended that you prepare this printer
dedicated e-mail account not to accidentally delete the unread e-mail.

5. Select OK.

The setting operation is completed.
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I Receiving Printer Status by E-mail

You receive the printer status information such as the remaining ink level and the error from the printer.
*This function may not be available depending on the country or region of purchase.

2> Note

+ Specify the mail server settings in advance.

= Setting Mail Server

+ If you did not specify the date and time setting using the printer's operation panel, the date and time
may not be reflected on the sent e-mail. We recommended that you set the date and time setting using
the printer's operation panel.

For the date and time setting, see Other printer settings.

» These functions can be set only when you are logged in administrator mode.

1. Start up Remote UL.

= Start up Remote Ul

2. Select Printer settings.
3. Select Status notification email.
4. Select Notification recipients.

5. Specify destination settings.

Up to 5 destinations can be registered by following the steps below.
1. Select number of destination.
2. Select Add.
3. Enter e-mail address, and then select printer status to send information.

4. Select OK.

The registration for destination is completed.
6. Select Printer settings > Status notification email > Retry settings.

7. Specify resending settings.

The number of resending can be specified by following the steps below.
1. Specify number of resending.

2. Specify interval of resending.
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3. Select OK.

The resending setting is completed.
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I Migrating Printer's Setting

Migrates the printer settings to another one of the same model.
This operation is available using Remote Ul or USB flash drive.

= Using Remote Ul
= Using USB Flash Drive

»» Note

» The printers must be running the same firmware version. The target data to be migrated is fixed.

I Using Remote Ul

1. Exporting settings

1. Start up Remote Ul.

= Start up Remote Ul

2. Select Printer settings.
3. Select Import/Export printer settings.
4. Select Export printer settings.
5. Enter password and select OK.
2. Importing settings

1. Start up Remote Ul

= Start up Remote Ul

2. Select Printer settings.

3. Select Import/Export printer settings.
4. Select Import printer settings.

5. Select a file to import.

6. Enter password and select OK.

| using USB Flash Drive

1. Exporting settings

1. Insert a USB flash drive to USB flash drive port.
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L

2. TapL_ [ (Setup) on HOME screen.

= Home Screen Menu Composition

3. Tap Printer settings.

4. Tap Import/export settings.

If you specify the administrator password, enter the password.
5. Tap Export.
6. Enter password and Tap OK.
7. Enter password again.
2. Importing settings

1. Insert a USB flash drive to USB flash drive port.

L

2. TapL_ [ (Setup) on HOME screen.

= Home Screen Menu Composition

3. Tap Printer settings.

4. Tap Import/export settings.

If you specify the administrator password, enter the password.
5. Tap Import.

6. Enter password and Tap OK.
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| initializing Printer's Setting

Initializes the following settings.

» Paper setting information

+ Detection priority data of paper
» SSL certificate

* LAN setting

* Administrator password

» Hard drive data

+ Job history

* Operation panel lock

This operation is available using the operation panel or Remote Ul.

= Using operation panel
= Using Remote Ul

I Using operation panel

&

1. TapL__— | (Setup) on HOME screen.

= Home Screen Menu Composition

2. Tap Printer settings.

3. Tap Initialize printer settings.

If you specify the administrator password, enter the password.

4. Confirm displayed message and tap Yes.

I Using Remote Ul

1. Start up Remote UL.

= Start up Remote UI.

2. Select Printer settings.
3. Select Initialize printer settings.

4. Confirm displayed message and select Yes.

The Remote Ul is disconnected.
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I Network Setting

» Network Connection Tips

Printer Connection Methods
Connecting Smartphone/Tablet to Printer via Wireless Router
Connecting Smartphone/Tablet to Printer Directly (Wireless Direct)
Default Network Settings
Another Printer Found with Same Name
Connecting to Another Computer via LAN/Changing from USB to LAN Connection
Printing Network Settings

Reconfiguration Method of LAN Connection/Reconfiguration Method of Wi-Fi
Connection

Countermeasures against Unauthorized Access

Network Status and Troubleshooting

» Checking Printer Connection Status Using IJ Network Device Setup Utility

» Sharing the Printer on a Network (Windows)

Setting Up a Shared Printer

Restrictions on Printer Sharing

» Sharing the Printer on a Network (macOS)

Settings on Print Server
Settings on Client PC

Restrictions on Printer Sharing
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I Network Connection Tips

» Printer Connection Methods

@ Connecting Smartphone/Tablet to Printer via Wireless Router

@ Connecting Smartphone/Tablet to Printer Directly (Wireless Direct)

» Default Network Settings
» Another Printer Found with Same Name

» Connecting to Another Computer via LAN/Changing from USB to LAN
Connection

» Printing Network Settings

» Reconfiguration Method of LAN Connection/Reconfiguration Method of Wi-Fi
Connection

» Countermeasures against Unauthorized Access

» Network Status and Troubleshooting
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I Printer Connection Methods

4 connection methods are available on the printer.

(i)

Wi-Fi Connection

¢ Using Wi-Fi Router

USB Connection
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Different types of network connections cannot be used at the same time.

When connecting another device while the devices are already connected to the printer, connect it using the
same connection method as the connected device or connect via USB connection.

If you connect using a different connection method, the connection to the devices in use will be disabled.

= Restrictions

| Wi-Fi Connection

There are two methods for connecting the printer to your device (e.g. smartphone or tablet). One method
is to connect using a wireless router, and the other method is to connect without using a wireless router.

The two connection methods cannot be used at the same time.

If you have a wireless router, we recommend you use the method using a wireless Router.

» Connection Using a Wireless Router

7 Ll =
) («

o Connect the printer and the devices using a wireless router.
o Connection methods vary depending on the wireless router type.
> You can change network settings such as the SSID and security protocol on the printer.

o When the connection between a device and a wireless router is completed and Lo (Wi-Fi icon)
is displayed in the device's screen, you can connect the device to the printer using the wireless
router.
= Connecting Smartphone/Tablet to Printer via Wireless Router

»>» Note

* If you connect using a wireless router, the printer and the device must be connected to the same
network.

= Advantages of Connecting Printer over Wi-Fi
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» Connection without Using a Wireless Router (Wireless Direct)

o Connect the printer and a device without using a wireless router. Connect the device and the
printer directly using the printer's wireless direct.

o In the wireless direct, you can connect up to five devices at the same time. If you try to connect
another device while five devices are already connected, disconnect a device you do not use and
configure settings again.

o Network settings such as the SSID and security protocol are specified automatically.

= Connecting Smartphone/Tablet to Printer Directly (Wireless Direct)

I LAN Connection

Connect the printer and a computer or a router with an Ethernet cable. If your router supports wireless
connection, you can connect the device via wireless connection.

> Note

« Devices connected to the router must be connected to the same network.

= \What Is Ethernet Cable?
= Advantages of Connecting Printer via Wired LAN

I USB Connection

Connect the printer to a computer using a USB cable.
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= \What Is USB Cable?
In USB connection, the printer is connected one-on-one to the computer.

If your computer is connected to LAN, you can use the printer with other devices by enabling the sharing
setting on your computer.

> Note

* You can connect the printer to a computer via USB even when the printer is already connected to
another one via wired LAN.

| m— R —

32 Important

+ If you connect a device connected to the Internet via a wireless router to the printer that is in the
wireless direct, the connection between the device and wireless router will be disabled. In that case,
the connection of the device may switch to a mobile data connection automatically depending on your
device. Transmission fees for connecting to the Internet using a mobile data connection apply.

232



I Connecting Smartphone/Tablet to Printer via Wireless Router

You can connect devices (e.g. smartphone, or tablet) to the printer by two methods below.

» Wi-Fi connection (connecting devices via a wireless router)
» Wireless Direct connection (connecting devices without using a wireless router)

This section describes Wi-Fi connection via a wireless router.
Follow the procedure below to connect via a wireless router.

1. Confirm the Printer's Wi-Fi Connection is Enabled

2. Connect Smartphones and Tablets to the Printer

3% Important

» Check the usage restrictions and change the printer LAN setting.

= Restrictions

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

I Enable Printer's Wi-Fi connection

Ready to print

(€ Plain Paper
A1 Rell

— Replace g Feed/Cut
* paper s

] 6 O B

If a different network icon is displayed on the HOME screen, follow the procedure below to enable Wi-Fi
connection.

1. On the HOME screen, tap the Network icon.

= Home Screen Menu Composition

2. Tap Wi-Fi.
3. Tap Settings.
4. Tap Enable/disable Wi-Fi.

5. Tap Enable.

The printer's Wi-Fi is enabled and you can connect the Wi-Fi you connected previously.
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I Connect Smartphones and Tablets to the Printer

= For Android device
= For iOS device

For Android device
1. Open "Settings" menu on your device.
2. Enable "Wi-Fi".

3. Select wireless router SSID you use from detected device list.

4. Enter wireless LAN router password.

Your device is connected to the printer.

5. Start printing from application.

For iOS device
1. Open "Settings" menu on your device.
2. Enable "Wi-Fi".

3. Select wireless router SSID you use from detected device list.
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4. Enter wireless LAN router password.

Your device is connected to the printer.

5. Start printing from application.
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Connecting Smartphone/Tablet to Printer Directly (Wireless
Direct)

You can connect devices (e.g. smartphone, or tablet) to the printer by two methods below.

» Wi-Fi connection (connecting devices using a wireless router)
» Wireless Direct connection (connecting devices without using a wireless router)

This section describes wireless direct, which allows you to print by connecting the devices to the printer
directly.

22 Important
» Check the usage restrictions and switch the printer to the wireless direct.
= Restrictions

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

+ If a device has already been connected to the printer directly and you want to add a device to connect,
connect it to the printer directly. You can connect up to 5 devices to the printer at the same time.

I Connect with Wireless Direct

1. Make sure printer is turned on.

2. On the HOME screen, tap the Network icon.
Ready to print

£ Plain Paper
= A1 Roll

—. Replace 3 Feed/Cut
= paper s

=] 6 o =

Depending on the current LAN status, the icon displayed on the button may differ.

= Home Screen Menu Composition

3. Tap Wireless Direct.
4. Tap Settings.
5. Tap Enable/disable Wireless Direct and tap Yes.

6. Confirm displayed message and tap OK.

After Wireless Direct is enabled, the identifier (SSID) etc. when using the printer with wireless direct
connection are displayed.
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By flicking the touch screen, you can check various settings of wireless direct.

2> Note
» The identifier (SSID) and password are specified automatically.

» By tapping Show password, you can check the password. The password is required when
connecting a device to the printer. (Depending on the device you are using, no password is
required.)

» By tapping Settings, you can change the following settings.

— Enable/disable Wireless Direct
— Update SSID/password

— Wireless Direct network (SSID)
— Connection request confirmation

For updating the SSID / password or changing the name of the printer displayed on Wi-Fi Direct
compatible device, see Change Wireless Direct Connection Setting.

I Connecting Smartphone/Tablet to Printer

1. Turn on Wi-Fi communication on Wi-Fi Direct compatible device.

For more on turning on Wi-Fi communication, see your device's instruction manual.

2. Select "DIRECT-XXXX-GP-NNNN" ("X" represents alphanumeric characters, NNNN
means your printer model name.) from list displayed on device.

»» Note
* |f "DIRECT-XXXX-GP-NNNN" does not appear on the list, wireless direct is not enabled.

See Connect with Wireless Direct to enable wireless direct.

* You can change the name of the printer displayed on Wi-Fi Direct compatible devices.

See Change Wireless Direct Connection Setting as necessary.

3. Enter password on Wi-Fi Direct compatible device.
The device is connected to the printer.

> Note

* You can check the password set for the printer by the following method.

1. On the HOME screen, tap | | (Network).
2. Tap Wireless Direct.
3. Tap Show password.

* If your Wi-Fi Direct compatible device is set to prioritize using Wi-Fi Direct and it is connecting
to the printer, the printer displays a confirmation screen asking if you allow the device to
connect to the printer.

237



Make sure the name on the touch screen is the same as that of your Wi-Fi Direct compatible
device and tap Yes.

I Change Wireless Direct Connection Setting

1. Make sure printer is turned on.

(]

2. On the HOME screen, tap | | (Network).

= Home Screen Menu Composition

3. Tap Wireless Direct.
4. Tap Settings.

5. Change settings as necessary.
» To update the identifier (SSID) and the password for wireless direct
Tap Update SSID/password to display the confirmation screen.
To update the identifier (SSID) and the password, tap Yes.
To check the updated password, tap Show password.
» To change the printer's name displayed on the Wi-Fi Direct compatible device

Tap Wireless Direct network (SSID) to display the printer's name (the initial value is "DIRECT-
XXXX-GP-NNNN") displayed on a Wi-Fi Direct compatible device.

Follow the procedure below to change the name.
1. Tap the device name entry field on the touch screen.
2. Enter device name (up to 32 characters).
3. Tap OK and confirm the entered device name.
4. Tap OK.

» To change the confirmation screen setting when a Wi-Fi Direct compatible device is connecting
to the printer

Tap Connection request confirmation to display the confirmation screen.

If you want the printer to display the screen to inform you a Wi-Fi Direct compatible device is
connecting to the printer, tap Yes.

32 Important

» To prevent an unauthorized access, we recommend you should not change the setting from
the default.

When you finished performing the settings, the printer returns to the Wireless Direct settings screen.
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> Note

« If you change the wireless direct setting on the printer, also change the setting on the device.

I Change the Printer Setting to Wi-Fi Connection

1. Make sure printer is turned on.

(]

2. On the HOME screen, tap | | (Network).

= Home Screen Menu Composition

3. Tap Wi-Fi.
4. Tap Settings.
5. Tap Enable/disable Wi-Fi and tap Enable.

6. Confirm displayed message and tap OK.

239



I Default Network Settings

I LAN Connection Defaults

Item Default

Enable/Disable LAN Wired LAN enabled

Network name (SSID) BJNPSETUP

Communication mode Infrastructure

Wi-Fi security Disable

IP address (IPv4) DHCP

IP address (IPv6) Auto setup

Set printer name *1 XXXXXXXXXXXX
Enable/disable IPv6 Enable

Enable/disable WSD Disable

Timeout settings 15 minutes

Enable/disable Bonjour [Enable

Service name Canon GP-NNNN *2

LPR protocol settings Enable

Wi-Fi DRX settings Enable

Wired LAN DRX settings | Enable

("XX" represents alphanumeric characters.)

*1 Default value depends on printer. To check value, use operation panel.

= | AN settings

*2 NNNN means your printer model name.

I Wireless Direct Defaults

Item Default

Network name (SSID) DIRECT-abXX-GP-NNNN *1
Password YYYYYYYYYY *2

Wi-Fi security WPA2-PSK (AES)
Connection request confirmation | Displayed

240



*1 "ab" is specified at random and "XX" represents last two digits of printer's wireless MAC address.
NNNN means your printer model.

*2 The password is specified automatically when the printer is turned on for the first time.
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I Another Printer Found with Same Name

When the printer is found during setup, other printers with the same name may appear on the results
screen.

Select a printer with checking the printer settings against those on detection result screen.
Check the printer's MAC address or serial to select the correct printer from the results.

»» Note

+ Serial number may not appear on result screen.

Check the printer's MAC address and the serial number by one of the following methods.
» Display on the touch screen.
o MAC address
= | AN settings
o Serial number
Refer to Printer information > System information.

= Printer information

* Print the network settings.

= Printing Network Settings
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Connecting to Another Computer via LAN/Changing from USB
to LAN Connection

I For Windows:

To add a computer to connect to the printer on a LAN or to change from USB to LAN connection, perform
setup using the Setup CD-ROM or from Setup Guide.

I For macOS:

To connect an additional computer to the printer via LAN, or to change from USB to LAN connection,
perform setup from Setup Guide.
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I Printing Network Settings

Use the operation panel to print the printer's current network settings.

22 Important

» The network settings printout contains important information about your network. Handle it with care.

1. Check that printer is turned on.

2. Load plain paper.

= Loading Rolls on the Roll Holder
= [ oading Rolls in the Printer

If you use sheets, prepare at least 10 sheets (A4 or Letter-sized).

= | oading Sheets in the Printer

3. Select a (Setup) icon on HOME screen.
4. Select Printer settings.

5. Select LAN settings.

6. Select Print details.

7. Select Yes on displayed screen.

8. Select Yes or No on displayed screen.
The printer starts printing network settings information.

»» Note

* You can also print the printer's network settings. Select the : (Setup) icon > Printer settings >
Test print > Print LAN details > Yes > Yes.

The printed network settings information is as follows: (Some setting values are not displayed depending on
the printer settings.)

Item Description Setting

LAN Setting Basic setting information -

Basic Info IPv4 setting information (Wired LAN) -

LAN Interface Mode Current interface Wired LAN/Wireless LAN(Infra)/Wireless
LAN(AP)/Wireless(Wireless direct)/Disa-
bled
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Link Active Operation status Active/lnactive

IP Address IPv4 IP address XXX XXX XXX XXX
Gateway Address IPv4 default gateway XXX XXX XXX XXX
Subnet Mask IPv4 subnet mask XXX XXX XXX XXX
IP Mode Acquiring method of IPv4 IP address Auto IP/DHCP/Manual
Use DNS Auto Mode Acquiring DNS server automatically On/Off

Primary DNS Server Address Primary DNS server address XXXXXX XXX XXX
Secondary DNS Server Address | Secondary DNS server address XXX XXX XXX XXX
Control Filtering SNMP filtering setting information -

Use IP Filtering Operation status of IP filtering On/Off

IP Filtering Select IP filtering method Disabled/Enabled
IP Filtering Permission Address | IP filtering permission address -

Start Address 1 Start address 1 XXXXXX XXX XXX
End Address 1 End address 1 XXX XXX XXX XXX
Use Single On 1 Use single on 1 On/Off

Start Address 2 Start address 2 XXX XXX XXX XXX
End Address 2 End address 2 XXX XXX XXX XXX
Use Single On 2 Use single on 2 On/Off

Start Address 3 Start address 3 XXX XXX XXX XXX
End Address 3 End address 3 XXX XXX XXX XXX
Use Single On 3 Use single on 3 On/Off

Start Address 4 Start address 4 XXX XXX XXX XXX
End Address 4 End address 4 XXX XXX XXX XXX
Use Single On 4 Use single on 4 On/Off

Start Address 5 Start address 5 XXX XXX XXX XXX
End Address 5 End address 5 XXXXXX XXX XXX
Use Single On 5 Use single on 5 On/Off

IP Filtering Prohibit Address IP filtering prohibit address -

Start Address 1 Start address 1 XXXXXX XXX XXX
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End Address 1 End address 1 XXX XXX XXX XXX
Use Single On 1 Use single on 1 On/Off

Start Address 2 Start address 2 XXX XXX XXX XXX
End Address 2 End address 2 XXX XXX XXX XXX
Use Single On 2 Use single on 2 On/Off

Start Address 3 Start address 3 XXX XXX XXX XXX
End Address 3 End address 3 XXXXXX XXX XXX
Use Single On 3 Use single on 3 On/Off

Start Address 4 Start address 4 XXX XXX XXX XXX
End Address 4 End address 4 XXX XXX XXX XXX
Use Single On 4 Use single on 4 On/Off

LAN Setting Basic setting information -

Basic Info IPv4 setting information (Wired LAN) -

Control Filtering SNMP filtering setting information -

IP Filtering Prohibit Address IP filtering prohibit address -

Start Address 5 Start address 5 XXX XXX XXX XXX
End Address 5 End address 5 XXX XXX XXX XXX
Use Single On 5 Use single on 5 On/Off

Print Filtering Print filtering setting information -

Use IP Filtering Operation status of IP filtering On/Off

IP Filtering Select IP filtering method Disabled/Enabled
IP Filtering Permission Address | IP filtering permission address -

Start Address 1 Start address 1 XXXXXX XXX XXX
End Address 1 End address 1 XXX XXX XXX XXX
Use Single On 1 Use single on 1 On/Off

Start Address 2 Start address 2 XXX XXX XXX XXX
End Address 2 End address 2 XXXXXX XXX XXX
Use Single On 2 Use single on 2 On/Off

Start Address 3 Start address 3 XXX XXX XXX XXX
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End Address 3 End address 3 XXX XXX XXX XXX

Use Single On 3 Use single on 3 On/Off

Start Address 4 Start address 4 XXX XXX XXX XXX

End Address 4 End address 4 XXX XXX XXX XXX

Use Single On 4 Use single on 4 On/Off

Start Address 5 Start address 5 XXX XXX XXX XXX

End Address 5 End address 5 XXXXXX XXX XXX

Use Single On 5 Use single on 5 On/Off

IP Filtering Prohibit Address IP filtering prohibit address -

Start Address 1 Start address 1 XXX XXX XXX XXX

End Address 1 End address 1 XXXXXX XXX XXX

Use Single On 1 Use single on 1 On/Off

Start Address 2 Start address 2 XXXXXX XXX XXX

End Address 2 End address 2 XXX XXX XXX XXX

Use Single On 2 Use single on 2 On/Off

Start Address 3 Start address 3 XXX XXX XXX XXX

End Address 3 End address 3 XXX XXX XXX XXX

Use Single On 3 Use single on 3 On/Off

Start Address 4 Start address 4 XXX XXX XXX XXX

End Address 4 End address 4 XXX XXX XXX XXX

Use Single On 4 Use single on 4 On/Off

Start Address 5 Start address 5 XXX XXX XXX XXX

End Address 5 End address 5 XXXXXX XXX XXX

Use Single On 5 Use single on 5 On/Off

LAN Setting Basic setting information -

IPv6 Info IPVv6 setting information (Wired LAN) -

Link Local Address Link local address -

IP Address IPv6 IP address XXX XXX XXXXXXXX
XXX XXX XXXXXXXX
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Prefix Length

Link local address prefix length

XXX (0 to 128)

Use Manual Mode Operation status of IPv6 manual address | On/Off

Manual Address Manual address -

IP Address IPv6 IP address XXX XXX XXXXXXXX
XXX XXX XXXXXXXX

Prefix Length Prefix length XXX (0 to 128)

Use Stateful Address Mode Operation status of stateful address mode | On/Off

Stateful Address Stateful address -

IP Address IPv6 IP address XXXXXXXXKXXXXXXXX
XXX XXX XXXXXXXX

Prefix Length

Prefix length

XXX (0 to 128)

Stateless Address

Stateless address

IP Address 1

IP address 1

XXXXXXXXXKXXXXXX
XXXXXXXXXKXXXXXX

Prefix Length 1

Prefix length 1

XXX (0 to 128)

IP Address 2

IP address 2

XXXXXXXXXKXXXXXX
XXXXXXXX XXX X XXXX

Prefix Length 2

Prefix length 2

XXX (0 to 128)

IP Address 3

IP address 3

XXXXXXXX X XXX XXXX
XXXXXXXX X XXX XXXX

Prefix Length 3

Prefix length 3

XXX (0 to 128)

IP Address 4

IP address 4

XXXXXXXXKXXXXXXXX
XXXXXXXXKXXXXXXXX

Prefix Length 4

Prefix length 4

XXX (0 to 128)

Gateway Address

Gateway address

IP Address 1

IP address 1

XXXXXXXX X XXX XXXX
XXXX XXX XXXXXXXX

Prefix Length 1

Prefix length 1

XXX (0 to 128)

IP Address 2

IP address 2

XXXXXXXXXKXXXXXX
XXXXXXXXXKXXXXXX

Prefix Length 2

Prefix length 2

XXX (0 to 128)
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IP Address 3

IP address 3

XXXXXXXXKXKXXXXXX
XXXXXXXXKXKXXXXXX

Prefix Length 3

Prefix length 3

XXX (0 to 128)

IP Address 4

IP address 4

XXXXXXXXKXKXXXXXX
XXXXXXXXKXKXXXXXX

Prefix Length 4

Prefix length 4

XXX (0 to 128)

Use DNS Auto Mode Acquiring DNS server automatically On/Off

Primary DNS Server Address Primary DNS server address XXXXXXXXXXXXXXXX
XXXXXXXX X XXX XXXX

Secondary DNS Server Address | Secondary DNS server address XXX XXX X XXX X XXX
XXXXXXXX XXX XXXX

Control Filtering SNMP filtering setting information -

Use IP Filtering Operation status of IP filtering On/Off

IP Filtering Select IP filtering method Disabled/Enabled

IPv6 Filtering Permission Info IPv6 filtering permission information -

IP Filtering Start Address 1 IP filtering start address 1 XXX XXX X XXX X XXX
XXXXXXXX X XXX XXXX

IP Filtering End Address 1 IP filtering end address 1 XXX XXXXXXXX X XXX
XXXXXXXX X XXX XXXX

Use Single On 1 Use single on 1 On/Off

LAN Setting Basic setting information -

IPv6 Info IPv6 setting information (Wired LAN) -

Control Filtering SNMP filtering setting information -

IP Filtering Start Address 2 IP filtering start address 2 XXX XXXXXXXXXXXX
XXXXXXXX X XXX XXXX

IP Filtering End Address 2 IP filtering end address 2 XXX XXX X XXX XXXX
XXXXXXXX X XXX XXXX

Use Single On 2 Use single on 2 On/Off

IP Filtering Start Address 3 IP filtering start address 3 XXXXXXXXXXXXXXXX
XXXXXXXX X XXX XXXX

IP Filtering End Address 3 IP filtering end address 3 XXXXXXXX X XXX XXXX
XXXXXXXXX XXX XXXX
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Use Single On 3 Use single on 3 On/Off

IP Filtering Start Address 4 IP filtering start address 4 XXXXXXXXXXXXXXXX
XXXXXXXX X XXX XXXX

IP Filtering End Address 4 IP filtering end address 4 XXX XXXX X XXX X XXX
XXXXXXXXX XXX XXXX

Use Single On 4 Use single on 4 On/Off

IP Filtering Start Address 5 IP filtering start address 5 XXXXXXXXXXXXXXXX
XXXXXXXX X XXX XXXX

IP Filtering End Address 5 IP filtering end address 5 XXXXXXXX X XXX XXXX
XXXXXXXXX XXX XXXX

Use Single On 5 Use single on 5 On/Off

IPv6 Filtering Prohibit Info IPv6 Filtering prohibit information -

IP Filtering Start Address 1 IP filtering start address 1 XXX XXXXXXX X XXXX
XXXXXXXXXXXXXXXX

IP Filtering End Address 1 IP filtering end address 1 XXXXXXXXKXXXXXXXX
XXXXXXXX X XXX XXXX

Use Single On 1 Use single on 1 On/Off

IP Filtering Start Address 2 IP filtering start address 2 XXX XXXXXXXXXXXX
XXXXXXXX X XXX XXXX

IP Filtering End Address 2 IP filtering end address 2 XXXXXXXXXXXXXXXX
XXXXXXXX X XXX XXXX

Use Single On 2 Use single on 2 On/Off

IP Filtering Start Address 3 IP filtering start address 3 XXX XXXXXXXXXXXX
XXXXXXXX X XXX XXXX

IP Filtering End Address 3 IP filtering end address 3 XXX XXXXXXXX X XXX
XXXXXXXX X XXX XXXX

Use Single On 3 Use single on 3 On/Off

IP Filtering Start Address 4 IP filtering start address 4 XXXXXXXXKXXXXXXXX
XXXXXXXX X XXX XXXX

IP Filtering End Address 4 IP filtering end address 4 XXX XXX X XXX XX XX
XXXXXXXX X XXX XXXX

Use Single On 4 Use single on 4 On/Off
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IP Filtering Start Address 5 IP filtering start address 5 XXXX XXX XXX XX XXXX
XXX XXX XXX X XXX

IP Filtering End Address 5 IP filtering end address 5 XXX XXX XXX XX XXXX
XXX XXX XXX XXX X

Use Single On 5 Use single on 5 On/Off

Print Filtering Print filtering setting information -

Use IP Filtering Operation status of IP filtering On/Off

IP Filtering Select IP filtering method Disabled/Enabled

IP Filtering Permission Info IP filtering permission information -

IP Filtering Start Address 1 IP filtering start address 1 XXX XXX XXX XX XXXX
XXX XXX XXX XXX

IP Filtering End Address 1 IP filtering end address 1 XXXX XXX XXX XX XXXX
XXXX XXX XXX X XXX

Use Single On 1 Use single on 1 On/Off

IP Filtering Start Address 2 IP filtering start address 2 XXXX XXX XXX XX XXXX
XXX XXX XXX XXX

IP Filtering End Address 2 IP filtering end address 2 XXX XXX XXXX XXX X
XK XXX XXX XXX X

Use Single On 2 Use single on 2 On/Off

LAN Setting Basic setting information -

IPv6 Info IPVv6 setting information (Wired LAN) -

Print Filtering Print filtering setting information -

IP Filtering Start Address 3 IP filtering start address 3 XXX XXX XXX X XXXX
XXX XXX XXX X XXX

IP Filtering End Address 3 IP filtering end address 3 XXXXXXXXKXXXXXXXX
XXX XXX XXX XXX X

Use Single On 3 Use single on 3 On/Off

IP Filtering Start Address 4 IP filtering start address 4 XXX XXXXXXXXXXXX
XK XXXX XXX XXX X

IP Filtering End Address 4 IP filtering end address 4 XXXXXXXXXXXXXXXX
XXX XXX XXX EXXXX

Use Single On 4 Use single on 4 On/Off
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IP Filtering Start Address 5 IP filtering start address 5 XXXXXXXX X XXX XXXX
XXXXXXXXXXXXXXXX

IP Filtering End Address 5 IP filtering end address 5 XXXXXXXXXXXXXXXX
XXXXXXXX X XXX XXXX

Use Single On 5 Use single on 5 On/Off

IPv6 Filtering Prohibit Info IPVv6 Filtering prohibit information -

IP Filtering Start Address 1 IP filtering start address 1 XXXXXXXXXXXXXXXX
XXXXXXXX X XXX XXXX

IP Filtering End Address 1 IP filtering end address 1 XXXX:XXXX X XXX XXXX
XXXXXXXXXXXXXXXX

Use Single On 1 Use single on 1 On/Off

IP Filtering Start Address 2 IP filtering start address 2 XXX XXX XXXX: X XXX
XXXXXXXX X XXX XXXX

IP Filtering End Address 2 IP filtering end address 2 XXX XXX XXX X XXXX
XXXXXXXXXXXXXXXX

Use Single On 2 Use single on 2 On/Off

IP Filtering Start Address 3 IP filtering start address 3 XXX XXX X XXX X XXX
XXXXXXXXX XXX XXXX

IP Filtering End Address 3 IP filtering end address 3 XXX XXXXXXXXXXXX
XXXXXXXX XXX XXXX

Use Single On 3 Use single on 3 On/Off

IP Filtering Start Address 4 IP filtering start address 4 XXXXXXXX X XXX XXXX
XXXXXXXXX XXX XXXX

IP Filtering End Address 4 IP filtering end address 4 XXX XXXXXXXXXXXX
XXXXXXXX X XXX XXXX

Use Single On 4 Use single on 4 On/Off

IP Filtering Start Address 5 IP filtering start address 5 XXX XXX XXX X XXXX
XXXX XXX X XXX XXXX

IP Filtering End Address 5 IP filtering end address 5 XXX XXXXXXXXXXXX
XXXXXXXX X XXX XXXX

Use Single On 5 Use single on 5 On/Off

MAC Info

MAC address setting information (Wired/

Wi-Fi)
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MAC Address(Wired) MAC address (Wired LAN) XXXXXXK XX XX XX
MAC Address(Wireless) MAC address (Wi-Fi) XXXXXXXX XX XX
Use MAC Address Filtering Operation status of MAC address filtering | On/Off
MAC Filtering Select MAC address filtering method Disabled/Enabled
MAC Filtering Permission Info MAC filtering permission information -
MAC Address 1 MAC address 1 XXXXXXXX XX XX
MAC Address 2 MAC address 2 XXXXXXXX XX XX
MAC Address 3 MAC address 3 XXXXXX XX XX XX
MAC Address 4 MAC address 4 XXXXXXXX XX XX
MAC Address 5 MAC address 5 XXXXXXXX XX XX
LAN Setting Basic setting information -
MAC Info MAC address setting information (Wired/ |-

Wi-Fi)
MAC Filtering Prohibit Info MAC filtering prohibit information -
MAC Address 1 MAC address 1 XXXXXX XX XX XX
MAC Address 2 MAC address 2 XXXXXXXX XX XX
MAC Address 3 MAC address 3 XXXXXXXX XX XX
MAC Address 4 MAC address 4 XXXXXXXX XX XX
MAC Address 5 MAC address 5 XXXXXXK XX XX XX
Proxy Setting Proxy server setting information -
Use Proxy Use proxy server On/Off

Proxy Server Address

Proxy server address

XXXXXXXXXXXXXXXX (up to 128 char-
acters)

Proxy Port Number

Proxy port specification

1 to 65535

Use User Authority Mode

Use user authority mode

On/Off

Proxy Server User Name

Proxy server user name

XXXXXXXXXXXXXXXX (up to 64 char-
acters)

Wireless LAN Setting

Wi-Fi setting information

Channel

Channel (infrastructure)

XXX (0 to 255)

SSID

SSID

Wi-Fi (infrastructure) SSID (up to 32
characters)
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Security Type

Security type for Wi-Fi (infrastructure)

Disabled/WEP 64bit/WEP 128bit/WPA
PSK TKIP/WPA PSK AES/WPA2 PSK
TKIP/WPA2 PSK AES/MIXED

WEP1 WEP key 1 for Wi-Fi (infrastructure) XXXXXXXX (up to 32 characters)
WEP2 WEP key 2 for Wi-Fi (infrastructure) XXXXXXXX (up to 32 characters)
WEP3 WEP key 3 for Wi-Fi (infrastructure) XXXXXXXX (up to 32 characters)
WEP4 WEP key 4 for Wi-Fi (infrastructure) XXXXXXXX (up to 32 characters)
WEP Certificate WEP certificate for Wi-Fi (infrastructure) | Open/Shared/Auto

WEP Format WEP format for Wi-Fi (infrastructure) Hex/String

Direct Connection Setting

Wireless direct setting information

Device Name

Wireless direct device name

Wireless direct device name (up to 32
characters)

Channel Channel (Wireless direct) XXX (0 to 255)

SSID SSID Wireless direct network name (SSID) de-
vice name (up to 32 characters)

Security Type Security type for Wi-Fi (Wireless direct) Disabled/WPA2 PSK TKIP/WPA2 PSK
AES

WSD Setting WSD setting information -

Use WSD Use WSD On/Off

WSD Timeout Timeout 1/5/10/15/20 [min]

Use WSD Rx Optimization

Use WSD reception optimization

On/Off

Protocol Setting

Protocol setting information

Printer Name

Printer name

XXXXXXXX (up to 16 characters)

Use LPR Use LPR On/Off
Use Wired DRX Discontinuous reception (Wired LAN) On/Off
Use Wireless DRX Discontinuous reception (Wi-Fi) On/Off
Use RAW Use RAW On/Off
Use LLMNR Use LLMNR On/Off
Use Spanning Tree Use spanning tree On/Off
Use Dedicated Port Dedicated port setting On/Off

SNMP Setting

SNMP setting information
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Use SNMPv1

Use SNMPv1

On/Off

Use SNMPv3

Use SNMPv3

On/Off

SNMP Community Name1

SNMPv1 community name 1

XXXXXXXX (up to 32 characters)

SNMP Community Name2

SNMPv1 community name 2

XXXXXXXX (up to 32 characters)

SNMP Extra Access Authority

SNMPv1 extra access authority

Disable/Read Only/Read Write

SNMP Access Authority1 SNMPv1 community1/2 access authority | Read Only/Read Write

SNMP Access Authority2 SNMPv1 community1/2 access authority | Disable/Read Only/Read Write
SNMPV3 Setting SNMPV3 setting information -

User1 User 1 -

User Name User name XXXXXXXX (up to 32 characters)
Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction

MIB access restriction

Read Only/Read Write

Security Setting Security setting No Auth No Priv/Auth No Priv/Auto Priv
Authority Algorithm Authority algorithm Null/MD5/SHA1

Encryption Algorithm Encryption algorithm Null/AES/DES

User2 User 2 -

User Name User name XXXXXXXX (up to 32 characters)

Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction

MIB access restriction

Read Only/Read Write

Security Setting Security setting No Auth No Priv/Auth No Priv/Auto Priv
Authority Algorithm Authority algorithm Null/MD5/SHA1

Encryption Algorithm Encryption algorithm Null/AES/DES

User3 User 3 -

User Name User name XXXXXXXX (up to 32 characters)

Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction

MIB access restriction

Read Only/Read Write

Security Setting Security setting No Auth No Priv/Auth No Priv/Auto Priv
Authority Algorithm Authority algorithm Null/MD5/SHA1
Encryption Algorithm Encryption algorithm Null/AES/DES
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User4 User 4 -
User Name User name XXXXXXXX (up to 32 characters)
Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction

MIB access restriction

Read Only/Read Write

Security Setting Security setting No Auth No Priv/Auth No Priv/Auto Priv
Authority Algorithm Authority algorithm Null/MD5/SHA1

Encryption Algorithm Encryption algorithm Null/AES/DES

Userb User 5 -

User Name User name XXXXXXXX (up to 32 characters)

Use SNMPv3 Use SNMPv3 On/Off

MIB Access Restriction

MIB access restriction

Read Only/Read Write

Security Setting Security setting No Auth No Priv/Auth No Priv/Auto Priv
Authority Algorithm Authority algorithm Null/MD5/SHA1
Encryption Algorithm Encryption algorithm Null/AES/DES

Dynamic DNS Setting

Dynamic DNS setting

IPv4

IPv4

Use Dynamic DNS

Operation status of Dynamic DNS

On/Off

Host Name

Host name

XXXXXXXX (up to 64 characters)

Domain Name

Domain name

XXXXXXXX (up to 65 characters)

IPv6 IPv6 -
Use Manual Address DNS dynamic setting of manual address | On/Off
Use Stateless Address DNS dynamic setting of stateless address | On/Off
Use Stateful Address DNS dynamic setting of stateful address | On/Off
Use Name As IPv4 Use same host name/domain name as On/Off

that used for IPv4

Host Name

Host name

XXXXXXXX (up to 64 characters)

Domain Name

Domain name

XXXXXXXX (up to 65 characters)

SNTP Setting

SNTP setting information

Use SNTP

Use SNTP

On/Off

SNTP Polling Interval

SNTP polling interval

1 to 48 [sec]
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SNTP Server Name

SNTP server name

XXXXXXXX (up to 256 characters)

FTP Setting FTP setting information -
Use FTP Use FTP On/Off
Use FTP Authority Use FTP authority On/Off

FTP User Name

FTP user name

XXXXXXXX (up to 33 characters)

Bonjour Setting

Bonjour setting information

Use Bonjour

Use Bonjour

On/Off

Bonjour Service Name

Bonjour service name

Bonjour service name (Up to 50 alphanu-
meric characters)

802.1X Setting

802.1X setting information

Authority Type

Enable/disable 802.1X and authority type

Do not use/EAP-TLS/EAP-TTLS/PEAP

EAP TTLS Type

Internal authority type for EAP-TTLS

MSCHAPV2/PAP

Weak Encryption Restriction

Weak encryption restriction

Do not restrict/Restrict

Weak Certificate Restriction

Weak certificate restriction

Do not restrict/Restrict

Login Name

Login name

XXXXXXXX (up to 24 characters)

User Name

User name

XXXXXXXX (up to 24 characters)

Server Name

Server name

XXXXXXXX (up to 43 characters)

IPsec Setting

IPsec setting information

Use IPsec

Use IPsec

On/Off

Previous Shared Key

Previous shared key for IPsec

XXXXXXXX (up to 17 characters)

Phase2 Protocol IPsec phase2 protocol AH/ESP/AH+ESP
IPP Setting IPP confirmation setting -

Use IPP Use IPP On/Off

Use IPP Authority Use IPP authority On/Off

IPP User Setting

IPP confirmation user setting

User1 User 1 -
User Name User name XXXXXXXX (up to 32 characters)
User2 User 2 -
User Name User name XXXXXXXX (up to 32 characters)
User3 User 3 -
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User Name User name XXXXXXXX (up to 32 characters)
User4 User 4 -

User Name User name XXXXXXXX (up to 32 characters)
User5 User 5 -

User Name User name XXXXXXXX (up to 32 characters)
User6 User 6 -

User Name User name XXXXXXXX (up to 32 characters)
User7 User 7 -

User Name User name XXXXXXXX (up to 32 characters)
User8 User 8 -

User Name User name XXXXXXXX (up to 32 characters)
User9 User 9 -

User Name User name XXXXXXXX (up to 32 characters)
User10 User 10 -

User Name User name XXXXXXXX (up to 32 characters)
Email Setting E-mail setting information -

Retry Count E-mail retry count Oto5

Retry Interval E-mail retry interval 1 to 60 (min)

Use Email Notification Use E-mail notification On/Off

Use SSL Use SSL On/Off

Use SSL Cert No Check Use SSL certification On/Off

Use Mailbox Delete Use mailbox delete On/Off

SMTP Server Address

SMTP server address

XXXXXXXX (up to 256 characters)

SMTP Server Port No

SMTP server port number

1 to 65535

SMTP State

SMTP state

Invalid/Authorized/POP before SMTP

From Address

From address

XXXXXXXX (up to 128 characters)

To Address 1

To address 1

XXXXXXXX (up to 128 characters)

Reply Address 1

Reply address 1

XXXXXXXX (up to 128 characters)

Notice Conditions 1

Notice conditions 1
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Job End Job end On/Off
Error Occurred Error occurred On/Off
Warning Occurred Warning occurred On/Off

Signature 1 Signature 1 XXXXXXXX (up to 128 characters)
To Address 2 To address 2 XXXXXXXX (up to 128 characters)
Reply Address 2 Reply address 2 XXXXXXXX (up to 128 characters)

Notice Conditions 2

Notice conditions 2

Job End Job end On/Off
Error Occurred Error occurred On/Off
Warning Occurred Warning occurred On/Off

Signature 2 Signature 2 XXXXXXXX (up to 128 characters)
RUI Setting Remote Ul setting information -
Use RUI Use Remote Ul On/Off

("XX" represents alphanumeric characters.)
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Reconfiguration Method of LAN Connection/Reconfiguration
Method of Wi-Fi Connection

= Changing LAN Connection Method
= Changing Wi-Fi Connection Method

I Changing LAN Connection Method
Follow either procedure below to change LAN connection method (wired or wireless).

¢ For Windows:

o Redo setup using the Setup CD-ROM or from Setup Guide.
o Select Enable for Enable/disable Wired LAN or Enable/disable Wi-Fi in the touch screen
menu.

After that, perform settings on the Network Settings screen on IJ Network Device Setup Utility.

For details, refer to "Performing/Changing Network Settings" > "Performing Network Settings" in I1J
Network Device Setup Utility Guide.

= |J Network Device Setup Utility Guide

* For macOS:

Redo setup from Setup Guide.

I Changing Wi-Fi Connection Method
Follow either procedure below to change Wi-Fi connection method (infrastructure or wireless direct).

¢ For Windows:

o Redo setup using the Setup CD-ROM or from Setup Guide.
o Perform settings on the Network Settings screen on IJ Network Device Setup Ultility.

22 Important

» Before you perform settings using IJ Network Device Setup Utility, change the printer settings
following the procedure below.

1. Select LAN settings on HOME screen.

= Home Screen Menu Composition

If you specify the administrator password, enter the password.
2. Select Wi-Fi.
3. Select Settings.

4. Select Wi-Fi setup.
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5. Select Easy wireless connect.

6. Check message and select OK.

Follow instructions on your smartphone or tablet.

7. If message saying setup is completed appears, select OK.

¢ For macOS:

Redo setup from Setup Guide.
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I Countermeasures against Unauthorized Access

This section describes countermeasures against an unauthorized access to the printer from outside. When
you use the printer via a network or you are an administrator, we recommend you read this section before
using the printer.

Four countermeasures below can be helpful against an unauthorized access.

= Specify a Private IP Address

= Restrict Communication Using Firewall or Wi-Fi Router
= Specify a Password for the Printer

= Apply higher security level for Wi-Fi connection

> Note

* As the setting procedure described below is an example, it may be different from that of your printer.
For details, refer to your printer's manual.

I Specify a Private IP Address

An IP address is a numeric label assigned to each device on the network. There are two types of IP
address. One is used for internet connection ("global IP address"), and the other is used for a local area
network such as an inhouse LAN ("private IP address").

If a global IP address is specified for the printer, many and unspecified users on internet can access to
the printer. As a result, you will face an increased risk of information leakage caused by an unauthorized
access from outside. On the other hand, if a private IP address is specified for the printer, users who can
access to the printer are confined to those on a local area network such as an inhouse LAN. Therefore,
we recommend you specify a private IP address for the printer.

The range of addresses used as a private IP address is shown below. Make sure whether a private IP
address is specified for your printer.
Range of private IP address

» 10.0.0.0 to 10.255.255.255
* 172.16.0.0 to 172.31.255.255
* 192.168.0.0 to 192.168.255.255

Procedure to check the IP address

Select Setup > Device settings > LAN settings on your printer to select a network connection method
and check the IP address. For the procedure to check and specify the IP address, refer to your printer's
manual.

> Note

« Establishing an environment to protect an access from outside using a firewall can reduce a risk of an
unauthorized access even though a global IP address is specified for your printer.
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I Restrict Communication Using Firewall or Wi-Fi Router

Firewall is a system which prevents an unauthorized access from an external network user to protect an
inhouse network against attack or intrusion.

Firewall enables your network to be protected against an unauthorized access by restricting a
communication from the specific external IP address which seems to have a risk.

A home use Wi-Fi router has a similar function. Be careful when you change the settings.

I Specify a Password for the Printer

Even if a malicious third party accesses to your printer by any chance, you can reduce a risk of
information leakage drastically by specifying a password to protect various information on your printer.

In addition, though the printer can be protected by specifying a password, it is important to manage the
specified password for security. Manage your password referring to the four points below. For details,
refer to your printer's manual.

» Be sure to change the default password.

» Change the password periodically.

* Do not use a password easy to guess for a third party.

» Do not tell a third party about the specified password casually.

»>» Note

» A password is not specified for some printers at the time of purchase. In this case, specify the
password for the printer.
» A password cannot be specified for some printers.

Password management using Remote Ul (User Interface)

Remote Ul is a software to access to the printer via a network by using a web browser. You can check the
printer status or settings on Remote Ul, which allows you to perform operations almost the same as those
you can on the operation panel of the printer.

Entering the printer's IP address or host name on the web browser displays the portal page of Remote Ul.
For the procedure to start up or operations of Remote Ul, refer to your printer's manual.

32 Important

» Do not access to a website while you are using Remote Ul on the web browser.

In addition, be sure to close the web browser when you leave your seat before you finish performing
settings, or when you have finished performing settings.

I Apply higher security level for Wi-Fi connection

When you use the printer via Wi-Fi, we recommend you apply a security method with higher security level
(e.g. WPA/WPA2).

For more on operations, refer to your printer's manual.
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I Network Status and Troubleshooting

Check the network status referring to LAN setting information on the touch screen.

= Printing Network Settings

Network Status

What to Do

Connected normally.

If you are unable to
print, see 1 on What
to Do.

1. If you are unable to print, check the items below:

» whether the computer is connected to Wi-Fi

» whether the firewall of your security software is enabled

» whether a privacy separator, SSID separator, or Network separation function is ena-
bled on your wireless router

If one of the above is enabled, disable it before setup.

» whether the network name (SSID) of the printer (see "3-2-6" of network setting infor-
mation printout) matches that of the router to connect

2. To change the network connection method (wired/wireless), change it on the printer's
network setting screen.

Wi-Fi is disabled on
the printer.

Perform printer setup following the instructions of the manual.

Wired LAN connec-
tion is disabled.

Make sure the printer is connected to the router with the LAN cable.
If the LAN cable is loose, connect the cable properly.

If the LAN cable is connected to the WAN side of the router, connect the cable to the LAN
side of the router.

Make sure the network devices (e.g. hub or router) are turned on.

IP address is not as-
signed.

If you specify the printer's IP address automatically, enable DHCP on the router.

If you specify the printer's IP address manually, the address is disabled because it is out of
the valid range. You specified (0.0.0.0) as the IP address, for example.

Specify the valid IP address.

The default gateway
is not specified.

Check the items below to communicate by hopping routers (e.g. using a cloud application).

» Make sure the device specified as the default gateway is turned on.
 Specify the default gateway address correctly.
To check the default gateway, print out the network settings information.

¥¥» Note

» For some printers, you can check the default gateway on the operation panel.

Cannot connect to
the specified net-
work.

Check the status of the printer, network devices (e.g. wireless router), or smartphone/tablet.

« If they are turned off, turn them on.
» Make sure wireless signal is strong.

Monitor signal status and move the printer and wireless router as necessary.
» The security key specified for the wireless router may not match that you entered.

The security key is case-sensitive.
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Enter the correct security key.

Make sure wireless
signal is strong.

Make sure the printer is not placed too far away from the wireless router.

Monitor signal status and move the printer and wireless router as necessary.

The number of con- Wireless Direct does not allow more than 5 devices to be connected.
nected clients rea-

ches the upper limit.

If you add a device to connect, disconnect a device you do not use before adding the
device.

The signal to noise There is a lot of noise from other devices.
ratio (S/N ratio) is

low.

Move the printer apart from other devices.

A link local address Perform printer setup again.

is assigned. * The security key specified for the wireless router may not match that you entered.
The security key is case-sensitive.
Enter the correct security key.

The specified net- The network name (SSID) is not specified.

work name (SSID) is
left default value.

Enter the network name (SSID) specified for the destination.
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I Sharing the Printer on a Network (Windows)

When computers are used in a network environment, documents can be printed from multiple computers
that share a single printer.

Prind Servar
"'q.*
Metwork
L) o 2
£ i £ LY £ kY
Chent PC Client PC Client PC

» Setting Up a Shared Printer

This section describes how to set up the print server and the client.

»» Note

» The Windows versions of the computers connected to the network do not necessarily have to be the
same.

I Related Topic

= Restrictions on Printer Sharing
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I Setting Up a Shared Printer

On the print server, set up sharing of the printer driver. Then from the client, set up the connection to the
print server.

1. Install the printer driver on the print server system

2. Display the Devices and Printers window

Select the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers.
The Devices and Printers window is displayed.

3. Click the icon for the model name of printer to be shared
Press the Alt key, and from the displayed File menu, select Printer properties -> Sharing tab.

3% Important

» When starting up the software and performing install or uninstall, a confirmation or warning dialog
box may appear.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

4. Set sharing

On the Sharing tab, check (or select) Share this printer, set the shared name as necessary, and then
click OK.

5. If the print server and the client have different architectures (32 bit or 64 bit), install an
additional driver

-—

. Display the Devices and Printers, Printers, or Printers and Faxes window.

2. Select the printer icon, click Print server properties, and select the Drivers tab.
3. Click Add....

4. When the Add Printer Driver Wizard window is displayed, click Next.

5. If the print server has a 32-bit architecture, select x64. If the print server has a 64-bit
architecture, select x86. Then click Next.

6. Click Have Disk....

7. In the Install From Disk window, open the "Driver" folder of the downloaded printer driver,
specify the "inf" file, and click OK.
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¥ Note

« If the printer server is 32-bit, specify it as "xxxxxxx3.INF". If it is 64-bit, specify it as "xxxxxxx6.INF".

8. Select the printer to be used, and click Next.

¥ Note

« If an error message is displayed, select the other printer.

9. Click Finish

The setup on the print server system is complete. Next, set up the client systems.
6. On the client, open Explorer, and double-click the icon of the printer to be shared

7. Follow the window instructions, and install the printer driver

The setup on the client system is complete.
Even when you perform the setup on a different client, follow the same steps 6 and 7.
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I Restrictions on Printer Sharing

These are restrictions that apply when you are using a printer in a network environment. Check the
restrictions for the environment you are using.

I Restriction on setting up printer sharing

If "ntprint.inf" is requested when you install the driver from Add Printer, specify the file as follows:

1. Start Explorer on the print server and on the client with the different architecture, paste the
following path in the address bar, and press Enter on the keyboard:
Y%windir%\system32\driverstore\

2. Right-click the FileRepository folder, and click Properties.

3. On the Sharing tab, click Share.

4. In the message window displayed on the print server, specify "ntprint.inf_xxxxxxxx" in the folder
that was shared in step 3, and click OK.

If there are multiples copies, select the file with the latest update date and time.

I Restrictions on sharing and using a printer

A print completion message may be displayed. To disable the message display, follow the procedure
below.
1. In the Control Panel -> Hardware and Sound (Hardware) -> Devices and Printers window of
the client system, select the printer, and click Print server properties on the command bar.
2. Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

The bi-directional communication function is disabled and the correct printer status may not be
recognized.
If a client user opens the printer driver properties and then clicks OK with the Enable bidirectional
support check box cleared on the Ports tab, the bidirectional communication function of the print
server may also be disabled.
In this case, check Enable bidirectional support check box on both the print server system and the
client system.
When you print from a client system, the following functions cannot be used.

o The Free Layout and the Edit Using PosterArtist features of Page Layout in the Layout tab

When the functions on the Device Settings tab cannot be set properly from a client system, they may
be grayed out. In this case, change the settings from the print server.

When you change the settings of the print server, you should delete the icon of the shared printer
from the client system, and then specify the shared settings again in the client system.

If the same driver installed on the print server is also installed on the client, the network printer icon
may be created automatically.

If an error occurs when you print a document on a shared printer from a client, the error message

of the Canon |J status monitor is displayed on both the client and the print server. If a document is
printed out normally, the Canon IJ status monitor is displayed only on the client.
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I Adjustments for Better Print Quality

» Adjusting the Print Head

@ Adjusting the Print Head

@« Troubleshooting Paper Abrasion and Blurry Images
» Adjusting Feed Amount

@ Adjusting Feed Amount

@ Adjusting Vacuum Strength
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I Adjusting the Print Head

» Adjusting the Print Head

» Troubleshooting Paper Abrasion and Blurry Images
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| Adjusting the Print Head

If printed documents are affected by the following problems, try adjusting the print head.

« If printing is faint or affected by banding in different colors
Execute Nozzle Check in the touch screen menu to check for print head nozzle clogging.

= Checking for Nozzle Clogging

« If printed lines are misaligned
Execute Print head angle adjustment in the touch screen menu to adjust the print head angle.
Always adjust the print head angle after replacing the print head.

= Adjusting Line Misalignment

After executing Print head angle adjustment, adjust the print head position.

= Automatic Adjustment to Straighten Lines and Colors
= Manual Adjustment to Straighten Lines and Colors

If printed vertical lines are warped or colors are out of alignment
Execute Print Head Alignment in the touch screen menu to adjust the print head position.

First, execute Auto (standard) of Print Head Alignment. If the print result is not improved, execute
Auto (advanced) or Manual.

= Automatic Adjustment to Straighten Lines and Colors
= Manual Adjustment to Straighten Lines and Colors

« If paper rubs against the print head, or image edges are blurred

Setting Paper thickness (head height) in the touch screen menu and changing the height of the print
head may improve the situation.

= Troubleshooting Paper Abrasion and Blurry Images
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I Adjusting Line Misalignment

If printed lines are misaligned, execute Print head angle adjustment to adjust the print head angle. Print
head angle adjustment requires you to examine a printed test pattern and adjust the angle using the angle
adjustment lever.

Always adjust the print head angle after replacing the print head.

3% Important

» Because the results of adjustment vary depending on the type of paper used for adjustment, use the
same type of paper as you will use for printing.

* When using cut sheets, do not move the release lever until instructions (guidance) for removing the
paper are displayed.

Moving the release lever during printing or maintenance operations will cause the printer to stop.

Paper to Prepare

When using rolls
An unused roll at least 10.00 in. (254.0 mm) wide

When using sheets
1 sheet of unused paper of at least Ad/Letter size

Perform adjustment as follows.

1. Load paper.

= Loading Rolls in the Printer
= | oading Sheets in the Printer

2% Important

+ Always make sure the loaded paper matches the type of paper specified on the printer.
Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. Tap a (Setup) > Maintenance on HOME screen.

= Home Screen Menu Composition

The Maintenance screen appears.

3. Tap Print head angle adjustment.

A confirmation message appears.

4. Tap Yes.

The carriage moves and instructions for the print head angle adjustment procedure are displayed on the
touch screen.

5. Open the top cover.
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A test pattern is printed for adjustment.

2% Important

» Do not touch the linear scale (A) or carriage shaft (B). Touching these may cause malfunction.

7. Examine the test pattern for adjustment. Determine the straightest set of lines.
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»» Note

« If the problem, such as misaligned lines or color unevenness, is not solved after adjustment, execute
Print head angle adjustment and move the angle adjustment lever in the front or the rear of the last
position. When finished, execute Print Head Alignment again.
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I Automatic Adjustment to Straighten Lines and Colors

If printed vertical lines are warped or colors are out of alignment, execute Print Head Alignment and adjust
the print head position.

Choose from Auto (standard) or Auto (advanced) for automatically adjusting the print head.

Minor warping and misaligned colors can usually be improved by executing Auto (standard). If there is no
improvement, perform Auto (advanced) or Manual.

= Manual Adjustment to Straighten Lines and Colors

When you execute Auto (standard) or Auto (advanced), the adjustment pattern is printed, and the print
head position is adjusted based on the printing result automatically.

.

22 Important

« If the problem, such as misaligned lines, is conspicuous, or other problem, such as color unevenness,
is not solved after executing Print Head Alignment, execute Print head angle adjustment and then
execute Print Head Alignment again.

= Adjusting Line Misalignment

» Because the results of adjustment vary depending on the type of paper used for adjustment, use the
same type of paper as you will use for printing.

 This function is not available with Tracing Paper, Translucent Matte Film, or Clear Film.

» When using cut sheets, do not move the release lever until instructions (guidance) for removing the
paper are displayed.

Moving the release lever during printing or maintenance operations will cause the printer to stop.

»» Note

« After print head replacement, we recommend executing Print Head Alignment. When Print pattern
after new head is set to ON, print head position adjustment is automatically executed after print head
replacement.

» To change the paper type or for more beautiful color borders, perform Auto (standard).

» To ensure clear quality and when replacing the print head, perform Auto (advanced) to fine-tune the
position between nozzles and colors. To ensure high-quality printing, we recommend that you execute
Auto (advanced).

« If adjustment is not possible as expected using special paper, try another type of paper or try Manual
adjustment.

= Manual Adjustment to Straighten Lines and Colors

Paper to Prepare

When using rolls
An unused roll at least 10.00 in. (254.0 mm) wide
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When using sheets
Auto (standard): 2 sheets of unused paper, A4/Letter size or larger (or 1 sheet when using A2 or
larger)

Auto (advanced): 3 sheets of unused paper, A4/Letter size or larger (or 1 sheet when using A2 or
larger)

Perform adjustment as follows.

1. Load paper.

= Loading Rolls in the Printer
= | oading Sheets in the Printer

32 Important

» Always make sure the loaded paper matches the type of paper specified on the printer.
Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. Tap Q (Setup) > Maintenance on HOME screen.

= Home Screen Menu Composition

The Maintenance screen appears.
3. Tap Print Head Alignment.

4. Tap Auto (standard) or Auto (advanced).

A confirmation message appears.

5. Tap Yes.

The paper source setting screen appears.

6. Tap Roll paper or Manual.

A test pattern is printed for adjustment.

»» Note

« If you are printing on sheets smaller than A2 size, a confirmation message prompting you to
continue printing appears on the touch screen. Tap Yes and follow the instructions on the touch
screen.
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I Manual Adjustment to Straighten Lines and Colors

If printed vertical lines are warped or colors are out of alignment, execute Print Head Alignment and adjust
the print head position.

Normally, execute Auto (standard).

= Automatic Adjustment to Straighten Lines and Colors

However, when printing on special paper or if printing is not improved after Auto (advanced), try Manual.

Manual adjustment requires you to examine the printed test pattern and enter an adjustment value.

.

22 Important

» Because the results of adjustment vary depending on the type of paper used for adjustment, use the
same type of paper as you will use for printing.

* When using cut sheets, do not move the release lever until instructions (guidance) for removing the
paper are displayed.

Moving the release lever during printing or maintenance operations will cause the printer to stop.

Paper to Prepare

When using rolls
An unused roll at least 10.00 in. (254.0 mm) wide

When using sheets
1 sheet of unused paper, Ad/Letter size or larger (or 1 sheet when using A2 or larger)

Perform adjustment as follows.

1. Load paper.

= Loading Rolls in the Printer
= | oading Sheets in the Printer

3% Important

» Always make sure the loaded paper matches the type of paper specified on the printer.
Adjustment cannot be completed correctly unless the loaded paper matches the settings.

2. Tap Q (Setup) > Maintenance on HOME screen.

= Home Screen Menu Composition

The Maintenance screen appears.

3. Tap Print Head Alignment.
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4. Tap Manual.
A confirmation message appears.

»» Note

* If you do not perform Auto (advanced), a confirmation message prompting you to perform Auto
(advanced) appears. In this case, tap Yes and perform Auto (advanced).

5. Tap Yes.

The paper source setting screen appears.

6. Tap Roll paper or Manual.

A test pattern is printed for adjustment.
7. Tap D-1.

8. Examine adjustment test pattern D-1 and determine the number with straight lines.

1)
‘:
H[

A B

A: Example with straight lines
B: Example with misaligned lines

»» Note

« |If two patterns seem equally good and you cannot decide which one is better, choose an
intermediate value. For example, choose 11 if you cannot decide whether pattern 10 or 12 is
better.

9. Repeat steps 7-8 to specify adjustment values for D-2 and other remaining patterns.

Specify all the items displayed on the touch screen.

10. Tap OK.

The adjustment value is now registered, and adjustment is complete.
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I Troubleshooting Paper Abrasion and Blurry Images

The print head height setting affects printing quality.

Specifying a low print head height makes images clearer and enhances printing quality but may cause paper
to rub against the print head.

On the other hand, specifying a high print head height will prevent paper from rubbing against the print head
but may reduce the printing quality.

22 Important

» Paper rubbing against or becoming caught on the print head may jam or result in printed documents
that are soiled.

2> Note
* Raise or lower print head, depending on nature of the problem.

= Paper rubs against the Print Head
= The edges of the paper are dirty
= |mage edges are blurred or white banding occurs

1. Tap paper setting display area on HOME screen.

= Home Screen Menu Composition

Ready to print

i€ Plain Paper
% A3 Roll

—. Replace lp Feed/Cut
" paper s

T | & |
The Paper menu screen appears.

2. Tap Paper settings.

The Paper settings screen appears.

3. Tap Advanced.

The Advanced paper settings screen appears.
4. Tap Paper thickness (head height).

5. Drag slider to set paper thickness (head height) and tap OK.
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»» Note

* When Auto is set to ON, before printing, the printer automatically adjusts the print head height
to the level optimal for the ambient temperature and humidity. You can check the setting for the
previous print job in Values applied with auto settings.

= Printer information

* When Auto is set to OFF, the setting selected during this procedure is applied.
» Depending on the type of paper, some setting values may not be available.
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I Adjusting Feed Amount

» Adjusting Feed Amount

» Adjusting Vacuum Strength
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I Adjusting Feed Amount

» Selecting Feed Amount Adjustment Method
» Automatic Banding Adjustment

» Manual Banding Adjustment

» Fine-Tuning Paper Feed Amount

» Adjusting Line Length
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I Selecting Feed Amount Adjustment Method

There are two methods of adjusting the paper feed amount, Prioritize print quality and Prioritize length
accuracy, either of which will be applied during printing.

Since the method that is applied during printing is determined from the value of the Set priority setting,
configure Set priority to match the print target.

Follow the procedure below to perform settings.

o

1. TapL__— [ (Setup) on HOME screen.

= Home Screen Menu Composition

2. Tap Maintenance.

3. Tap Paper feed adjustment.
4. Tap Set priority.

5. Tap paper to adjust.

6. Tap setting.
Auto
Prioritize print quality will be selected when Print Target is set from the printer driver.

Prioritize print quality
Adjusts the feed amount to reduce banding across the sheet in printed documents. Adjust print
quality settings are applied.

When Paper feed fine adjustment is executed, the Paper feed fine adjustment settings are
applied in addition to the Adjust print quality settings.

Prioritize length accuracy
Adjusts the feed amount for better accuracy of lines in printed documents. The value of Change
adjustment values in Adjust feed length is applied.

7. Tap OK.
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I Automatic Banding Adjustment

If printed images are affected by banding in different colors across the sheet, execute Adjust print quality
for automatic adjustment of the paper feed amount.

The printer prints and reads a test pattern for automatic adjustment of the feed amount.
22 Important
* When using highly transparent media, use manual adjustment.

= Manual Banding Adjustment

»» Note

* We recommend executing the adjustment if you have changed the paper type or paper size.
* Always check the Set priority values.

= Selecting Feed Amount Adjustment Method

+ If additional fine-tuning is necessary, execute Paper feed fine adjustment.

= Fine-Tuning Paper Feed Amount

* Use Adjust feed length to ensure that lines in CAD drawings are printed at exactly the right length.
= Adjusting Line Length

» This may take some time, depending on the type of paper.

Items to Prepare

When Using Rolls
An unused roll at least 254.0 mm (10.00 in.) wide

When Using Sheets
One sheet of unused paper of at least Ad/Letter size

Follow the procedure below to adjust.

1. Load paper.

= Loading Rolls in the Printer
= | oading Sheets in the Printer

<

2. Tap________ [ (Setup) on HOME screen.

= Home Screen Menu Composition

3. Tap Maintenance.

4. Tap Paper feed adjustment.

5. Tap Adjust print quality.
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6. Tap Auto.

7. Tap paper to adjust.

A test pattern is printed for adjustment and adjustment is finished.
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I Manual Banding Adjustment

If printed images are affected by banding in different colors, execute Adjust print quality for adjustment of
the paper feed amount.

Use manual adjustment with highly transparent media.
Manual adjustment requires you to enter an adjustment value after a test pattern is printed.

> Note

* We recommend executing the adjustment if you have changed the paper type or paper size.
» Always check the Set priority values.

= Selecting Feed Amount Adjustment Method

If additional fine-tuning is necessary, execute Paper feed fine adjustment.

= Fine-Tuning Paper Feed Amount

Use Adjust feed length to ensure that lines in CAD drawings are printed at exactly the right length.
= Adjusting Line Length

Items to Prepare

When Using Rolls
An unused roll at least 254.0 mm (10.00 in.) wide

When Using Sheets
Two sheets of unused paper of at least A4/Letter size

Follow the procedure below to adjust.

1. Load paper.

= Loading Rolls in the Printer
= | oading Sheets in the Printer

2% Important

» Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be
completed correctly unless the loaded paper matches the settings.

<&

2, TapL__— [ (Setup) on HOME screen.

= Home Screen Menu Composition

3. Tap Maintenance.
4. Tap Paper feed adjustment.
5. Tap Adjust print quality.

6. Tap Manual.

288



10.

1.

. Tap paper to adjust.

Test pattern A is printed for manual adjustment.

»» Note

» When printing on sheets, follow the instructions on the screen and remove the sheet.

Examine test pattern A for adjustment.

Determine pattern in which banding is least noticeable.

»» Note

+ If banding seems least noticeable in two patterns but you cannot decide which one is better,
choose an intermediate value. For example, choose 11 if you cannot decide whether pattern 10 or
12 is better.

. Tap number you decided.

Test pattern B is printed for manual adjustment.

> Note

* If you printed test pattern A on a sheet, follow the instructions on the screen and use another
sheet of the same type of paper. Additionally, after test pattern B is printed, follow the instructions
on the screen and remove the sheet.

Examine test pattern B for adjustment. Determine pattern in which banding is least
noticeable.

Tap number you decided.

The adjustment value is now registered, and adjustment is complete.
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I Fine-Tuning Paper Feed Amount

If the contrast is uneven or banding in different colors appears at 30 mm (1.2 in) intervals in printed
documents, try executing Paper feed fine adjustment during printing to fine-tune the feed amount.

»» Note

* The Paper feed fine adjustment menu is only displayed during printing. Additionally, it is displayed
when you have selected Auto or Prioritize print quality in Set priority in Paper feed adjustment.

* Always execute Adjust print quality before Paper feed fine adjustment. Once you execute Adjust
print quality, the Paper feed fine adjustment value will revert to 0.

= Automatic Banding Adjustment
= Manual Banding Adjustment

Follow the procedure below to adjust.

<

1. TapL_ — [ (Setup) on HOME screen during printing .

= Home Screen Menu Composition

2. Tap Maintenance.
3. Tap Paper feed fine adjustment.

4. Tap value.

At this time, if banding in dark colors appears, select a setting value in the range 1 to 5, and if banding in
light colors appears, select a setting value in the range -1 to -5.
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I Adjusting Line Length

To ensure that lines in CAD drawings are printed at exactly the right length, use Adjust feed length to
adjust the amount that paper is advanced.

There are two options in Adjust feed length : Print alignment pattern and Change adjustment values.

»>» Note

* We recommend executing the adjustment if you have changed the paper type or paper size.
* Always check the Set priority values before adjustment.

= Selecting Feed Amount Adjustment Method

Items to Prepare

When Using Rolls
* An unused roll at least 254.0 mm (10.00 in.) wide
+ High-precision ruler

When Using Sheets
* One sheet of unused paper of at least Ad/Letter size
» High-precision ruler

Follow the procedure below to adjust.

1. Load paper.

= | oading Rolls in the Printer
= | oading Sheets in the Printer

3% Important
» Always make sure the loaded paper matches the type of paper specified.

Adjustment cannot be completed correctly unless the loaded paper matches the settings.

<

2. Tap.__— [ (Setup) on HOME screen.

= Home Screen Menu Composition

3. Tap Maintenance.
4. Tap Paper feed adjustment.
5. Tap Adjust feed length.

6. Tap Print alignment pattern or Change adjustment values.
* If you tap Print alignment pattern:
The test pattern is printed for you to measure the scale and calculate the discrepancy.

The scale bar prints "Millimeter" in 50 mm increments and "Inch" in 1-inch increments.
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Blellimyetier Inecch

« If you tap Change adjustment values:

No test pattern is printed.

Instead, you will measure a document already printed to determine the discrepancy.

7. Tap amount of discrepancy.

If the scale is shorter than the actual size, use a positive setting value. If it is longer, use a negative
value. The feed amount can be adjusted in 0.02% increments.
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I Adjusting Vacuum Strength

When printing on heavyweight paper or paper that curls or wrinkles easily, if the Print head rubs against
paper, adjusting the level of suction against paper on the platen may improve results.

32 Important

» Paper rubbing against or becoming caught on the Print head may jam or result in printed documents
that are soiled.

1. On the HOME screen, tap paper information area.

Ready to print

£ Plain Paper
= A3 Rl

— Replace e Feed/Cut
= paper s

= | 6 | &
2. Tap Paper settings.
3. Tap Advanced.
4. Tap Transport unit vacuum strength.

5. Tap vacuum strength.
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I Maintenance and Consumables

» Ink Tanks

@ Ink Tanks

Replacing Ink Tanks

Checking Ink Tank Levels
« When to Replace Ink Tanks
» Print Head

Print Head

Checking for Nozzle Clogging

Cleaning the Print Head

Replacing the Print Head
» Maintenance Cartridge
@« Maintenance Cartridge
@« Replacing the Maintenance Cartridge
@« Checking the Remaining Maintenance Cartridge Capacity

« When to Replace the Maintenance Cartridge

¥

Cutter Blade
« Cutter Blade
« Replacing the Cutter Blade
» Performing Maintenance Functions from Your Computer (Windows)
@« Cleaning the Print Heads
@ Printing a Nozzle Check Pattern
» Performing Maintenance Functions from Your Computer (macOS)
« Opening Remote Ul for Maintenance
@ Cleaning the Print Heads
@ Printing a Nozzle Check Pattern

» Cleaning the Printer
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@ Cleaning the Printer Exterior
@ Cleaning Inside the Top Cover
@ Cleaning the Print Head

» Other Maintenance
@ Preparing to Transfer the Printer
@« Reinstalling the Printer

« Firmware update
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| ink Tanks

> Ink Tanks
» Replacing Ink Tanks
» Checking Ink Tank Levels

» When to Replace Ink Tanks
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| ink Tanks

The printer supports the following ink tanks.

When purchasing, check the Model number.

« 130 ml (4.4 fl 0z)

=

« 300 ml (10.1 fl 0z)

| checking Ink Model Number

Checking Using Web Browser

1. Start up Remote UL.

= Start up Remote Ul

2. Select Ink model number.
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Menu Printer status

Details

When a password Is set, you
will be requested to enter your

password, Estimated ink levels

Manual [Onling)

Ready to print

For secure communication

|
]
_——e-------

Download firmware
b ———

Ink model number Order My Ink Now

The type and number of inks displayed will vary depending on the printer you are using.

Checking Using Canon IJ Status Monitor ( Windows )

1. Start up Canon |J Status Monitor.

= Canon |J Status Monitor

2. Click Estimated ink levels.

3. Click Ink Model Number information.

o Canan =
Qptssn Bemote Ul Help

x

Prrtor i o,
Docurment Mlame
Drwrer
Prriing Page
Fermairing Prrting Time of Cumert Page:

¥ Eitrmged s liveis

H” |
{
i

i
s

¥ Estegped Marterarce Cotador Usage

[ 3 Paper Feed

The type and number of inks displayed will vary depending on the printer you are using.
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»» Note

» For instructions on replacing the ink tanks, see Replacing Ink Tanks.
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I Replacing Ink Tanks

I Compatible Ink Tanks

For details on compatible ink tanks, see Ink Tanks.

You can replace ink tanks in 4.4 fl oz (130 ml) and 10.1 fl oz (300 ml).
»>» Note

» Depending on the color, you can also use an ink tank with a different capacity.

I Precautions When Handling Ink Tanks

Take the following precautions when handling ink tanks.

A Caution

 For safety, keep ink tanks out of the reach of children.
* Ifink is accidentally ingested, contact a physician immediately.

3% Important

» There may be ink around the ink holes of an ink tank you removed. Handle the ink tanks carefully
during replacement. The ink may stain clothing.

» Do not install ink tanks used in this printer in another printer. This will prevent correct ink level
detection, which may damage the printer or cause other problems.

* We recommend using up an ink tank in the course of printing within six months after breaking the
seal. Printing quality may be affected if you use older ink tanks.

» Do not leave the printer without ink tanks installed for extended periods (a month or more). Residual
ink may become clogged inside the printer and affect printing quality.

I How to Replace an Ink Tank

If a message indicates you should replace an ink tank, check the message details and go to step 2.

1. Selecting Ink Tank Replacement from Menu
2. Removing Ink Tanks

= Removing ink tank

3. Loading New Ink Tanks
= [oading ink tank
22 Important

» Do not remove an ink tank during initialization immediately after turning on the printer, or during print
head cleaning. Ink may leak out.

»» Note

* Ink tank replacement is possible even during printing, when print jobs are being canceled, or when
paper is being advanced.
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I Selecting Ink Tank Replacement from Menu

1. Tap ‘ (Ink information) on HOME screen.

= Home Screen Menu Composition

The Current estimated ink levels screen appears.

2. Tap Replace.

Instructions for the ink tank replacement procedure appear on the touch screen.

I Removing ink tank

1. Open ink tank cover.

32 Important

» Avoid jarring the printer a lot when replacing an ink tank. Handle the printer gently when
replacing tanks. Jarring the printer during printing may affect printing quality.

2. Press tip of ink tank lock lever of color for replacement horizontally and pull ink tank lock
lever up to open it.

3. Remove ink tank by grips (A), and then tap OK.
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22 Important

» Do not turn off the printer, except for transportation, while the ink tank is removed. It may cause
the interior of the ink tank cover to become soiled.

 Store the removed ink tank with ink remaining with the ink holes (B) facing up. Otherwise, ink
may leak and cause stains. Put the removed ink tank in a plastic bag and close the bag.

B

> Note

» Dispose of the used ink tank in accordance with local regulations.

I Loading ink tank

1. Before opening the pouch, tilt the ink tank to the left and right gently one or two times.

Agitate the ink in the ink tank by slowly rotating the ink tank upside-down and right side up repeatedly.
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22 Important

» Do not remove and agitate an ink tank that has already been installed in the printer. Ink may
leak out.

« Failure to agitate the ink tank may cause the ink components to precipitate and may affect
printing quality.

23> Note

« If the ink tank is at a low temperature, allow it to warm up to room temperature before installing.

2. Open the pouch and remove the ink tank.

22 Important

» Never touch the ink holes (B) or the metal contacts (C). This may cause stains, damage the ink
tank, and affect printing quality.
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 Avoid dropping the ink tank after removing it from the pouch. Otherwise, ink may leak and
cause stains.

3. Tap OK and insert ink tank into holder with ink holes down and metal contacts in front.

22 Important
< An ink tank cannot be loaded in the holder if the color or orientation is incorrect.

If the ink tank does not fit in the holder, do not force it into the holder. Reinstall while checking
the label color display, ink tank color, and ink tank orientation.

4. Push the ink tank lock lever closed until it clicks into place.

"
i~
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32 Important

» Do not push the ink tank in by hand. Forcing the ink tank into the holder may damage the
printer.

* Ifa 4.4 fl oz (130 ml) ink tank is installed facing the wrong direction, the rotating part of the ink
tank lock lever come out of place. If this happens, open the ink tank lock lever to return it to the
proper position.
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I Checking Ink Tank Levels

On the touch screen, you can check how much ink is left in the ink tank.

1. Tap . (Ink information) on HOME screen.

= Home Screen Menu Composition

The Current estimated ink levels screen appears.

Current estimated ink levels

]
¥ C

Replace Order ink now

N
3 — |
= N |
z N |

=
=

B

This printer has ink tanks (A) and sub-ink tanks (B). Even if ink runs out, printing can continue with ink in

the sub-ink tanks.

When the remaining ink is low, @ will appear on the remaining ink level. When ink runs out, 0 will
appear. See the figure below.

@ & O

i

W W W w [(]}B

If the touch screen indicates to replace the ink tank, replace the ink tank. If a message is displayed

indicating to check the remaining ink levels, or after tasks that consume a lot of ink such as large-format

printing or head cleaning, check the remaining levels and replace ink tank as needed.

= Replacing Ink Tanks

»» Note

» Tap Order ink now to view the ink supplier information.
* When the ink tank is replaced, the sub-ink tank will be filled with ink.

During this time, is displayed above the ink level.
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I When to Replace Ink Tanks

Replace or prepare to replace ink tanks in the following situations.

« If ink confirmation message appears on touch screen

If ink is low, the Status lamp lights orange and a notification message will appear on the touch screen.
You can continue to print, but prepare the ink tanks.

= Checking Ink Tank Levels

» Before print jobs and maintenance that consume a lot of ink

If little ink is left, there may not be enough for large-format printing, head cleaning, and maintenance,
which require a lot of ink. Replace or prepare to replace the ink tanks in the following situations.

= Checking Ink Tank Levels

* If message for ink replacement appears on touch screen

When the ink runs out, the Status lamp flashes orange, a message regarding ink tanks replacement
appears on the touch screen, and printing is disabled. Replace the ink tank.

= Replacing Ink Tanks
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I Print Head

» Print Head
» Checking for Nozzle Clogging
» Cleaning the Print Head

» Replacing the Print Head
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I Print Head

When purchasing, check the Model number.

Model number: PF-07

»>» Note

+ For instructions on replacing the print head, see Replacing the Print Head.
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I Checking for Nozzle Clogging

If printing is faint or affected by banding in different colors, make sure the print head nozzles are clear by
printing a test pattern to check the nozzles.

32 Important

* When using cut sheets, do not move the release lever until instructions (guidance) for removing the
paper are displayed.

Moving the release lever during printing or maintenance operations will cause the printer to stop.

2> Note
» By default, nozzles are checked at fixed intervals.

= Auto maintenance settings

Paper to Prepare

When using rolls
An unused roll at least 10.00 in. (254.0 mm) wide

When using sheets
1 sheet of unused paper of at least Ad/Letter size

1. Load paper.

= | oading Rolls in the Printer
= | oading Sheets in the Printer

2. Tap Q (Setup) > Maintenance on HOME screen.

= Home Screen Menu Composition

The Maintenance screen appears.

3. Tap Nozzle Check.

A confirmation message appears.

4. Tap Yes.

The printer now prints a test pattern for checking the nozzles.

5. Check the printing results.

If the horizontal lines are not faint or incomplete, the nozzles are clear.

=1
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f some sections of the horizontal lines are faint or incomplete, the nozzles for those colors are clogged.

] AT
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If horizontal lines are faint or incomplete, execute print head cleaning.

I
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= Cleaning the Print Head
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I Cleaning the Print Head

If printing is faint, cleaning the print head may improve results.

Choose one of three print head cleaning modes (Cleaning, Deep Cleaning, or System Cleaning),
depending on the problem to resolve.

» Cleaning

Use this mode if printing is faint or contains foreign substances. This method of cleaning consumes the
least amount of ink.

It takes about 2 to 3 minutes.

* Deep Cleaning
Use this mode if no ink is ejected at all or if Cleaning does not solve the problem.
It takes about 3 minutes.

» System Cleaning

Use this mode if printing is not improved after Deep Cleaning. System Cleaning consumes a very
large amount of ink. Performing this frequently consumes the ink faster. Perform this only when needed.

It takes about 4 minutes.

22 Important

» Do not remove the maintenance cartridge or ink tanks during Cleaning, Deep Cleaning, or System
Cleaning.

Ink may leak or an error may occur.

+ If printing is not improved after System Cleaning, the print head may be at the end of its service life.
Contact your Canon dealer for assistance.

* When using cut sheets, do not move the release lever until instructions (guidance) for removing the
paper are displayed.

Moving the release lever during printing or maintenance operations will cause the printer to stop.

»» Note

* Check the nozzle check pattern and select an ink group for which to perform cleaning as needed. You
can clean all print head or select the pattern below to clean the print head with a clogged nozzle.
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* By default, nozzles are checked at fixed intervals.

= Auto maintenance settings

Perform cleaning as follows.

1. Tap Q (Setup) > Maintenance on HOME screen.

= Home Screen Menu Composition

The Maintenance screen appears.
2. Tap Print Head Cleaning.
3. Tap Cleaning, Deep Cleaning, or System Cleaning.

4. Tap ink group to be cleaned.

 All colors
* Pattern 1: MBK / BK/ FP
* Pattern2: Y/M/C

A confirmation message appears.

5. Tap Yes.

Head cleaning is now executed.

6. Print a test pattern to check the nozzles and determine whether cleaning has cleared the
nozzles.

= Checking for Nozzle Clogging
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I Replacing the Print Head

If the touch screen indicates to replace the print head or if instructed to do so by your Canon dealer, replace
the print head.

I Compatible Print Head

For details on compatible print head, see Print Head.

I Precautions When Handling Print Head

Take the following precautions when handling the print head.

A\ Caution

» For safety, keep print head out of the reach of children.

« Ifink is accidentally ingested, contact a physician immediately.

» Do not touch the print head immediately after printing. The print head becomes extremely hot, and
there is a risk of burns.

3% Important

» There may be ink around the nozzles of the print head you remove. Handle the print head carefully
during replacement. The ink may stain clothing.

» Do not open the print head pouch until immediately before installation. After removing the print head
from the pouch, install it right away. If the print head is left as is after the pouch is opened, the
nozzles may dry out, which may affect printing quality.

I How to Replace Print Head

A\ Caution

* When replacing the print head immediately after printing, wait a few minutes before replacing it. The
metal parts of the print head become hot during printing, and there is a risk of burns from touching
these parts.

32 Important

* Your hands may become dirty during print head replacement. Use the gloves provided in the box with
the new print head for replacement.

»>» Note

* Prepare a new ink tank when ink levels are low.

* Prepare a new maintenance cartridge when the remaining capacity of the maintenance cartridge is
low.

1. Tap O (Setup) > Maintenance on HOME screen.

= Home Screen Menu Composition
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The Maintenance screen appears.
2. Tap Head Replacement.

3. Tap Start head replacement.

Ink begins being drawn in. When it finishes, instructions for the print head replacement procedure
appear on the touch screen.

It takes about 1 to 2 minutes for ink to be drawn into the system and remove ink from the print head.

4. Open top cover.

5. If the print head locking cover and print head lock lever are dirty, use a damp cloth that
you have wrung out completely to wipe them clean.

32 Important

» Do not touch the linear scale (A) or carriage shaft (B). Touching these may cause malfunction.
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» Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so
as not to scratch the surface.

6. Pull down print head lock lever toward the front while holding its center (C) with your
fingertip.

7. Grab grip (D) and open print head locking cover.
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22 Important

» Never touch the metal contacts of the carriage. Furthermore, do not allow any dirt or debris to
become adhered to the metal contacts of the carriage. These may damage the printer.

22> Note

+ Dispose of the used print head in accordance with local regulations.

9. Take new print head out of its pouch by grabbing grips (E).
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10. Remove orange protective caps (F, G).

Grab grip (H) to remove protective cap (G).

22 Important

» Always carry the print head by holding its right and left grips. Never touch nozzle (1) or metal
contacts (J). This may damage the print head and affect printing quality.
* Never touch the ink holes (K). This may affect printing quality.
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» The inside surface of the protective cap is coated with ink to protect the nozzle. Be careful not
to touch these surfaces when removing the caps.

» The print head contains ink to protect the nozzle. We recommend removing the protective cap
while holding it over the pouch that contained the print head or otherwise safely out of the way
to avoid spilling ink and staining your clothes or the surrounding area. If ink accidentally spills,
wipe off the ink with a dry cloth.

« If you need to put a print head somewhere temporarily before installation, do not set it down
with the nozzles and metal contacts facing down. If the nozzles or metal contacts are damaged,
it may affect the printing quality.

» Do not reattach the removed protective part. Dispose of these materials in accordance with
local regulations.

11. Turn ink holes (K) toward the front and insert print head into carriage.

Insert the print head all the way into the carriage, while taking care to keep parts that were protected
by the protective caps from touching the carriage.

12. Grasp tab (D) of print head locking cover and lower it to front to lock print head.
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15. Close top cover.
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Ink now fills the print head. It takes about 10 minutes.

22 Important

* While ink is being filled, definitely do not remove the ink tank or maintenance cartridge. Ink may
leak out.

2> Note
* Print head position adjustment is executed when Print pattern after new head is set to ON.
Follow the instructions on the touch screen to load paper.

= Auto maintenance settings
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I Maintenance Cartridge

» Maintenance Cartridge
» Replacing the Maintenance Cartridge
» Checking the Remaining Maintenance Cartridge Capacity

» When to Replace the Maintenance Cartridge
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I Maintenance Cartridge

When purchasing, check the Model number.

Model number: MC-31

»>» Note

* For instructions on replacing the maintenance cartridge, see Replacing the Maintenance Cartridge.
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I Replacing the Maintenance Cartridge

I Compatible Maintenance Cartridges

For details on compatible maintenance cartridge, see Maintenance Cartridge.

I Precautions When Handling Maintenance Cartridge
Take the following precautions when handling the maintenance cartridge.

A\ Caution

» For safety, keep maintenance cartridge out of the reach of children.
« Ifink is accidentally ingested, contact a physician immediately.

3% Important

* Do not remove the maintenance cartridge except to replace it. Ink may leak out.

» Do not remove a maintenance cartridge during initialization immediately after turning on the printer,
during print head cleaning, while ink is being drawn out, or during initialization immediately after
replacing the maintenance cartridge.

The maintenance cartridge may become damaged or ink may leak out.

» To prevent ink from leaking from a used maintenance cartridge, avoid dropping the cartridge or
storing it at an angle. Otherwise, ink may leak and cause stains.

* Ink adheres to the top of the maintenance cartridge after it has been used. Handle the maintenance
cartridge carefully during replacement. The ink may stain clothing.

I How to Replace a Maintenance Cartridge

If a message indicates you should replace a maintenance cartridge, check the message details and go to
step 4.

1. Tap a (Setup) > Maintenance on HOME screen.

= Home Screen Menu Composition

The Maintenance screen appears.

2. Tap Maintenance cartridge info.

The Maintenance cartridge info screen appears.

3. Tap Replace.

Instructions for the maintenance cartridge replacement procedure appear on the touch screen.

4. Open box, and remove plastic bag and maintenance cartridge.
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3% Important

» Never touch the metal contacts (A). This may damage the maintenance cartridge.

-

6. Hold the used maintenance cartridge by the grip (B) with one hand and put your other
hand under the maintenance cartridge to hold it firmly on the bottom, keeping it level as
you pull it out.
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22 Important

» A used maintenance cartridge is heavy. Always grasp the cartridge firmly and keep the
cartridge level during removal. If you drop a used maintenance cartridge or store it at an angle,
ink may leak and cause stains.

7. Put used maintenance cartridge in supplied plastic bag and store on flat surface.

8. Check the top and bottom of the maintenance cartridge, place in the box, and store the
box on a flat surface.

32 Important

» Always put the used maintenance cartridge back in the box and store the box on a flat surface.

23> Note

« Dispose of the used maintenance cartridge in accordance with local regulations.

9. Wipe away any soiling on the maintenance cartridge cover.
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22 Important

» Support the maintenance cartridge cover from underneath as you wipe it.

10. Keeping the new maintenance cartridge level, insert it all the way in.

The maintenance cartridge is initialized.

22 Important

» Do not remove the maintenance cartridge during initialization immediately after replacing the
maintenance cartridge. The maintenance cartridge may become damaged.

11. Close maintenance cartridge cover.
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I Checking the Remaining Maintenance Cartridge Capacity

The maintenance cartridge absorbs excess ink from borderless printing and print head cleaning. You can
confirm the remaining capacity of the maintenance cartridge by checking the touch screen.

1. Tap Q (Setup) > Maintenance on HOME screen.

= Home Screen Menu Composition

The Maintenance screen appears.

2. Tap Maintenance cartridge info.

The Maintenance cartridge info screen appears.

Maintenance cartridge info

Maintenance cartridge usage

®

Replace

If the touch screen indicates to replace the maintenance cartridge, replace the maintenance cartridge.

If a message appears indicating to check the remaining capacity of the maintenance cartridge, or before
tasks that deplete much of the capacity such as head cleaning or preparations to move the printer, check
the remaining maintenance cartridge capacity and prepare a new maintenance cartridge as needed.

= Replacing the Maintenance Cartridge
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I When to Replace the Maintenance Cartridge

Replace or prepare to replace the maintenance cartridge in the following situations.

+ If maintenance cartridge confirmation message appears on touch screen

When the maintenance cartridge is almost used up, the Status lamp lights orange and a natification
message will appear on the touch screen. You can continue to print, but check the remaining
maintenance cartridge capacity and prepare to replace the maintenance cartridge with a new one.

= Checking the Remaining Maintenance Cartridge Capacity

* When the maintenance cartridge capacity is drastically depleted

Print head cleaning, print head replacement, and preparations to transfer the printer deplete much of
the maintenance cartridge capacity. (In particular, preparing to move the printer depletes a lot of the
capacity.)

Check the remaining maintenance cartridge capacity before this maintenance and replace the
maintenance cartridge if necessary.

= Checking the Remaining Maintenance Cartridge Capacity

* If message for maintenance cartridge replacement appears on touch screen

When the maintenance cartridge is used up, the Status lamp blinks orange, a message regarding
maintenance cartridge replacement appears on the touch screen, and printing is disabled. Replace the
maintenance cartridge with a new one.

= Replacing the Maintenance Cartridge
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I Cutter Blade

* Cutter Blade

» Replacing the Cutter Blade
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I Cutter Blade

When purchasing, check the Model number.

Model number: CT-08

»» Note

» For instructions on replacing the cutter blade, see Replacing the Cutter Blade.

332



I Replacing the Cutter Blade

I Compatible Cutter Blade

For details on compatible cutter blade, see Cutter Blade.

I How to Replace Cutter Blade
3% Important

» The cutter blade can not be replaced if there is paper in the moving range of the cutter. Remove the
paper.

1. Tap a (Setup) > Maintenance on HOME screen.

= Home Screen Menu Composition

The Maintenance screen appears.

2. Tap Replace cutter blade unit.

A confirmation message appears.

3. Tap Yes.

The carriage moves and after it stops moving, instructions for the cutter blade replacement procedure
appear on the touch screen.

4. If cutter blade is dirty, use damp cloth that you have wrung out completely to wipe it
clean.

32 Important

» Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so
as not to scratch the surface.

5. Turn hex screw with hex wrench until loose.
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6. Remove cutter blade while holding A.

/1 Caution

* Never touch any part other than A. This may stain your hands or cause injury. Additionally, this
may damage the printer.
» Do not disassemble the cutter blade. Touching the blade may cause injury.

22> Note

» Dispose of the used cutter blade in accordance with local regulations.

7. Install new cutter blade while aligning B to C and D to E.

8. Turn hex screw until securely fixed.
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»» Important

 After the cutter blade is secured, check that the cutter blade does not come off. If the cutter
blade comes off, this may damage the printer.

9. Tap Done.

10. Tap Yes.
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Performing Maintenance Functions from Your Computer
(Windows)

» Cleaning the Print Heads

» Printing a Nozzle Check Pattern
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I Cleaning the Print Heads

The print head cleaning function allows you to clear up clogged print head nozzle. Perform print head
cleaning if printing is faint or a specific color fails to print, even though there is enough ink.

The procedure for print head cleaning is as follows:

‘ J Print Head Cleaning

1. Open the printer driver setup window

2. Click Print Head Cleaning on the Utility tab

When the Print Head Cleaning dialog box opens, select the head cleaning to be performed from the
following:

Cleaning
Perform Cleaning if printing is faint or a specific color fails to print, even though there is enough
ink.

System Cleaning
System Cleaning is a more powerful cleaning function. Perform System Cleaning if there is no
improvement even after repeating Cleaning several times.

22 Important

» System Cleaning consumes an extremely large amount of ink.
Executing system cleaning frequently will rapidly deplete your printer's ink supply. Therefore,
execute system cleaning only when necessary.

3. Execute cleaning
Make sure that the printer is on and then click OK.

Print head cleaning starts.

»» Note

+ After Cleaning or System Cleaning is complete, perform Print Nozzle Check Pattern and check the
cleaning results.

I Related Topic

= Printing a Nozzle Check Pattern
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I Printing a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly by printing a
nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

‘ J Print Nozzle Check Pattern

1. Open the printer driver setup window

2. Load paper in the printer

3. Click Print Nozzle Check Pattern on the Utility tab

The Print Nozzle Check Pattern dialog box opens.

4. Select the paper source

Select the paper source from the displayed dialog box.

5. Print a nozzle check pattern

Make sure that the printer is on and click OK.
Printing of the nozzle check pattern begins.

Click OK when the confirmation message appears.

6. Check the print result

Check the print results.

(B)

(A) As long as the horizontal lines are in line, and not missing, the nozzle is working normally.
(B) Where the horizontal lines are not in line or are missing, the color nozzle is blocked.

»» Note

» From the nozzle check pattern printing results, if it becomes patchy or there are areas that
cannot be printed, use Print Head Cleaning to clean the print heads.
Once cleaning is complete, print the nozzle check pattern again and check the results.
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I Related Topic

= Cleaning the Print Heads
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I Cleaning the Printer

» Cleaning the Printer Exterior
» Cleaning Inside the Top Cover

» Cleaning the Print Head
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I Cleaning the Printer Exterior

Clean the printer regularly to maintain better printing quality and help prevent problems.

To ensure a comfortable working environment, clean the printer exterior about once a month.

1. Turn printer off.

= Turning the Printer On and Off

2. Unplug power cord from outlet.

A Caution

» Always turn off the printer and unplug the power cord before cleaning or maintenance.
Accidentally leaving the printer on poses a risk of injury if you touch moving parts inside the
printer.

3. Wring out soft cloth with water or watered-down neutral detergent, and use it to wipe off dirt.

Clean the printer exterior and the power cord plug.

/' Warning

* Never use flammable solvents such as alcohol, benzine, or thinner. If these substances come into
contact with electrical components inside the printer, there is a risk of fire or electrical shock.

22 Important

« If the output guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend
cleaning the output guide even if it does not appear dirty, because it may actually be covered with

paper dust.

= Cleaning Inside the Top Cover

» Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as

not to scratch the surface.
* When neutral detergent is used, be sure to wipe off the detergent with soft cloth with water.

4. After cleaning, dry with a soft dry cloth.

5. Plug power cord into outlet.
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I Cleaning Inside the Top Cover

Clean inside the top cover about once a month to maintain better printing quality and help prevent problems.

Also clean inside the top cover in the following situations to ensure optimal operation.

If the printed surface or the underside of paper is dirty after printing
When a roll paper runs out

After borderless printing

After printing on small paper

After printing on paper that generates a lot of cutting debris

After changing the roll paper

After printing on paper that generates a lot of paper dust

After printing on adhesive paper

3% Important

If the platen inside the top cover becomes dirty, it may soil the underside of paper. We recommend
cleaning the platen after borderless printing or printing on small paper.

If the output guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend
cleaning the output guide even if it does not appear dirty, because it may actually be covered with
paper dust.

Printing on adhesive paper may leave adhesive on the platen, paper retainer, or other parts. To prevent
paper jams, we recommend cleaning inside the top cover after printing.

Cleaning may not be performed if there is paper in the cleaning area. Remove the paper.

. Tap a (Setup) > Maintenance on HOME screen.

= Home Screen Menu Composition

The Maintenance screen appears.

. Tap Platen cleaning.

A confirmation message appears.

. Tap Yes.

The carriage moves and after it stops moving, instructions appear on the touch screen.

. Open top cover.
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5. If paper dust has accumulated in vacuum holes (A) on platen or in ink grooves (B), use
cleaning brush (C), provided with printer, to wipe it away.

B A c c

2% Important

* Do not touch the linear scale (D) or carriage shaft (E). Touching these may cause malfunction.

23> Note

« If the cleaning brush is dirty, rinse it in water.

6. Clean the inside of the top cover with a completely wrung out damp cloth.

Wipe away any ink residue and paper dust (debris from cutting) on entire platen (F), paper retainer (G),
ink grooves (H), and output guide (1), and so on.
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A Warning

» Never use flammable solvents such as alcohol, benzine, or thinner. If these substances come into
contact with electrical components inside the printer, there is a risk of fire or electrical shock.

3% Important

» Do not use a dry cloth to wipe inside the top cover. This may create a static charge, which may
attract dust and affect the printing quality.

* Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as
not to scratch the surface.

23> Note

* When cleaning between the platen and ejection guide, use a damp cloth that you have wrung out
completely to wipe over the output tray and along grooves.

2. Close top cover.
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I Other Maintenance

» Preparing to Transfer the Printer
» Reinstalling the Printer

» Firmware update
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I Preparing to Transfer the Printer

To protect the internal parts in transit, always follow these steps before transferring the printer to a new
location.

For details on installing printer after transfer, see Reinstalling the Printer.

22 Important

+ Avoid tilting the printer excessively in transit. This may cause ink in the printer to leak and cause stains.
* When you select Prepare to move, any registered web services will be canceled. After moving your
printer, set up your web services again.

= \\Neb service setup

»» Note

+ The maintenance cartridge replacement may be required when you execute the Prepare to
move menu. Prepare the maintenance cartridge in advance while referring below. The number
of maintenance cartridge required varies depending on the amount remaining in the maintenance
cartridge being used.

* If you can move the printer in a level state using casters or something similar, you do not need to
execute Prepare to move.
» Always follow the instructions of the service representative when preparing to transfer the printer.

The following lists transport restrictions by type of transport.

Move on the same floor

Usage Examples: Move indoors by carrying
— Transport and storage in low temperature environments: No
— Required maintenance cartridges: 1

Transport outdoors

Usage Examples: Transport by vehicle

— Transport and storage in low temperature environments: Yes
— Required maintenance cartridges: 1

I Preparing for Transportation

1. Remove the paper.
* Rolls

= Removing the Roll from the Printer

« Sheet

= Removing Sheets

2. If touch screen indicates to replace maintenance cartridge, replace maintenance
cartridge.
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= Replacing the Maintenance Cartridge

3. Tap Q (Setup) > Maintenance on HOME screen.

= Home Screen Menu Composition

The Maintenance screen appears.
4. Tap Prepare to move.

5. Tap Move on the same floor or Transport outdoors.

A confirmation message appears.

6. Tap Yes.

The printer is now prepared for transfer.

When the preparation is finished, a message prompting you to open the ink tank cover appears on the
touch screen.

22 Important

« If consumables must be replaced, a message appears on the touch screen, and preparation is
disabled. If the message appears, tap OK and contact your Canon dealer for assistance.

7. Open ink tank cover to remove all ink tanks.

= Replacing Ink Tanks

8. Push all ink tank lock levers closed until they click into place.

Py

9. Close ink tank cover.

Ink is now drawn into the maintenance cartridge.

A confirmation message will appear when the process is finished.
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32 Important

» Do not remove the maintenance cartridge except when the message indicating replacement is
displayed.

If you remove the maintenance cartridge while ink is being removed, the ink may leak out.
10. Press ON button and turn off printer.

I Packing Printer

1. Disconnect power cord and interface cable.

32 Important

« Turn off the printer before you unplug it. Unplugging the printer before it is off and moving it may
damage the printer. If you accidentally unplug the printer, plug it in again, reinstall the ink tanks,
and follow this procedure again.

2. Tape down printer covers to secure them, in the reverse order of tape removal during
installation.

3. Remove the stand by reversing the installation procedure, when it was attached to the
printer.

4. Disassemble and repackage the stand by following the installation procedure in reverse.

5. Repack roll holder, holder stopper, and printer in shipping materials, and then package
them in shipping box.

349



I Reinstalling the Printer

The basic workflow for reinstalling the printer is as follows.

For detailed instructions, see the Setup Guide.

I Assemble the stand (Option)

1. To use the optional stand, assemble the stand by referring to the Printer Stand Setup
Guide that was provided with the stand.

/I Caution

» The stand must be assembled by at least two people on a flat surface. Attempting assembly by
yourself poses a risk of injury or bending the Stand.

» When assembling the stand, lock all four of the casters. Attempting to move the stand when the
casters are locked poses a risk of injury or damage to the location site.

* When moving the stand, make sure that the basket does not graze the floor and that all four
of the casters are unlocked before moving the stand. Not doing so may damage the basket,
scratch the floor, or cause injuries.

I Install the printer

1. Mount the printer on the assembled stand and tighten the screws firmly.
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/I Caution

* Moving the printer requires at least three people. Be careful to avoid back strain and other
injuries.

» When moving the printer, firmly grasp the carrying grips. The printer may be unsteady if you
hold it at other positions, which poses a risk of injury from dropping the printer.
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» When placing the printer on the stand, lock all four of the casters of the stand. Attempting to
place the printer on the stand while the casters are not locked poses a risk of injury.

2. Remove tape and packaging material attached to the printer.

3. Connect the power cord to the power cord connector on the right side of the printer.
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4. Plug the power cord into the outlet.

5. Press ON button to turn on printer.

When "Install the printer here? Do not install the ink tanks yet." appears, tap Yes.

© @

—

6. When instructions for loading ink tank appear on operation panel, open ink tank cover
and load ink tank.

7. Loading Rolls on the roll holder

(See "Loading Rolls on the Roll Holder.")
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8. Load the Roll Media in the printer.

(See "Loading Rolls in the Printer.")

9. Install the software.
Note that the driver installation procedure varies depending on the type of connection.

(See "Installing the Printer Driver" (Windows).)

(See "Installing the Printer Driver" (macOS).)
22 Important

* When the printer is connected to a network (via TCP/IP), the printer's IP address may be
changed if you reinstall the printer.

In this case, be sure to reconfigure the printer's IP address.

* When you select Prepare to move, any registered web services will be canceled. After moving
your printer, set up your web services again.

= \Web service setup
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I Firmware update

22 Important

* When you use this function, make sure the printer is connected to the Internet.

» The administrator password is required to change settings if it is enabled for changing settings using the
operation panel.

I Using Operation Panel

&

1. Tap__ — [ (Setup) on HOME screen.

= Home Screen Menu Composition

2. Tap Printer settings.

3. Tap Firmware update.

If an administrator password is set, enter the password.
4. Tap Install update.

5. Tap Yes.
6. Confirm displayed message and tap Start update.

I Using Remote Ul

1. Start up Remote UL.

= Start up Remote Ul

2. Select Firmware update.

3. Select Install update.

4. Confirm displayed message and select Update.
2> Note

« If the firmware update is not complete, check the following and take an appropriate action.

— Check the network settings such as a wireless router.

— If Cannot connect to the server. is displayed on the touch screen, select OK and try again
after a while.
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I Specifications

» Specifications

» Print Area
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I Specifications

[

L 2R 2R 2B 2 2R B

Printer specifications

= GP-300/ GP-5300
= GP-200/ GP-5200

Printing performance
Memory and hard disk
Interface

Network Specifications
Operating Conditions
Ink

Paper

3% Important

» The following values may vary depending on the operating environment.

I Printer specifications

GP-300 / GP-5300

Power supply

100-240 V AC (50/60 Hz)

Power consumption

When printing: 74 W max. *1

In Sleep mode: 2.0 W max. *1

Standby (all ports connected): 2.1 W max.
When power is off: 0.3 W max. *2

*1 Wired LAN connection

*2 The printer uses a trace amount of power even when turned off. To stop all
power consumption, turn off the printer and unplug the power cord.

Operating environment

Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 10 to 80 % RH (with no condensation)

Dimensions (W x D x H)

Printer only:

Approx. 50.8 x 29.5 x 17.3 in. (1289 x 748 x 439 mm)
Printer and Stand SD-33 (when opening the basket):
Approx. 50.8 x 34.3 x 41.8 in. (1289 x 870 x 1060 mm)

Stand may not be provided depending on the region where the printer is
purchased.

Weight

Printer only (without print head and ink tanks):

Approx. 108 Ib (49 kg)

Printer and Stand SD-33 (without print head and ink tanks):
Approx. 128 Ib (59 kg)
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Space for installation (W x D x
H)

Printer only:

Approx. 66.5 x 53.5 x 29.1 in. (1689 x 1358 x 739 mm)
Printer and Stand SD-33 (when opening the basket):
Approx. 66.5 x 57.9 x 53.6 in. (1689 x 1470 x 1360 mm)

GP-200 / GP-5200

Power supply

100-240 V AC (50/60 Hz)

Power consumption

When printing: 71 W max. *1

In Sleep mode: 2.0 W max. *1

Standby (all ports connected): 2.1 W max.
When power is off: 0.3 W max. *2

*1 Wired LAN connection

*2 The printer uses a trace amount of power even when turned off. To stop all
power consumption, turn off the printer and unplug the power cord.

Operating environment

Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 10 to 80 % RH (with no condensation)

Dimensions (W x D x H)

Printer only:

Approx. 38.7 x 29.5 x 17.3 in. (982 x 748 x 439 mm)
Printer and Stand SD-24 (when opening the basket):
Approx. 38.7 x 34.3 x 41.8 in. (982 x 870 x 1060 mm)

Stand may not be provided depending on the region where the printer is
purchased.

Weight

Printer only (without print head and ink tanks):

Approx. 91 Ib (41 kg)

Printer and Stand SD-24 (without print head and ink tanks):
Approx. 110 Ib (50 kg)

Space for installation (W x D x
H)

Printer only:

Approx. 54.5 x 53.5 x 29.1 in. (1382 x 1358 x 739 mm)
Printer and Stand SD-24 (when opening the basket):
Approx. 54.5 x 57.9 x 53.6 in. (1382 x 1470 x 1360 mm)

I Printing performance

Print method

Bubblejet

Maximum resolution

2400 dpi (horizontally) * x 1200 dpi (vertically)

* Prints with a minimum 1/2400 inch dot pitch between ink droplets.

Print head

PF-07
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Number of nozzles

2560 nozzles per color

I Memory and hard disk

Memory

Physical memory 2GB

Hard disk capacity

500 GB

Personal mail boxes (Permanent storage area): 308 GB

Print job storage capacity

Common Box: 100 jobs

Personal Boxes: 100 jobs

I Interface

USB and the network can be used at the same time.

You cannot use Wi-Fi and wired LAN at the same time.

usB Hi-Speed USB *
* To use Hi-Speed USB, your computer must support Hi-Speed USB. Addition-
ally, the Hi-Speed USB interface is completely backward compatible with USB
1.1, so the printer can be connected even if the computer interface is USB 1.1.
USB memory USB flash drive
LAN Wired LAN: IEEE802.3ab (1000BASE-T) / IEEE802.3u (100BASE-TX) /
IEEE802.3 (10BASE-T)
Wi-Fi: IEEE802.11n / IEEE802.11g / IEEE802.11b

I Network Specifications

Communication protocol

SNMP, HTTP, TCP/IP (IPv4/IPv6), FTP

Wired LAN specifications

Compliance standards: IEEE802.3ab (1000BASE-T) / IEEE802.3u
(100BASE-TX) / IEEE802.3 (10BASE-T)

Transmission speed: 10 Mbps / 100 Mbps / 1000 Mbps (automatically selec-
ted)

Security:IEEE802.1X (EAP-TLS/EAP-TTLS/PEAP)

Wi-Fi specifications

Compliance standards: IEEE802.11n / IEEE802.11g / IEEE802.11b
Frequency range: 2.4 GHz

Channels: 1-11 or 1-13 *

* Varies by country and region.

Effective range: Indoors 164 feet/50 m *

* Varies according to environmental conditions.

Security:

WEP (64/128 bits)
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Setup:

WPA-PSK (TKIP/AES)
WPA2-PSK (TKIP/AES)

WPS (push button method/PIN code method)

Easy wireless connect

I Operating Conditions

If operating conditions of the operating system are high, follow those.

Windows

printer driver)

Compatible Operating System (Standard supplied [ Windows 10

Windows 8.1

Windows 7

Windows Server 2019
Windows Server 2016
Windows Server 2012 R2
Windows Server 2012
Windows Server 2008 R2

Use the latest Service Pack available.

Free hard disk space

20 GB or more

macOS

Compatible Operating System (Standard
supplied printer driver)

macOS High Sierra 10.13.6 - macOS Big Sur 11

Free hard disk space

20 GB or more

Other Supported OS

i0S, iPadOS, Android

Some functions may not be available with the supported OS.

* An Internet connection is required to use the Online Manual.
» To install the software while using Windows, you must have a CD-ROM drive or a network

connection.

* To install the software while using macOS, you must have a network connection.

| ink

For information on the ink the printer supports, see Ink Tanks.
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I Paper

For details on the compatible media types, see Paper Information List.

For details on the paper widths supported by the printer, see Paper Sizes.

For details about Print Area, see Print Area.
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I Print Area

A margin required by the printer is added with respect to the size of paper loaded in the printer. Except in
borderless printing, the actual printing area corresponds to the paper size minus the space for this margin.

»» Note

 Printable Area: The area that can be printed.
* For borderless printing with roll paper, the margin is 0 in. (0 mm).

= Printing without Edges Based on the Scenarios (Windows)
= Printing without Edges Based on the Scenarios (macOS)

* Recommended Print Area: We recommend printing within this area.
* To match the document size with the actual printing area, print on oversize paper with the required
margin added.

= Printing to Oversized Paper Sizes (Windows)
= Printing to Oversized Paper Sizes (macOS)

I Sheets

Printable Area:

A margin of 0.2 in. (3 mm) on top, 0.5 in. (12.7 mm) on bottom*, and 0.2 in. (3 mm) on left and right sides
is required.

Recommended Print Area:

A margin of 0.8 in. (20 mm) on top, 0.8 in. (20 mm) on bottom*, and 0.2 in. (3 mm) on left and right sides
is required.

* The bottom margin for cut sheet depends on an OS and applications.

v

A

r

B

A: Top Edge

B: Bottom Edge
C: Left Edge

D: Right Edge
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| Rolis

Printable Area:

A margin of 0.2 in. (3 mm) on top and bottom and 0.2 in. (3 mm) on left and right sides is required. For
borderless printing, the margins on top, bottom, left, and right are 0 in. (0 mm). For paper that supports
borderless printing, see Paper Information List.

Recommended Print Area:

A margin of 0.8 in. (20 mm) on top, 0.2 in. (3 mm) on bottom, and 0.2 in. (3 mm) on left and right sides is
required.

A

: )

A: Top Edge

B: Bottom Edge
C: Left Edge

D: Right Edge
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I Appendix

» Manuals and Their Contents
» Safety

» Online Manual

» Using This Online Manual

» Trademarks and Licenses
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I Manuals and Their Contents

Quick Guide Replacing paper, ink tanks, and print head.
Setup Guide Installing the printer and software.

ER)

Printer Stand Setup Guide

Assembling the stand.

e
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I Safety

» Safety Precautions
» Regulatory Information
>» WEEE (EU&EEA)

» When Repairing, Lending, or Disposing of the Printer
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I Safety Precautions

I Choosing a location

Never install the printer on an unstable or vibrating surface.

Do not install the printer in locations that are very humid or dusty, in direct sunlight, outdoors, or close
to a heating source.

To avoid the risk of fire or electric shocks, use the printer under the operating environment specified in
the Specifications.

Do not place the printer on a thick rug or carpet.

Do not place the printer with its back attached to the wall.

We recommend ensuring ample space for installation.

Do not install the printer near sources of strong electromagnetic fields, whether equipment that
generates such fields or places where such fields occur.

I Power Supply

Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the
power cord if necessary.

Never remove the plug by pulling on the cord.

Pulling the cord may damage the power cord, leading to possible fire or electrical shock.

Do not use an extension lead/cord.

I Working Around the Printer

Never put your hands or fingers in the printer while it is printing.

Firmly grasp the carrying grips on each side in the base. Holding the printer at other positions is
dangerous and cause injury and damage if the printer is dropped.

Use the following number of people to hold the printer when transporting the printer by carrying it. The
weight may cause pain such as back pain.

For the GP-300, GP-5300 : 3 people or more

For the GP-200, GP-5200 : 3 people or more

When using and transferring the printer, do not tilt it, stand it on its side, or turn it upside down. There
is a risk of the ink spilling.

When transferring the printer tilted, always perform the steps in "Preparing to Transfer the Printer" in

order to protect the internal structure.
Do not place any object on the printer. Especially do not place metal objects (paper clips, staples,
etc.) or containers of flammable solvents (alcohol, thinners, etc.) on top of the printer.

I Print Heads/Ink Tanks/Maintenance Cartridges

Keep ink tanks out of the reach of children. In case ink is accidentally licked or swallowed, rinse out
mouth or give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical
advice immediately.

367



In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with
skin, wash with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice
immediately.

Never touch the electrical contacts on a print head after printing.

The metal parts may be very hot and could cause burns.

Do not throw ink tanks and maintenance cartridges into fire.

Do not attempt to disassemble or modify the print head, ink tanks, and maintenance cartridges.

Avoid dropping or shaking print head, ink tanks, and maintenance cartridges.
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I Regulatory Information

I Users in the U.S.A.

FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10548/K10547 (Contains FCC Approved WLAN Module K30357)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

» Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.

Changes or modifications not expressly approved by the party responsible for compliance could void the
user's authority to operate equipment.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

The equipment complies with FCC radiation exposure limits for at uncontrolled equipment. This
equipment should be installed and operated with minimum distance at least 20cm between the radiator
and persons body (excluding extremities: hands, wrists, feet and ankles) and must not be colocated or
operated with any other antenna or transmitter.

Canon U.S.A., Inc.

One Canon Park
Melville, New York 11747
1-800-652-2666
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I Interference

Do not use the printer around medical equipment or other electronic devices. Signals from the printer may
interfere with the correct operation of these devices.
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| weee (EusEEA)

I Only for European Union and EEA (Norway, Iceland and Liechtenstein)

i9:¢

_ EURDPE ONLY

These symbols indicate that this product is not to be disposed of with your household waste, according
to the WEEE Directive (2012/19/EU), the Battery Directive (2006/66/EC) and/or national legislation
implementing those Directives. If a chemical symbol is printed beneath the symbol shown above,

in accordance with the Battery Directive, this indicates that a heavy metal (Hg = Mercury, Cd =
Cadmium, Pb = Lead) is present in this battery or accumulator at a concentration above an applicable
threshold specified in the Battery Directive. This product should be handed over to a designated
collection point, e.g., on an authorized one-for-one basis when you buy a new similar product or to an
authorized collection site for recycling waste electrical and electronic equipment (EEE) and batteries and
accumulators. Improper handling of this type of waste could have a possible impact on the environment
and human health due to potentially hazardous substances that are generally associated with EEE.
Your cooperation in the correct disposal of this product will contribute to the effective usage of natural
resources. For more information about the recycling of this product, please contact your local city
office, waste authority, approved scheme or your household waste disposal service or visit www.canon-
europe.com/weee, or www.canon-europe.com/battery.

Nur fur Europaische Union und EWR (Norwegen, Island und
Liechtenstein)

B X

_ EURDPE ONLY

Diese Symbole weisen darauf hin, dass dieses Produkt gemafl WEEE-Richtlinie (2012/19/EU; Richtlinie
Uber Elektro- und Elektronik-Altgerate), Batterien-Richtlinie (2006/66/EG) und nationalen Gesetzen

zur Umsetzung dieser Richtlinien nicht tber den Hausmdill entsorgt werden darf. Falls sich unter

dem oben abgebildeten Symbol ein chemisches Symbol befindet, bedeutet dies gemaf der Batterien-
Richtlinie, dass in dieser Batterie oder diesem Akkumulator ein Schwermetall (Hg = Quecksilber, Cd =
Cadmium, Pb = Blei) in einer Konzentration vorhanden ist, die Giber einem in der Batterien-Richtlinie
angegebenen Grenzwert liegt. Dieses Produkt muss bei einer dafiir vorgesehenen Sammelstelle
abgegeben werden. Dies kann z. B. durch Rickgabe beim Kauf eines neuen ahnlichen Produkts

oder durch Abgabe bei einer autorisierten Sammelstelle fur die Wiederaufbereitung von Elektro- und
Elektronik-Altgeraten sowie Batterien und Akkumulatoren geschehen. Der unsachgemafe Umgang

mit Altgeraten kann aufgrund potenziell gefahrlicher Stoffe, die generell mit Elektro- und Elektronik-
Altgeraten in Verbindung stehen, negative Auswirkungen auf die Umwelt und die menschliche Gesundheit
haben. Durch lhre Mitarbeit bei der umweltgerechten Entsorgung dieses Produkts tragen Sie zu einer
effektiven Nutzung naturlicher Ressourcen bei. Um weitere Informationen Uber die Wiederverwertung
dieses Produkts zu erhalten, wenden Sie sich an Ihre Stadtverwaltung, den 6ffentlich-rechtlichen
Entsorgungstrager, eine autorisierte Stelle fir die Entsorgung von Elektro- und Elektronik-Altgeraten
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oder I|hr drtliches Entsorgungsunternehmen oder besuchen Sie www.canon-europe.com/weee, oder
www.canon-europe.com/battery.

I Union Européenne, Norvége, Islande et Liechtenstein uniquement.

B X

_ EURDPE ONLY

Ces symboles indiquent que ce produit ne doit pas étre mis au rebut avec les ordures ménageéres, comme
le spécifient la Directive européenne DEEE (2012/19/UE), la Directive européenne relative a I'élimination
des piles et des accumulateurs usagés (2006/66/CE) et les lois en vigueur dans votre pays appliquant
ces directives. Si un symbole de toxicité chimique est imprimé sous le symbole illustré ci-dessus
conformément a la Directive relative aux piles et aux accumulateurs, il indique la présence d'un métal
lourd (Hg = mercure, Cd = cadmium, Pb = plomb) dans la pile ou I'accumulateur a une concentration
supérieure au seuil applicable spécifié par la Directive. Ce produit doit étre confié au distributeur a
chaque fois que vous achetez un produit neuf similaire, ou a un point de collecte mis en place par les
collectivités locales pour le recyclage des Déchets des Equipements Electriques et Electroniques (DEEE).
Le traitement inapproprié de ce type de déchet risque d'avoir des répercussions sur l'environnement

et la santé humaine, du fait de la présence de substances potentiellement dangereuses généralement
associées aux équipements électriques et électroniques. Votre entiere coopération dans le cadre de

la mise au rebut correcte de ce produit favorisera une meilleure utilisation des ressources naturelles.

Pour plus d'informations sur le recyclage de ce produit, contactez vos services municipaux, votre éco-
organisme ou les autorités locales compétentes, ou consultez le site www.canon-europe.com/weee, ou
www.canon-europe.com/battery.

Uitsluitend bestemd voor de Europese Unie en EER (Noorwegen,
IJsland en Liechtenstein)

i ¢

— EURDPE ONLY

Met deze symbolen wordt aangegeven dat dit product in overeenstemming met de AEEA-richtlijn
(2012/19/EU), de richtlijn 2006/66/EG betreffende batterijen en accu's en/of de plaatselijk geldende
wetgeving waarin deze richtlijnen zijn geimplementeerd, niet bij het normale huisvuil mag worden
weggegooid. Indien onder het hierboven getoonde symbool een chemisch symbool gedrukt staat, geeft
dit in overeenstemming met de richtlijn betreffende batterijen en accu's aan dat deze batterij of accu een
zwaar metaal bevat (Hg = kwik, Cd = cadmium, Pb = lood) waarvan de concentratie de toepasselijke
drempelwaarde in overeenstemming met de genoemde richtlijn overschrijdt. Dit product dient te worden
ingeleverd bij een hiervoor aangewezen inzamelpunt, bijv. door dit in te leveren bij een hiertoe erkend
verkooppunt bij aankoop van een gelijksoortig product, of bij een officiéle inzameldienst voor de recycling
van elektrische en elektronische apparatuur (EEA) en batterijen en accu's. Door de potentieel gevaarlijke
stoffen die gewoonlijk gepaard gaan met EEA, kan onjuiste verwerking van dit type afval mogelijk
nadelige gevolgen hebben voor het milieu en de menselijke gezondheid. Uw medewerking bij het op
juiste wijze weggooien van dit product draagt bij tot effectief gebruik van natuurlijke hulpbronnen. Voor
verdere informatie over recycling van dit product kunt u contact opnemen met uw plaatselijke gemeente,
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afvaldienst, officiéle dienst voor klein chemisch afval of afvalstortplaats, of kunt u terecht op www.canon-
europe.com/weee, of www.canon-europe.com/battery.

Sélo para la Unién Europea y el Area Econémica Europea (Noruega,
Islandia y Liechtenstein)

B X

_ EURDPE ONLY

Estos iconos indican que este producto no debe desecharse con los residuos domésticos de acuerdo
con la Directiva sobre RAEE (2012/19/UE) y la Directiva sobre Pilas y Acumuladores (2006/66/CE) y/o la
legislacion nacional. Si aparece un simbolo quimico bajo este icono, de acuerdo con la Directiva sobre
Pilas y Acumuladores, significa que la pila o el acumulador contiene metales pesados (Hg = Mercurio,
Cd = Cadmio, Pb = Plomo) en una concentracién superior al limite especificado en dicha directiva.

Este producto debera entregarse en un punto de recogida designado, por ejemplo, entregandolo en

el lugar de venta al adquirir un producto nuevo similar o en un centro autorizado para la recogida de
residuos de aparatos eléctricos y electrénicos (RAEE), baterias y acumuladores. La gestion incorrecta
de este tipo de residuos puede afectar al medio ambiente y a la salud humana debido a las sustancias
potencialmente nocivas que suelen contener estos aparatos. Su cooperacion en la correcta eliminacion
de este producto contribuira al correcto aprovechamiento de los recursos naturales. Los usuarios tienen
derecho a devolver pilas, acumuladores o baterias usados sin coste alguno. El precio de venta de pilas,
acumuladores y baterias incluye el coste de la gestion medioambiental de su desecho, y no es necesario
mostrar la cuantia de dicho coste en la informacion y la factura suministradas a los usuarios finales. Si
desea mas informacion sobre el reciclado de este producto, pédngase en contacto con su municipio, el
servicio o el organismo encargado de la gestion de residuos domésticos o visite www.canon-europe.com/
weee, 0 www.canon-europe.com/battery.

Només per a la Unié Europea i a I’Espai Economic Europeu (Noruega,
Islandia i Liechtenstein)

B H

_ EURDPE ONLY

Aquests simbols indican que aquest producte no s’ha de llengar amb les escombraries de la llar,

d’acord amb la RAEE (2012/19/UE), la Directiva relativa a piles i acumuladors (2006/66/CE) i la

legislacio nacional que implementi aquestes directives. Si al costat d’aquest simbol hi apareix imprés

un simbol quimic, segons especifica la Directiva relativa a piles i acumuladors, significa que la bateria o
I'acumulador conté un metall pesant (Hg = mercuri, Cd = cadmi, Pb = plom) en una concentracié superior
al limit aplicable especificat en la Directiva. Aquest producte s’hauria de lliurar en un dels punts de
recollida designats, com per exemple, intercanviant un per un en comprar un producte similar o lliurant-lo
en un lloc de recollida autoritzat per al reciclatge de residus d’aparells eléctrics i electronics (RAEE) i
piles i acumuladors. La manipulacié inadequada d’aquest tipus de residus podria tenir un impacte negatiu
en I'entorn i en la salut humana, a causa de les substancies potencialment perilloses que normalment
estan associades a I'RAEE. La vostra cooperacié a I’hora de rebutjar correctament aquest producte
contribuira a la utilitzacié efectiva dels recursos naturals. Els usuaris tenen dret a retornar les bateries o
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els acumuladors usats sense cap carrec. El preu de venda de les bateries i els acumuladors inclou el cost
de la gestié ambiental dels residus i no es necessari mostrar I'import d’aquest cost en aquest fullet o en la
factura que es lliuri a I'usuari final. Per a més informacié sobre el reciclatge d’aquest producte, contacteu
amb l'oficina municipal, les autoritats encarregades dels residus, el pla de residus homologat o el servei
de recollida d’escombraries domeéstiques de la vostra localitat o visiteu www.canon-europe.com/weee, 0
www.canon-europe.com/battery.

I Solo per Unione Europea e SEE (Norvegia, Islanda e Liechtenstein)

B X

_ EURDPE ONLY

Questi simboli indicano che il prodotto non puo essere smaltito con i rifiuti domestici, ai sensi della
Direttiva RAEE (2012/19/UE), della Direttiva sulle Batterie (2006/66/CE) e/o delle leggi nazionali che
attuano tali Direttive. Se sotto il simbolo indicato sopra é riportato un simbolo chimico, in osservanza
della Direttiva sulle batterie, tale simbolo indica la presenza di un metallo pesante (Hg = Mercurio, Cd
= Cadmio, Pb = Piombo) nella batteria o nell'accumulatore con un livello di concentrazione superiore

a una soglia applicabile specificata nella Direttiva sulle batterie. |l prodotto deve essere conferito a

un punto di raccolta designato, ad esempio il rivenditore in caso di acquisto di un nuovo prodotto

simile oppure un centro di raccolta autorizzato per il riciclaggio di rifiuti di apparecchiature elettriche

ed elettroniche (RAEE) nonché di batterie e accumulatori. Un trattamento improprio di questo tipo di
rifiuti pud avere conseguenze negative sull'ambiente e sulla salute umana a causa delle sostanze
potenzialmente nocive solitamente contenute in tali rifiuti. La collaborazione dell'utente per il corretto
smaltimento di questo prodotto contribuira a un utilizzo efficace delle risorse naturali ed evitera di
incorrere in sanzioni amministrative ai sensi dell'art. 255 e successivi del Decreto Legislativo n. 152/06.
Per ulteriori informazioni sul riciclaggio di questo prodotto, contattare le autorita locali, I'ente responsabile
della raccolta dei rifiuti, un rivenditore autorizzato o il servizio di raccolta dei rifiuti domestici, oppure
visitare il sito www.canon-europe.com/weee, 0 www.canon-europe.com/battery.

Apenas para a Unidao Europeia e AEE (Noruega, Islandia e
Liechtenstein)

i ¢

— EURDPE ONLY

Estes simbolos indicam que este produto ndo deve ser eliminado juntamente com o seu lixo doméstico,
segundo a Diretiva REEE de 2012/19/UE, a Diretiva de Baterias (2006/66/CE) e/ou a sua legislagao
nacional que transponha estas Diretivas. Se houver um simbolo quimico impresso como mostrado
abaixo, de acordo com a Diretiva de Baterias, isto indica que um metal pesado (Hg = Mercurio, Cd =
Cadmio, Pb = Chumbo) esta presente nesta pilha ou acumulador, numa concentragao acima de um limite
aplicavel especificado na Diretiva. Este produto deve ser entregue num ponto de recolha designado, por
exemplo num local autorizado de troca quando compra um equipamento novo idéntico, ou num local

de recolha autorizado para reciclar equipamento elétrico e eletronico (EEE) em fim de vida, bem como
pilhas e baterias. O tratamento inadequado deste tipo de residuos pode ter um impacto negativo no
ambiente e na saude humana, devido a substancias potencialmente perigosas que estdo associadas
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com equipamentos do tipo EEE. A sua cooperagao no tratamento correto deste produto ira contribuir
para a utilizagdo mais eficaz dos recursos naturais. Para obter mais informa¢des acerca de como
reciclar este produto, por favor contacte as suas autoridades locais responsaveis pela matéria, servigo
de recolha aprovado para pilhas e baterias ou servigo de recolha de residuos solidos domésticos da sua
municipalidade, ou visite www.canon-europe.com/weee, ou www.canon-europe.com/battery.

Gezlder kun i Europziske Union og EQS (Norge, Island og
Liechtenstein)

i ¢

— EURDPE ONLY

Disse symboler betyder, at produktet ikke ma bortskaffes sammen med dagrenovation i henhold til
WEEE-direktivet (2012/19/EU), batteridirektivet (2006/66/EF) og/eller den lokale lovgivning, som disse
direktiver er gennemfart i. Hvis der i overensstemmelse med batteridirektivet er trykt et kemisk symbol
under det symbol, der er vist ovenfor, betyder det, at batteriet eller akkumulatoren indeholder tungmetaller
(Hg = kviksglv, Cd = cadmium, Pb = bly) i en koncentration, som ligger over de graensevaerdier,

der er beskrevet i batteridirektivet. Produktet skal afleveres pa et godkendt indsamlingssted, f.eks. i
overensstemmelse med en godkendt én-til-én-procedure, nar du indkgber et nyt tilsvarende produkt,
eller pa et godkendt indsamlingssted for elektronikaffald samt for batterier og akkumulatorer. Forkert
handtering af denne type affald kan medfgre negative konsekvenser for miljget og menneskers

helbred pa grund af de potentielt sundhedsskadelige stoffer, der generelt kan forefindes i elektrisk og
elektronisk udstyr. Nar du foretager korrekt bortskaffelse af produktet, bidrager du til effektiv brug af
naturressourcerne. Kontakt din kommune, den lokale affaldsmyndighed, det lokale affaldsanlaeg, eller
bes@g www.canon-europe.com/weee, eller www.canon-europe.com/battery for at fa flere oplysninger om
genbrug af dette produkt.

Mévo yia Tnv EupwTraikn ‘Evwon kai Tov EOX (NopBnyia, loAavdia kai
AixrevoTaiv)

B H

_ EURDPE ONLY

AuTa T0 oUPBOAG UTTOBEIKVUOUV OTI QUTO TO TTPOIOV dEV TTPETTEI VA ATTOPPITITETAI JAdi JE T OIKIOKA
atoppiypara, cuuewva Pe Tnv Odnyia yia Ta ATTORANTa HAekTpIKOU Kal HAekTpovikoU EEoTTAIGOU
(AHHE) (2012/19/EE), Tnv Odnyia yia 1ig HAekTpIkéG ZTAAEG (2006/66/EK) ri/kail Tnv €BvVIKRA vouobeaia
TTOU €QapPOdel TIG Odnyieg ekeiveg. EGv kATTO10 XNUIKG 0UPBOAO ival TUTTwPEVO KATW aTTo TO OUPBOAO
TTOU QaiveTal TTapaTTdvw, ocUPewva pe Tnv Odnyia yia Tig HAekTpIKEG ZTAAEG, uTTOdNAWVEI OTI KGTTOI0 BapU
péTaAro (Hg = Ydpdapyupog, Cd = Kaduio, Pb = MOAUBS0G) uttdpyel oTnV UTratapia A Tov oUGOWPEUTA O€
OUYKEVTPWON PeyaAUTepn aTTd TO IoYUOV £TTiTTEdO TTOU KaBopietal atnv Odnyia yia TIg HAEKTPIKEG ZTHAEG.
AuUTO TO TTPOIGV TTPETTEI VA TTAPOBIOETAI 0€ KABOPIOUEVO ONPEI0 GUANOYAG, TT.X. O€ JIa €0UCIOdOTNUEVN
Baon avraAAayng 6Tav ayopddeTe €va vEO TTAPOUOIO TTPOIOV 1 O€ pIa e§ouaiodoTnuévn B€an cuAAoyig yia
TNV avakKUKAwoN Twv atmmoBAATWY NAEKTPIKOU Kal NAekTpovikoU e¢otTAiIopoU (HHE) kal Twv nAeKTPIKWV
oTNAWYV Kal ouoowPEUTWV. O akatdAANAOG XEIPIOPOG auToU Tou TUTTOU ATTORANTWY UTTOPEI va EXEl
apvNTIKO avTiKTUTTO OTO TTEPIBAAAOV Kal TNV UyEia Tou avBpwTTou, AGyw duvnTIKA ETTIKIVOUVWY OUCIWV
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TToU yevik@ ouvdéovtal pe Tov HHE. H cuvepyaaoia oag yia Tn cwaoTh atméppiyn autou Tou TTpoidvTog Ba
OUMBAAEI OTNV ATTOTEAECUATIKA XPON TWV QUOIKWY TTOpWV. INa TTEPIOCTOTEPES TTANPOPOPIEG OXETIKA E
AvaKUKAWGON auToU TOU TTPOIOVTOG, ETTIKOIVWVACTE PE TO TOTTIKO ypa@eio TNG TTOANG 0ag, TNV UTINPETia
ATTOPPIUPATWY, TO EYKEKPIYUEVO OXAMA A TNV UTTNPECIa atTéppIYnS OIKIOKWY ATTORANTWY I ETTIOKEPOEITE TN
d1eUBuvan www.canon-europe.com/weee rj www.canon-europe.com/battery.

Gjelder kun den europeiske union og E@S (Norge, Island og
Liechtenstein)

i ¢

— EURDPE ONLY

Disse symbolene indikerer at dette produktet ikke skal kastes sammen med husholdningsavfall, i

henhold til WEEE-direktivet (2012/19/EU), batteridirektivet (2006/66/EF) og/eller nasjonal lov som har
implementert disse direktivene. Hvis et kjemisk symbol vises under symbolet vist ovenfor, i samsvar

med batteridirektivet, indikerer dette at et tungmetall (Hg = kvikksglv, Cd = kadmium, Pb = bly) finnes

i batteriet eller akkumulatoren i en konsentrasjon over en gjeldende gvre grense som er spesifisert i
batteridirektivet. Produktet ma leveres til et dertil egnet innsamlingspunkt, det vil si pa en autorisert
en-til-en-basis nar en kjgper et nytt lignende produkt, eller til et autorisert innsamlingssted for resirkulering
av avfall fra elektrisk og elektronisk utstyr (EE-utstyr) og batterier og akkumulatorer. Feil handtering

av denne typen avfall kan veere miljg- og helseskadelig pa grunn av potensielt skadelige stoffer som

ofte brukes i EE-utstyr. Din innsats for korrekt avhending av produktet vil bidra til effektiv bruk av
naturressurser. Du kan fa mer informasjon om resirkulering av dette produktet ved a kontakte lokale
myndigheter, avfallsadministrasjonen, et godkjent program eller husholdningens renovasjonsselskap, eller
ga til www.canon-europe.com/weee, eller www.canon-europe.com/battery.

Vain Euroopan unionin seka ETA:n (Norja, Islanti ja Liechtenstein)
alueelle.

i ¢

— EURDPE ONLY

Nama tunnukset osoittavat, ettd sdhko- ja elektroniikkalaiteromua koskeva direktiivi (SER-direktiivi,
2012/19/EUV), paristoista ja akuista annettu direktiivi (2006/66/EY) seka kansallinen lainsaadanto kieltavat
tuotteen havittdmisen talousjatteen mukana. Jos ylla olevan symbolin alapuolelle on paristodirektiivin
mukaisesti painettu kemiallisen aineen tunnus, kyseinen paristo tai akku sisaltda raskasmetalleja (Hg

= elohopea, Cd = kadmium, Pb = lyijy) enemman kuin paristodirektiivin salliman maaran. Tuote on
vietava asianmukaiseen kerayspisteeseen, esimerkiksi kodinkoneliikkeeseen uutta vastaavaa tuotetta
ostettaessa tai viralliseen sahko- ja elektroniikkalaiteromun tai paristojen ja akkujen kerdyspisteeseen.
Sahko- ja elektroniikkalaiteromun virheellinen kasittely voi vahingoittaa ymparista ja ihmisten terveytta,
koska laitteet saattavat sisaltda ymparistolle ja terveydelle haitallisia aineita. Tuotteen asianmukainen
havittdminen sdastda myos luonnonvaroja. Jos haluat lisatietoja tdman tuotteen kierratyksesta, ota
yhteys kunnan jatehuoltoviranomaisiin tai kayttamaasi jatehuoltoyhtiéon tai kay osoitteessa www.canon-
europe.com/weee, tai www.canon-europe.com/battery.
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Endast for Europeiska unionen och EES (Norge, Island och
Liechtenstein)

i9:¢

_ EURDPE ONLY

De har symbolerna visar att produkten inte far sorteras och slangas som hushallsavfall enligt WEEE-
direktivet (2012/19/EU), batteridirektivet (2006/66/EG) och/eller nationell lagstiftning som implementerar
dessa direktiv. Om en kemisk symbol férekommer under ovanstaende symbol innebar detta enligt
Batteridirektivet att en tungmetall (Hg = Kvicksilver, Cd = Kadmium, Pb = Bly) férekommer i batteriet
eller ackumulatorn med en koncentration som 6verstiger tillamplig grans som anges i Batteridirektivet.
Produkten ska lamnas in pa en avsedd insamlingsplats, t.ex. pa en atervinningsstation auktoriserad

att hantera elektrisk och elektronisk utrustning (EE-utrustning) samt batterier och ackumulatorer eller
hos handlare som ar auktoriserade att byta in varor da nya, motsvarande kops (en mot en). Olamplig
hantering av avfall av den har typen kan ha negativ inverkan pa miljén och manniskors halsa pa grund
av de potentiellt farliga &mnen som kan aterfinnas i elektrisk och elektronisk utrustning. Din medverkan
till en korrekt avfallshantering av produkten bidrar till effektiv anvandning av naturresurserna. Om du vill
ha mer information om var du kan Idamna in den har produkten, kontakta ditt lokala kommunkontor, berérd
myndighet eller foretag for avfallshantering eller se www.canon-europe.com/weee, eller www.canon-
europe.com/battery.

I Pouze Evropska unie a EHP (Norsko, Island a Lichtenstejnsko)

B X

_ EURDPE ONLY

Tento symbol znamena, Ze podle smérnice OEEZ (2012/19/EU), smérnice o bateriich (2006/66/ES) a/
nebo podle vnitrostatnich pravnich provadécich predpist k témto smérnicim nema byt tento vyrobek
likvidovan s odpadem z domacnosti. Je-li v souladu s poZadavky smérnice o bateriich vyti§t€na pod vySe
uvedenym symbolem chemicka znacka, udava, ze tato baterie nebo akumulator obsahuje tézké kovy (Hg
= rtut, Cd = kadmium, Pb = olovo) v koncentraci vy$si, nez je pfislusna hodnota pfedepsana smérnici.
Tento vyrobek ma byt vracen do ur€eného sbérného mista, napf. v ramci autorizovaného systému
odbéru jednoho vyrobku za jeden nové prodany podobny vyrobek, nebo do autorizovaného sbérného
mista pro recyklaci odpadnich elektrickych a elektronickych zafizeni (OEEZ), baterii a akumulatoru.
Nevhodné nakladani s timto druhem odpadu by mohlo mit negativni dopad na Zivotni prostfedi a

lidské zdravi, protoze elektricka a elektronicka zafizeni zpravidla obsahuji potencialné nebezpecné

latky. Vase spoluprace na spravné likvidaci tohoto vyrobku napomuze efektivnimu vyuzivani pfirodnich
zdrojl. Chcete-li ziskat podrobné informace tykajici se recyklace tohoto vyrobku, obratte se prosim

na mistni Ufad, organ pro nakladani s odpady, schvaleny systém nakladani s odpady &i spole&nost
zajistujici likvidaci domovniho odpadu, nebo navstivte webové stranky www.canon-europe.com/weee
nebo www.canon-europe.com/battery.
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Csak az Eurdpai Unio és az EGT (Norvégia, Izland és Liechtenstein)
orszagaiban

i9:¢

_ EURDPE ONLY

Ezek a szimbolumok azt jelzik, hogy a termék hulladékkezelése a haztartasi hulladéktdl kiilonvalasztva,
az elektromos és elektronikus berendezések hulladékairdl (WEEE) sz6l6 (2012/19/EU) iranyelvnek és az
elemekrél és akkumulatorokrol, valamint a hulladék elemekrél és akkumulatorokrél sz61é (2006/66/EK)
irdnyelvnek megfeleléen és/vagy ezen iranyelveknek megfelel§ helyi el6irdsok szerint torténik.
Amennyiben a fent feltlintetett szimbdlum alatt egy vegyijel is szerepel, az elemekrél és akkumulatorokrol
sz06l6 iranyelvben foglaltak értelmében ez azt jelzi, hogy az elem vagy az akkumulator az irdnyelvben
meghatarozott hatarértéknél nagyobb mennyiségben tartalmaz nehézfémet (Hg = higany, Cd = kadmium,
Pb = 6lom). E terméket az arra kijeldlt gyUjtéhelyre kell juttatni — pl. hasonl6 termék vaséarlasakor

a régi becserélésére vonatkozo hivatalos program keretében, vagy az elektromos és elektronikus
berendezések (EEE) hulladékainak gy(Ujtésére, valamint a hulladék elemek és hulladék akkumulatorok
gyUjtésére kijeldlt hivatalos gydjtéhelyre. Az ilyen jellegl hulladékok nem el6irasszer kezelése az
elektromos és elektronikus berendezésekhez (EEE) altalanosan kapcsolhaté potencialisan veszélyes
anyagok révén hatassal lehet a kérnyezetre és az egészségre. E termék megfeleld leselejtezésével

On is hozzajarul a természeti forrasok hatékony hasznalatahoz. A termék Ujrahasznositasat illetéen
informalddjon a helyi polgarmesteri hivatalnal, a helyi kozterulet-fenntarté vallalatnal, a hivatalos
hulladékleraké telephelyen vagy a haztartasi hulladék begyijtését végzd szolgaltaténal, illetve latogasson
el a www.canon-europe.com/weee, vagy www.canon-europe.com/battery internetes oldalra.

Tylko dla krajéow Unii Europejskiej oraz EOG (Norwegia, Islandia i
Liechtenstein)

i ¢

— EURDPE ONLY

Te symbole oznaczajg, ze produktu nie nalezy wyrzucaé¢ razem z odpadami gospodarstwa domowego,
zgodnie z dyrektywg WEEE w sprawie zuzytego sprzetu elektrycznego i elektronicznego (2012/19/UE)
lub dyrektywg w sprawie baterii (2006/66/WE) badz przepisami krajowymi wdrazajgcymi te dyrektywy.
Jesli pod powyzszym symbolem znajduje sie symbol chemiczny, zgodnie z dyrektywg w sprawie

baterii oznacza to, ze bateria lub akumulator zawiera metal ciezki (Hg = rte¢, Cd = kadm, Pb

= oftéw) w stezeniu przekraczajgcym odpowiedni poziom okreslony w dyrektywie w sprawie baterii.
Uzytkownicy baterii i akumulatoréw majg obowigzek korzysta¢ z dostepnego programu zwrotu, recyklingu
i utylizacji baterii oraz akumulatoréw. Niewtasciwe postepowanie z tego typu odpadami moze miec
wplyw na srodowisko i zdrowie ludzi ze wzgledu na substancje potencjalnie niebezpieczne, zwigzane

ze zuzytym sprzetem elektrycznym i elektronicznym. Pahstwa wspétpraca w zakresie wiasciwej utylizacji
tego produktu przyczyni sie do efektywnego wykorzystania zasobow naturalnych. W celu uzyskania
informacji o sposobie recyklingu tego produktu prosimy o kontakt z wkasciwym urzedem miejskim

lub zaktadem gospodarki komunalnej badz zapraszamy na strone www.canon-europe.com/weee, lub
www.canon-europe.com/battery.
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Plati len pre staty Eurépskej unie a EHP (Norsko, Island a
Lichtenstajnsko)

i9:¢

_ EURDPE ONLY

Tieto symboly oznacuju, ze podla Smernice o odpade z elektrickych a elektronickych zariadeni (OEEZ)
2012/19/EU, Smernice o batériach (2006/66/ES) a podla platnej legislativy Slovenskej republiky sa tento
produkt nesmie likvidovat spolu s komunalnym odpadom. Ak je chemicka znacka vytlatena pod vysSie
uvedenym symbolom, znamena to, Ze tato batéria alebo akumulator obsahuje tazky kov (Hg = ortut,

Cd = kadmium, Pb = olovo) v koncentracii vy$sej, ako je prislusna povolena hodnota stanovena v
Smernici o batériach. Produkt je potrebné odovzdat do urenej zberne, napr. prostrednictvom vymeny
za kupu nového podobného produktu, alebo na autorizované zberné miesto, ktoré spractuva odpad z
elektrickych a elektronickych zariadeni (EEZ), batérii a akumulatorov. Nespravna manipulacia s takymto
typom odpadu méze mat negativny vplyv na zivotné prostredie a ludské zdravie, pretoze elektrické

a elektronické zariadenia obsahuju potencialne nebezpelné latky. Spolupracou na spravnej likvidacii
tohto produktu prispejete k G¢innému vyuzivaniu prirodnych zdrojov. Dal$ie informacie o recyklacii tohto
produktu ziskate od miestneho Uradu, Uradu zivotného prostredia, zo schvaleného planu OEEZ alebo od
spolo¢nosti, ktora zaistuje likvidaciu komunalneho odpadu. Viac informacii najdete aj na webovej stranke:
www.canon-europe.com/weee, alebo www.canon-europe.com/battery.

I Uksnes Euroopa Liit ja EMP (Norra, Island ja Liechtenstein)

B X

_ EURDPE ONLY

Antud simbolid viitavad sellele, et vastavalt elektri- ja elektroonikaseadmete jaatmeid kasitlevale
direktiivile (2012/19/EL), patareisid ja akusid ning patarei- ja akujaatmeid kasitlevale direktiivile
(2006/66/EU) ja/vdi nimetatud direktiive rakendavatele riiklikele digusaktidele ei voi seda toodet koos
olmejaatmetega ara visata. Kui keemiline simbol on triikitud eespool toodud siimboli alla, siis tahendab
see, et antud patareis v0i akus leiduva raskemetalli (Hg = elavhdbe, Cd = kaadmium, Pb = plii)
kontsentratsioonitase on kdrgem kui patareisid ja akusid ning patarei- ja akujaatmeid kasitlevas
direktiivis satestatud piirmaar. Antud tootest tekkinud jdatmed tuleb anda vastavasse kogumispunkti,

nt mutgipunkti, mis on volitatud ks Uihe vastu vahetama, kui ostate uue sarnase toote, voi

vastavasse elektri- ja lektroonikaseadmete jddtmete ning patareide ja akude Umbertd6tlemiseks mdeldud
kogumispunkti. Antud liiki jaatmete vale kaitlemine vdib kahjustada keskkonda ja inimeste tervist elekitri-
ja elektroonikajaatmetes tavaliselt leiduvate potentsiaalselt ohtlike ainete tottu. Antud tootest tekkinud
jaatmete nduetekohase korvaldamisega aitate kasutada loodusvarasid efektiivselt. Taiendava teabe
saamiseks elektri- ja elektroonikaseadmetest tekkinud jaatmete ning patarei- ja akujaatmete tagastamise
ja imbert66tlemise kohta votke ihendust kohaliku omavalitsusega, asjakohase valitsusasutusega,
asjakohase tootjavastutusorganisatsiooniga voi olmejaatmete kaitlejaga. Lisateavet leitate ka Interneti-
lehekduljelt www.canon-europe.com/weee vbi www.canon-europe.com/battery.
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I Tikai Eiropas Savienibai un EEZ (Norvégijai, Islandei un Lihtensteinai)

i9:¢

_ EURDPE ONLY

Sie simboli norada, ka atbilstosi ES Direktivai (2012/19/ES) par elektrisko un elektronisko iekartu
atkritumiem (EEIA), Direktivai (2006/66/EK) par baterijam un akumulatoriem, un akumulatoru atkritumiem,
ar ko atcel Direktivu 91/157/EEK, un vietéjiem tiesibu aktiem So izstradajumu nedrikst izmest kopa

ar sadzives atkritumiem. Ja zem iepriek$ noradita simbola ir uzdrukats kimiskais simbols, saskana ar
direktivu par baterijam un akumulatoriem tas nozimé, ka Sis baterijas vai akumulatori satur smagos
metalus (Hg = dzivsudrabs, Cd = kadmijs, Pb = svins) un to koncentracijas limenis parsniedz direktiva
par baterijam un akumulatoriem minéto piemérojamo slieksni. Sis izstradajums ir janodod piemérota
savak3anas vieta, pieméram, apstiprinata veikala, kur iegadajaties l1dzigu jaunu produktu un atstajat
veco, vai apstiprinata vieta izlietotu elektrisko un elektronisko iekartu un bateriju un akumulatoru
parstradei. Nepareiza $ada veida atkritumu apsaimniekoSana var apdraudét vidi un cilvéka veselibu

tadu iesp&jami bistamu vielu dél, kas parasti ir elektriskajas un elektroniskajas iekartas. Jausu atbalsts
pareiza $ada veida atkritumu apsaimniekoSana sekmeés efektivu dabas resursu izmantoSanu. Lai sanemtu
pilnigaku informaciju par $ada veida izstradajumu nodosanu otrreizéjai parstradei, sazinieties ar vietéjo
pasvaldibu, atkritumu savak8anas atbildigo dienestu, pilnvaroto organizaciju vai iestadi, kas veic sadzives
atkritumu apsaimnieko8anu, vai apmeklgjiet timekla vietni www.canon-europe.com/weee, vai www.canon-
europe.com/battery.

I Tik Europos Sajungai ir EEE (Norvegijai, Islandijai ir Lichtensteinui)

B X

_ EURDPE ONLY

Sie simboliai reiskia, kad $io gaminio negalima i$mesti j buitines atliekas, kaip reikalaujama WEEE
Direktyvoje (2012/19/ES) ir Baterijy direktyvoje (2006/66/EB) ir (ar) jasy Salies nacionaliniuose
jstatymuose, kuriais 3ios Direktyvos yra jgyvendinamos. Jeigu cheminio Zenklo simbolis yra nurodytas
Zemiau Sio zenklo, tai reiskia, kad vadovaujantis Baterijy direktyva, baterijy ar akumuliatoriy sudétyje
yra sunkiyjy metaly (Hg = gyvsidabrio, Cd = kadmio, Pb = Svino), kuriy koncentracija virSija Baterijy
direktyvoje nurodytas leistinas ribas. Sj gaminj reikia pristatyti j specialyjj surinkimo punkta, pavyzdZiui,
mainais, kai jus perkate naujg panasy gaminj, arba j specialigjg surinkimo vietg, kurioje perdirbamos
elektrinés ir elektroninés jrangos atliekos bei naudotos baterijos ir akumuliatoriai. Dél netinkamo Sio
tipo atlieky tvarkymo gali nukentéti aplinka ir i8kilti grésmé Zmogaus sveikatai dél galimai kenksmingy
medziagy, i$ esmés susijusiy su elektrine ir elektronine jranga. Bendradarbiaudami ir teisingai
utilizuodami Siuos gaminius, jus padésite efektyviai naudoti gamtinius iSteklius. Daugiau informacijos
apie gaminio perdirbimg jums gali suteikti vietinis biuras, atlieky tvarkymo bendrové, sertifikuoti organai
ar buitiniy atlieky surinkimo jmonés. Taip pat siiloma apsilankyti interneto svetainéje www.canon-
europe.com/weee, arba www.canon-europe.com/battery.
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I Samo za Evropsko unijo in EGP (Norveska, Islandija in Lihtenstajn)

_ EURDPE ONLY

Ti simboli pomenijo, da tega izdelka skladno z Direktivo OEEO (2012/19/EU), Direktivo 2006/66/ES in/ali
nacionalno zakonodajo, ki uvaja ti direktivi, ne smete odlagati z nesortiranimi gospodinjskimi odpadki.
Ce je pod zgoraj prikazanim simbolom natisnjen kemijski simbol, to v skladu z Direktivo pomeni, da je

v tej bateriji ali akumulatorju prisotna teZka kovina (Hg = Zivo srebro, Cd = kadmij, Pb = svinec), in

sicer v koncentraciji, ki je nad relevantno mejno vrednostjo, dolo¢eno v Direktivi. Ta izdelek je potrebno
odnesti na izbrano zbirno mesto, t. j. pooblas€eno trgovino, kjer ob nakupu novega (podobnega) izdelka
vrnete starega, ali na pooblaséeno zbirno mesto za ponovno uporabo odpadne elektrine in elektronske
opreme (EEO) ter baterij in akumulatorjev. Neustrezno ravnanje s to vrsto odpadkov lahko negativno
vpliva na okolje in ¢lovesko zdravje zaradi potencialno nevarnih snovi, ki so pogosto povezane z EEO.
Vase sodelovanje pri pravilnem odlaganju tega izdelka predstavlja pomemben prispevek k smotrni izrabi
naravnih virov. Za ve¢ informacij o ponovni uporabi tega izdelka se obrnite na lokalen mestni urad,
pristojno sluzbo za odpadke, predstavnika pooblad€enega programa za obdelavo odpadkov ali na lokalno
komunalo. Lahko pa tudi obiS¢ete naSo spletno stran www.canon-europe.com/weee, ali www.canon-
europe.com/battery.

Camo 3a EBponewnckus cbuio3 un EUM (Hopserusa, Ucnanaua v
JNIuxTeHwanH)

_ EURDPE ONLY

Tes3un cumMBOMNM NokaseaT, Ye TO3M NPOAYKT He TpsiOBa Aa ce M3XBbpIsA 3aeHO ¢ OUTOBUTE OTNaabLM
cbrnacHo Aupektusata 3a MYEEO (2012/19/EC), OupektnBaTta 3a 6atepun (2006/66/EO) n/vwnn BawweTo
HaLUMWOHarnHo 3akoHo4aTeNncTBo, Npunarawlo Te3m dupektnen. AKo Noa nokasaHusi rope CUMBOJIT €
oTnevaTaH CMMBOJT 3@ XMMUYECKN eNeMEHT, CbrnacHo pasnopendute Ha [lupektueaTta 3a batepun,
TO31 BTOpY CMMBOJ1 O3HAa4YaBa HanNM4neTo Ha Texbk MeTan (Hg = xuBak, Cd = kagmuii, Pb = onoBo)

B 6aTepusTa Unm akymynaTopa B KOHUEHTpaUMs Had ykasaHaTa rpaHuua 3a CbOTBETHUSI eNEMEHT B
OvpekTuBata. To3n npodyKT TpssbBa Aa 6bae NpefadeH B NpefHasHayveH 3a LenTa NyHKT 3a cbovpaHe,
Hanpumep Ha 6a3a pa3msiHa, koraTo KyrnyBaTe HOB NogobeH NpoayKT, unun B ogobpeH cbbupaTeneH
NYHKT 32 peuuknmpaHe Ha n3nsasno ot ynotpeba enekTpuyecko n enekTpoHHo obopyasaHe (MYEEO),
OaTepumn n akymynatopu. HenpaeumnHOTO TpeTupaHe Ha To3M TUM oTNagbLUM MOXe fa gosene Ao
€BEeHTyalnHun oTpuULaTeNHN NOCNeaCcTBUS 3a OKOMNHaTa cpefa M YOBELLKOTO 34paBe Nopaau noTeHumnanHo
onacHuTe BeLlecTBa, KoMTo 0OUKHOBEHO ca cBbp3aHu ¢ EEO. B cbuioTo Bpeme BalweTo cbaencreune 3a
NPaBUINHOTO N3XBbPSIHE HA TO3M NPOAYKT LLe JoMNpuHece 3a e(heKTUBHOTO U3MON3BaHe Ha NPUPOaHUTE
pecypcu. 3a noeeye MHOpPMaLMA OTHOCHO TOBa Kbe MOXeTe [a npefaneTte 3a peumknmpaHe Ha

TO3M MPOAYKT, MO CBbPXKETE ce C BalumTe MecTHM BNacTu, C opraHa, OTTOBOPEH 3a OTnaabLuuTe, C
opobpeHaTa cuctema 3a MYEEO unu ¢ Bawarta mecTtHa cnyx6a 3a 6utoBm oTnagbuu, unu nocetete
Www.canon-europe.com/weee, nnm www.canon-europe.com/battery.
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Doar pentru Uniunea Europeana si EEA (Norvegia, Islanda si
Liechtenstein)

i9:¢

_ EURDPE ONLY

Aceste simboluri indica faptul ca acest produs nu trebuie aruncat impreuna cu deseurile menajere, in
conformitate cu Directiva DEEE (2012/19/UE), Directiva referitoare la baterii (2006/66/CE) si/sau legile
dvs. nationale ce implementeaza aceste Directive. Daca un simbol chimic este imprimat sub simbolul de
mai sus, in conformitate cu Directiva referitoare la baterii, acest simbol indica prezenta in baterie sau
acumulator a unui metal greu (Hg = Mercur, Cd = Cadmiu, Pb = Plumb) intr-o concentratie mai mare
decét pragul admis specificat in Directiva referitoare la baterii. Acest produs trebuie inménat punctului de
colectare adecvat, ex: printr-un schimb autorizat unu la unu atunci cand cumparati un produs nou similar
sau la un loc de colectare autorizat pentru reciclarea reziduurilor de echipament electric si electronic
(EEE) si baterii si acumulatori. Administrarea neadecvata a acestui tip de deseuri, ar putea avea un
impact asupra mediului si asupra sanatatii umane datorita substantelor cu potential de risc care sunt in
general asociate cu EEE. Cooperarea dvs. in directia reciclarii corecte a acestui produs va contribui la

o utilizare eficienta a resurselor naturale. Pentru mai multe informatji despre reciclarea acestui produs,
va rugam sa contactati biroul dvs. local, autoritatile responsabile cu deseurile, schema aprobata sau
serviciul dvs. responsabil cu deseurile menajere sau vizitati-ne la www.canon-europe.com/weee, sau
www.canon-europe.com/battery.

I Samo za Europsku uniju i EEA (Norveska, Island i Lihtenstajn)

i ¢

— EURDPE ONLY

Oznaka pokazuje da se ovaj proizvod ne smije odlagati s komunalnim i ostalim vrstama otpada, u skladu
s direktivom WEEE (2012/19/EC), Direktivom o baterijama (2006/66/EC) i Pravilnikom o gospodarenju
otpadnim baterijama i akumulatorima te Pravilnikom o gospodarenju otpadnim elektriénim i elektronic¢kim
uredajima i opremom. Ako je ispod prethodno prikazane oznake otisnut kemijski simbol, u skladu s
Direktivom o baterijama, to znaci da se u ovoj bateriji ili akumulatoru nalazi teski metal (Hg = ziva, Cd

= kadmij, Pb = olovo) i da je njegova koncentracija iznad razine propisane u Direktivi o baterijama. Ovaj
bi proizvod trebalo predati ovlaSenom skupljac¢u EE otpada ili prodavatelju koji je duzan preuzeti otpadni
proizvod po sistemu jedan za jedan, ukoliko isti odgovara vrsti te je obavljao primarne funkcije kao i
isporuc¢ena EE oprema. Otpadne baterije i akumulatori predaju se ovlastenom skupljacu otpadnih baterija
ili akumulatora ili prodavatelju bez naknade i obveze kupnje za krajnjeg korisnika. Neodgovarajuce
rukovanje ovom vrstom otpada moze utjecati na okoli$ i ljudsko zdravlje zbog potencijalno opasnih
supstanci koje se najéeSée nalaze na takvim mjestima. Va3a suradnja u pravilnom zbrinjavanju ovog
proizvoda pridonijet ¢e djelotvornom iskoristavaniju prirodnih resursa. Dodatne informacije o recikliranju
ovog proizvoda zatrazite od svog lokalnog gradskog ureda, sluzbe za zbrinjavanje otpada, odobrenog
programa ili komunalne sluzbe za uklanjanje otpada ili pak na stranicama www.canon-europe.com/weee
ili www.canon-europe.com/battery.
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| Korisnici u Srbiji

i9:¢

_ EURDPE ONLY

Ovaj simbol oznacava da ovaj proizvod ne sme da se odlaze sa ostalim kuénim otpadom, u skladu sa
WEEE Direktivom (2012/19/EU), Direktivom o baterijama (2006/66/EC) i nacionalnim zakonima. Ukoliko
je ispod gore navedenog simbola odStampan hemijski simbol, u skladu sa Direktivom o baterijama, ovaj
simbol ozna€ava da su u ovoj bateriji ili akumulatoru prisutni teSki metali (Hg — Ziva, Cd — kadmijum, Pb -
olovo) u koncentracijama koje premasuju prihvatljivi prag naveden u Direktivi o baterijama. Ovaj proizvod
treba predati odredenom centru za prikupljanje, npr. po principu ,jedan-za-jedan® kada kupujete sli¢an
novi proizvod, ili ovla§éenom centru za prikupljanje za reciklazu istroSene elektrine i elektronske opreme
(EEE), baterija i akumulatora. Nepravilno rukovanje ovom vrstom otpada moZe imati negativne posledice
po zivotnu sredinu i ljudsko zdravlje usled potencijalno opasnih materijala koji se uglavhom vezuju za
EEE. Va3a saradnja na ispravnom odlaganju ovog proizvoda ¢e doprineti efikasnom koriS¢enju prirodnih
resursa. Vise informacija o tome kako mozete da reciklirate ovaj proizvod potrazite od lokalnih gradskih
vlasti, komunalne sluZbe, odobrenog plana reciklaZe ili servisa za odlaganje ku¢nog otpada, ili posetite
stranicu www.canon-europe.com/weee, ili www.canon-europe.com/battery.
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I When Repairing, Lending, or Disposing of the Printer

If you have entered personal data, passwords and/or other security settings on the printer, such information
may be stored in the printer.

When sending the printer for repair, lending or transferring the printer to another person, or disposing of the
printer, please be sure to follow the steps below in order to delete such information and prevent third parties
from accessing it.

= |nitializing Printer's Setting
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I Online Manual

This manual has been confirmed to be displayed on the following web browsers (latest version).

* Windows device
Microsoft Edge and Google Chrome

« macOS/iOS/iPadOS device
Safari

¢ Android device
Google Chrome

* Set your browser to allow cookies and enable JavaScript.

I Screenshots in This Manual

For Windows:
The screenshots used in this manual are taken with Windows 10.

For macOS:
The screenshots used in this manual are taken with macOS Catalina 10.15.
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I Enhanced Printing Options

» Printing from Your Computer (Windows)

= Printing with Easy Setup JBasics
Changing the Type of Paper

a Setting the Number of Copies and Printing Order

& Printing Photos and Business Documents
Printing By Setting Print Purpose
Edit in PosterArtist and Print

@ Changing the Print Quality and Correcting Image Data
Adjusting Color Balance
Setting the Print Quality Level (Custom)
Printing a Color Document in Monochrome

Specifying Color Correction

Optimal Photo Printing of Image Data
Adjusting Colors with the Printer Driver

Printing with ICC Profiles
Adjusting Brightness
Adjusting Contrast

Printing Using Detailed Setting Mode

Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Set a Custom Size Roll Width

Printing without Edges Based on the Scenarios

Printing without Margins to Match Paper Size
Printing without Margins to Match Roll Paper Width
Printing Full-Size without Margins

Three-sided Borderless Printing on Roll Paper
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@ Printing Hanging and Horizontal Banners (Large-Format Printing)
@ Printing by Dividing/Joining Documents

Inputting Multiple-file Documents into Free Layout plus

Lining Up and Printing Multiple Documents to Cut Sheets

Printing by Connecting Multiple Pages

Printing Multiple Pages All on One Page

Dividing and Printing Posters
@ Printing Document in Center of Paper
@ Printing by Saving Roll Paper

Saving Roll Paper by Rotating Document 90 Degrees

Saving Roll Paper by Eliminating Upper and Lower Margins on Document
& Switching the Paper Source to Match the Purpose
a Displaying the Print Results before Printing
a Link with PosterArtist to print with bright colors
a Specify Fluorescent Colors and Print
a Other Convenient Settings

Stamp Printing

Registering a Stamp
Setting a Page Size and Orientation
Registering a Frequently Used Printing Profile

Cutting Roll Paper after Printing
» Printing from Computer (macOS)
a Printing with Easy Setup #Basics
Changing the Type of Paper
a Setting the Number of Copies and Printing Order
@ Changing the Print Quality and Correcting Image Data

Adjusting Color Balance

Setting the Print Quality Level (Custom)
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Printing a Color Document in Monochrome
Specifying Color Correction
Optimal Photo Printing of Image Data
Adjusting Colors with the Printer Driver
Printing with ICC Profiles (Specifying an ICC Profile from the Application Software)

Printing with ICC Profiles (Specifying an ICC Profile from the Printer Driver)
Adjusting Brightness

Adjusting Contrast

Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Set a Custom Size Roll Width

Print Area

Printing without Edges Based on the Scenarios
Printing without Margins to Match Roll Paper Width

Printing Full-Size without Margins

Three-sided Borderless Printing on Roll Paper
Printing Hanging and Horizontal Banners (Large-Format Printing)
Printing by Dividing/Joining Documents

Lining Up and Printing Multiple Documents

Printing by Connecting Multiple Pages

Printing Multiple Pages All on One Page
Printing Document in Center of Paper
Printing by Saving Roll Paper
Saving Roll Paper by Rotating Document 90 Degrees

Saving Roll Paper by Eliminating Upper and Lower Margins on Document
Switching the Paper Source to Match the Purpose
Cutting Roll Paper after Printing

Specify Fluorescent Colors and Print
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a Printing Using AirPrint
Printing from Printer
& Printing Data Saved on USB Flash Drive
Printing from Smartphone/Tablet
@ Print Easily from a Smartphone or Tablet with Canon PRINT Inkjet/SELPHY
@ Printing from iOS Device (AirPrint)
Enlarging Copy with imageRUNNER ADVANCE

Using PIXMA/MAXIFY Cloud Link
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I Printing from Your Computer (Windows)

>

>

Printing with Easy Setup 7Basic

Setting the Number of Copies and Printing Order
Printing Photos and Business Documents

Changing the Print Quality and Correcting Image Data
Scaled Printing

Printing to Oversized Paper Sizes

Setting Paper Dimensions (Custom Size)

Set a Custom Size Roll Width

Printing without Edges Based on the Scenarios
Printing Hanging and Horizontal Banners (Large-Format Printing)
Printing by Dividing/Joining Documents

Printing Document in Center of Paper

Printing by Saving Roll Paper

Switching the Paper Source to Match the Purpose
Displaying the Print Results before Printing

Link with PosterArtist to print with bright colors
Specify Fluorescent Colors and Print

Other Convenient Settings
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I Printing with Easy Setup

This section describes the simple setting procedure so that you can carry out appropriate printing on this
printer.

I Printing with Easy Setup

1. Check that printer is turned on

2. Load paper on the printer

Set roll paper or cut paper to a printer.

3. Open the printer driver setup window

4. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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22 Important

« See "Paper Information List" for Canon authentic paper or Canon output check paper.

»» Note

+ Click Get Information... to display the Paper Information on Printer dialog box. The Paper
Information on Printer dialog box allows you to get the paper information from the printer and
to set the paper source and the media type on the printer driver.

» For instructions on changing the media type from the printer's operation panel, see "Changing
the Type of Paper."

5. Select print target
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From the pull-down menu, select Easy Settings, and then select the setting that matches your
purpose from the Print Target list.
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6. Select the print quality

For Print Quality, select High, Standard or Fast according to your purpose.
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3% Important
» The print quality settings that can be selected may differ depending on a printing profile.

7. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
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8. Select the paper source

For Paper Source, select the setting that matches your purpose.
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9. Select roll paper width
If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper

loaded in the printer.
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10. Complete the setup

Click OK.
When you print, the document is printed with settings that match your purpose.
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23> Note
« If the paper settings in the printer driver differ from the paper information registered on the printer, an
error message may appear on the printer's operation panel. You can execute Print, but you may not

obtain the correct printing result.
 Under initial settings, Print Priority in Advanced Settings is set to Poster/Photo (Fluorescent), so

your print data will be printed with bright colors overall.
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I Checking Printer Settings and Applying Settings to Printer Driver
1. Open printer driver setup window

2. Click Get Information... on Main tab

The Paper Information on Printer dialog box appears.

3. Select the paper source

From Paper Source, check the setting or select a new paper source.
The current printer settings appear in Media Type and Roll Paper Width.

4. Apply settings
To apply the printer settings to the printer driver, click OK.

»» Note

« If the media type and the output paper size are not set on the printer, OK will be grayed out and
cannot be clicked.

+ If communication with the printer is disabled, the Get Information... does not appear or printer
media information from the printer cannot be obtained.
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I Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:

1. Open the printer driver setup window

2. Specify the number of copies to be printed

For Copies on the Layout tab, specify the number of copies to be printed.
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3. Specify the print order

Check the Print from Last Page check box when you want to print from the last page in order, and

uncheck the check box when you want to print from the first page.

4. Complete the setup

Click OK.

When you execute print, the specified number of copies will be printed with the specified printing order.

22 Important

» When the application software that you used to create the document has the same function, specify
the settings on the printer driver. However, if the print results are not acceptable, specify the function
settings on the application software. When you specify the number of copies and the printing order with
both the application software and this printer driver, the number of copies may be multiplied numbers of

the two settings or the specified printing order may not be enabled.
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I Printing Photos and Business Documents

» Printing By Setting Print Purpose

» Edit in PosterArtist and Print
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I Printing By Setting Print Purpose

The print settings that are generally used frequently are pre-registered as print purposes. By using a print
purpose to print, you can print with settings that match the document.

The procedure for printing by using a print purpose is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select print setting mode

From the pull-down menu, select Easy Settings.
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4. Select print purpose
For Print Target, select the setting that matches the document.

Default Settings
Select this when printing general documents such as business documents.

Poster
Select this when printing posters.

Poster (Fluorescent)
Select this when you want to print the entire poster with bright colors.

Poster (Fluorescent Spot Color)
Select this when you want to specify the area of the poster to print with bright colors.

Photo (Color)
Select this when printing color illustrations or photos.

»» Note

» To check the settings of the items that are set by Print Target, click View Settings.

5. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source

For Paper Source, select the setting that matches your purpose.

7. Set the other items

Set the other items as necessary.
8. Complete the setup

Click OK.
When you print, the document is printed with settings to match the specified print purpose.
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I Edit in PosterArtist and Print

Word processing and spreadsheet software documents and web browser screens, etc. can be edited a print
from PosterAtrtist.

The following explains the procedure for editing original documents made in multiple application software in
PosterArtist and printing in a poster layout.

1. Open the printer driver setup window

2. Select edit in PosterArtist

Check Page Layout in the Layout tab and select Edit Using PosterArtist from the pull-down menu.
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»» Note

» Edit Using PosterArtist may not be available for use depending on the usage environment.

3. Start up PosterArtist

Click OK.
When printing is executed, PosterArtist starts up and PageCapture window opens.

4. Select page to get in PosterArtist

5. Edit page in PosterArtist

Image editing and sorting is implemented in PosterArtist.

By repeating steps 1 through 4 without closing the PosterArtist window, documents made in multiple
application software can be arranged on one page.

After editing is complete, please print from PosterArtist menu.
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»» Note

» For instructions on how to edit and rearrange images, refer to the PosterArtist manual.
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I Changing the Print Quality and Correcting Image Data

» Adjusting Color Balance

» Setting the Print Quality Level (Custom)

» Printing a Color Document in Monochrome
» Specifying Color Correction

» Adjusting Brightness

» Adjusting Contrast

¥

Printing Using Detailed Setting Mode
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I Adjusting Color Balance

You can adjust the color tints when printing.

Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software when you want to change the color
balance significantly. Use the printer driver only when you want to adjust the color balance slightly.

The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so
that the overall colors are more uniform.

No adjustment  Adjust color balance

The procedure for adjusting color balance is as follows:

1. Open the printer driver setup window

2. Select the advanced settings

Select Advanced Settings from the pull-down menu on the Main tab.

= Cance Prirfting Preferences 0

Man  Page Setp Layot Favedtes Lty

= I e = I
I Pert Prowey Posber/Pholo [ucnescant] o
— Prrt Gl Sderd -
promr—r— Aeschson 300dp
- Bﬂ]’l‘:uHEDl‘: Cnder M Coler =
Actual Size
Curslom Size
X
L] Frsorescnnt Spot Coler Sefirgs

—
I q
j [0 Thickoan Fine Lines

L]

] Prervrw befiore prrting
[0 Edt uermacert spek colors in Poaimivii

Satus Morder, Actoundieg... Defais

ok ] [ cones | [ e teb

3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.
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4. Adjust color balance

The Color Adjustment tab has individual sliders for Cyan, Magenta, and Yellow. Each color becomes
stronger when the corresponding slider is moved to the right, and becomes weaker when the
corresponding slider is moved to the left. For example, when cyan becomes weaker, the color red
becomes stronger.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the document is printed with the adjusted color balance.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Brightness

= Adjusting Contrast
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I Setting the Print Quality Level (Custom)

Custom on the Print Quality tab allows you to set detailed print quality levels.

The procedure for setting the print quality level is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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4. Setting the print quality level
Drag the slider bar to select the print quality level and click OK.

3% Important

» Certain print quality levels cannot be selected depending on the settings of Media Type.

5. Complete the setup
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Click OK on the Main tab.
When you execute print, the image data is printed with the selected print quality level.

I Related Topics

= Specifying Color Correction
= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast

407



I Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode
For Color Mode, select Monochrome.

»» Note

» The selectable Color Mode depends on the media type selected for Media Type on the Main tab.

4. Complete the setup

Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.
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3% Important

* When Monochrome is selected, the printer driver processes image data as sRGB data. In this case,
actual colors printed may differ from those in the original image data.

When using the grayscale printing function to print Adobe RGB data, convert the data to SRGB data
using an application software.

»» Note

* When Monochrome is selected, inks other than black ink may also be used.
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I Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, when data is printed, the printer driver automatically adjusts the colors.

When you want to print by using the color space of the image data effectively, select ICM or, ICC Profile
Matching. When you want to use an application software to specify a printing ICC profile, select Off.

The procedure for specifying color correction is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode
For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, select Color Correction setting that matches your purpose from the following, and
click OK.
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Driver Matching
Print with the optimal color using the printer driver's original color profile. Normally, you should
choose this mode.

ICC Profile Matching
Carry out color matching using the ICC profile. Specify the input profile, printer profile and matching
method in detail, and select when printing. You can use the digital camera or scanner ICC profile, or
the ICC profile created using the profile creation tool.

ICM
Perform color matching on the host computer using the Windows ICM function. Select when printing
from an ICM function-compatible application.

Off
Print without performing color matching on the printer driver. Select this when performing color
matching using applications such as Adobe Photoshop, or printing a color chart using a profile
creation tool.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

32 Important

» When ICM is disabled in the application software, ICM is unavailable for Color Correction and the
printer may not be able to print the image data properly.

I Related Topics

= Optimal Photo Printing of Image Data
= Adjusting Colors with the Printer Driver
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= Printing with ICC Profiles
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I Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ
from those of actual image or those displayed on the monitor.

To get the print results as close as possible to the desired color tones, you must select a printing method
that is best suited to the application software used or to your purpose.

I Color Management

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space.

For Windows, a color management system called "ICM" is built into the operating system.
sRGB is one of the common color spaces that is frequently used.

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and
carrying out color management, you can draw out the color space of the image data within the color
reproduction area that the printer can express.

»>» Note

* Normally, image files are saved in JPEG format. Some digital cameras allow you to save images in a
format called RAW. RAW data refers to an image saving format that requires a computer to develop
the image. You can embed an input ICC profile tag into a RAW file by using special application
software.

I Selecting a Printing Method Suited to the Image Data

The recommended printing method depends on the color space of the image data or the application
software to be used.

There are two typical printing methods.
Check the color space of the image data and the application software to be used, and then select the
printing method suited to your purpose.

Adjusting Colors with the Printer Driver

This section describes the procedure for printing data by using the color correction function of the
printer driver.

Select this function when you want to print impressions that are close to those displayed on the
monitor, for example, if you corrected the colors while checking the print image on the monitor.

Printing with ICC Profiles
Describes the procedure for printing by using the color space of the image data effectively.
You can print with a common color space by setting up the application software and the printer driver
so that the color management matches the input ICC profile of the image data.
The method for setting up the printer driver differs depending on the application software to be used.
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I Adjusting Colors with the Printer Driver

To use printer driver matching when printing, turn on the printer driver's color correction function. Printer
driver matching accurately applies the characteristics of data displayed on the monitor and allows you to
obtain print results of impressions that are close to those displayed on the monitor.

22 Important

» When printing using printer driver matching, Canon recommends that you set the monitor and the
environment light as follows:

— Monitor
Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2

— Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 Ix £ 125 Ix

»>» Note

* When printing from an application software that can identify ICC profiles and allows you to specify them,
use a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.

== Cancn Prirfting Preferences x

M Page Setup Lot Favedes Ly

Madia Typs .P'I.mPnper -

Cuslom Size

EITnx 160 - =

Cursiom Size Settra
EXTmx i1 B0 Eeler
[l Flusormpcart Spet Coler

[0l Thecken Fine Lines

] Frervorw baforn periing
] Bt Muwscnns spet colar in P

b Mordir, Aot Defimis

[ =

414



3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select Driver Matching for Color Correction.
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5. Select the rendering intent

Select the coloring adjustment method in Rendering Intent.

Perceptual (Photo)
Reproduces colors of general photos naturally and features smooth gradation. In addition, selecting
this setting allows you to adjust colors easily using an application software.

Saturation (Poster)
Reproduces vivid colors on data such as a poster.

6. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

7. Complete the setup

Click OK on the Main tab.
When you print, the colors get adjusted by the printer driver when printing the data.

I Related Topics

= Setting the Print Quality Level (Custom)
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= Specifying Color Correction
= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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| Printing with IcC Profiles

When the image data has a specified input ICC profile, you can print by using the color space of the data
effectively.

The printer driver setting procedure varies depending on the application software used to print.

I Specify an ICC Profile from the Application Software and Print the Data

When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,
or any application software that allows you to specify input and printing ICC profiles, you print by
effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify
an input ICC profile and a printing ICC profile in the image data.

Even if you print using a printing ICC profile that you created yourself, be sure to select color management
items from your application software.

For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select Off for Color Correction.
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Color Settings
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5. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

6. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

I Specify an ICC Profile with the Printer Driver, and then Print

When you print from application software that cannot identity input ICC profiles or does not allow you to
specify one, the data color space is printed as sRGB.

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Select color correction

Click Matching tab, and select ICC Profile Matching for Color Correction.
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5. Select input profile

Select the Input Profile you want to use.
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32 Important

» When the application software specifies an input profile, the input profile setting of the printer
driver becomes invalid.

6. Select the printer profile
Select Printer Profile as follows:

» To set the printer profile automatically:
Select Auto Settings.

» To set the printer profile manually:
Select a printer profile that matches the media type to be used.

7. Select the rendering intent
Select the coloring adjustment method in Rendering Intent.

Perceptual
Reproduces colors of general photos naturally and features smooth gradation. In addition,
selecting this setting allows you to adjust colors easily using an application software.

22 Important

* When you select Perceptual to print images, Canon recommends that you set the monitor
and the environment light as follows:

— Monitor
Color temperature: D50 (5000K)
Brightness: 100 to 120cd/m2
Gamma: 2.2

— Environment light
Fluorescent light for D50 color evaluation (color temperature 5000K, high color rendering
properties)
Brightness when looking at printed materials: 500 Ix £ 125 Ix

Saturation
Reproduces vivid colors on data such as a poster.

Relative Colorimetric
When image data is converted to the color space of the printer, this method converts the image
data so the color reproduction approximates the shared color regions. Select this method to print
image data with colors that are close to the original colors.

Absolute Colorimetric
When Relative Colorimetric is selected, white spots are reproduced as white spots of the paper
(background color). However, when Absolute Colorimetric is selected, how the white spots are
reproduced depends on the image data.

3% Important
» Depending on the media type, you may obtain the same print results even when you change

the Rendering Intent setting.

8. Set the other items
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If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, and Contrast settings, and then click OK.

9. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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I Adjusting Brightness

You can brighten or darken the colors of the overall image data during printing.
The following sample shows the case when light colors are darkened when the image data is printed.

No adjustment Darken light colors

The procedure for adjusting brightness is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Adjust brightness

On the Color Adjustment tab, moving the Brightness slider to the right brightens (dilutes) the colors,
and moving the slider to the left darkens (intensifies) the colors.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed at the adjusted brightness.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Contrast
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I Adjusting Contrast

You can adjust the image contrast during printing.

To make the differences between the light and dark portions of images greater and more distinct, increase
the contrast. On the other hand, to make the differences between the light and dark portions of images
smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:

1. Open the printer driver setup window

2. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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3. Select color mode

For Color Mode, select Color, and then click Color Settings....
The Color Settings dialog box appears.

4. Adjust the contrast

On the Color Adjustment tab, moving the Contrast slider to the right increases the contrast, and
moving the slider to the left decreases the contrast.
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You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

I Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness
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| Printing Using Detailed Setting Mode

You can print by using your own settings instead of the pre-registered Print Target settings.

The procedure for using the detailed setting mode and printing is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select advanced settings

From the Main tab pull-down menu, select Advanced Settings.
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4. Set print conditions
Set the following items as necessary.

Print Priority
Select elements to prioritize for print results.
If you select Poster/Photo (Fluorescent), posters and other material will be printed with bright
colors.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

Fluorescent Spot Color
Check this check box if you want to print with fluorescent ink.

Color Mode
Selects color adjustment method.

Thicken Fine Lines
To make thin lines thicker and easier to see when printing, add a checkmark.

5. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
The current settings are displayed in the settings preview on the left side of the window.
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6. Select the paper source

For Paper Source, select the setting that matches your purpose.

7. Set the other items

Set the other items as necessary.
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8. Complete the setup

Click OK.
When you print, the document is printed with the print conditions you set.

I Related Topics

Adjusting Color Balance

Setting the Print Quality Level (Custom)
Specifying Color Correction

Adjusting Brightness

Adjusting Contrast

Specify Fluorescent Colors and Print

(=Y
(=Y
(=Y
(=Y
(=Y
(=Y
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I Scaled Printing

The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the printer driver setup window

2. Select the paper size of the document

Using Page Size on the Page Setup tab, select the page size that is set with your application software.

3. Select the paper source

For Paper Source, select the setting that matches your purpose.

4. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper loaded
in the printer.

5. Select scaled printing

Check the Enlarged/Reduced Printing check box.
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6. Set one of scaling methods described below

From the items listed below, select the setting that matches your purpose and select the corresponding
check box.
The current settings are displayed in the settings preview on the left side of the window.

* Fit Paper Size
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Scales the document to match the paper size.
* Fit Roll Paper Width

s
I
L s ol

Scales the document to match the roll paper width.
* Scaling

80%

e

—

Allows you to specify the scaling by entering a number directly or by selecting the paper size you
want from the Printer Paper Size list.

The document is reduced when a size smaller than the Page Size setting is selected from the
Printer Paper Size list, and enlarged when a size larger is selected.

7. Complete the setup
Click OK.

When you execute print, the document will be printed with the specified scale.

32 Important

* When the application software which you used to create the original has the scaled printing function,
configure the settings on your application software. You do not need to configure the same setting in
the printer driver.
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»» Note

+ Selecting Enlarged/Reduced Printing changes the printable area of the document.
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I Printing to Oversized Paper Sizes

When printing a created document so that it fills the entire paper width, select a paper size from the
Oversize list (sizes resulting from adding margins necessary for printer operation to the document sizes) so
that all areas of the document are printed at their actual size.

A printout that has the same area as the document can be obtained by trimming the outer margins after
printing.

The procedure for printing with oversize is as follows:

1. Open the printer driver setup window

2. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.

3. Click Size Options...
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The Paper Size Options dialog box opens.

4. Select oversize

Select the Oversize check box, and click OK.
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The current settings are displayed in the settings preview on the left side of the Page Setup tab.

5. Select the paper source

For Paper Source, select the setting that matches your purpose.

6. Select roll paper width

If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper
loaded in the printer.

7. Set the other items

Set the other items as necessary.

8. Complete the setup

Click OK.
When you print, the document is printed using oversize.

32 Important

» When printing to oversized paper sizes, use paper that has the following necessary margins added to
the document size.
— Cut sheet: 6 mm or more added to width and 23 mm or more added to height of document size
— Roll paper: 6 mm or more added to width and 6 mm or more added to height of document size

> Note

» An oversized paper size cannot be used for the largest paper size that can be loaded in the printer.

» To set an oversized paper size for a non-standard paper size, register the paper size in the Paper
Size Options dialog box. An oversized paper size cannot be set for paper sizes that were set in the
Custom Size Settings dialog box.
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I Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a
paper size is called "custom size."

There are two ways of setting a user-defined paper, setting the paper from Size Options... on the Page
Setup tab and setting the paper from Custom Size of Page Size.

If you will be using a user-defined paper repeatedly, setting it from Size Options... is convenient because it
becomes registered to Page Size and can be selected any time after that.

If you want to use a user-defined paper temporarily, setting it from Custom Size is suitable.

The procedure for specifying a custom size is as follows:

I Setting from Paper Size Options

1. Open the printer driver setup window

2. Click Size Options... on the Page Setup tab
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The Paper Size Options dialog box opens.

3. Set user-defined paper

Set Custom Paper Size Name, Units, and Size, and then click Add.
For Size, specify an size or select the paper size to be used from Paper Size List.
To narrow down the paper sizes displayed in Paper Size List, select the Display Series check box.
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»» Note

+ By selecting the Borderless Printing Size check box for Paper Size, you can select a size
from the paper sizes that support Borderless Printing. By selecting the Fix the Ratio of the
Width to Height check box, you can change the size while keeping the Width and Height ratio.

4. Set user-defined paper

Click OK, then it returns to Page Setup tab.
The paper size registered by using Custom Paper Size Name is registered to Custom Paper Size of
Page Size and can be selected at any time.

I Setting from Custom Size

1. Open the printer driver setup window

2. Select the paper size

For Page Size on the Page Setup tab, select Custom Size from the Custom Paper Size list.
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The Custom Size Settings dialog box opens.

Custom Sre Settings *
Pager Size
Wik HER L ineh@354-2400
Hesght [ 11882 inchimon- 12583
Lints
Chmen Winch

3. Set the custom paper size

Enter the Width and Height values of the paper to be used, specify the Units, and then click OK.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.

22 Important

« If the application software that created the document has a function for specifying height and width
values, use the application software to set the values. If the application software does not have such a
function or if the document does not print correctly, perform the above procedure from the printer driver
to set the values.

Printing may be disabled depending on the size of the specified user-defined media.

For information about printable sizes for user-defined media, see "Paper Sizes."

* Any paper size that was set by using Custom Size can no longer be used after the application software
is closed.
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3> Note
« If the paper settings in the printer driver differ from the paper information registered on the printer, an
error message may appear on the printer's operation panel. You can still print but you may not be able

to obtain correct print results.
» The maximum configurable size with Custom Size is 3.2m.
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I Set a Custom Size Roll Width

By specifying the roll paper width with a value, you can use roll paper with a width that cannot be selected in
Roll Paper Width.

The procedure for setting custom size roll width is described below.

1. Open the printer driver setup window

2. Select the paper source

From the Paper Source list on the Page Setup tab, select Roll Paper.
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3. Select paper roll width
In Roll Paper Width, select User-defined1 (XXXX) / User-defined2 (XXXX).
The Custom Size Settings dialog box opens.

4. Set paper roll width

Specify Units, enter the roll width you want to use, and then click OK.
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»» Note

« If the value you entered is the same as the other roll widths, a message will be displayed, and the
other roll paper sizes will be set.

5. Complete the setup

Click OK on the Page Setup tab.
If you perform the print, the roll paper with the specified width will be used for printing with each setting

applied.
3> Note

« If the paper settings in the printer driver differ from the paper information registered on the printer, an
error message may appear on the printer's operation panel. You can execute Print, but you may not
obtain the correct printing result.

+ If you select a paper feed method for the custom size roll paper in Get Information... in the Main tab,
Roll Paper Width is set to Custom Size (XXXX).

However, if the same custom size is already set in User-defined1 (XXXX) or User-defined2 (XXXX),
it will not be set to Custom Size (XXXX), and User-defined1 (XXXX) or User-defined2 (XXXX) will be
selected instead.

439



I Printing without Edges Based on the Scenarios

» Printing without Margins to Match Paper Size
» Printing without Margins to Match Roll Paper Width
» Printing Full-Size without Margins

» Three-sided Borderless Printing on Roll Paper
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I Printing without Margins to Match Paper Size

L 9

The procedure for borderless printing by enlarging or reducing documents to match paper size is described
below.

1. In the printer driver, open the settings screen

2. Select the paper source

From the Paper Source list on the Page Setup tab, select Roll Paper.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select borderless printing

Place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as that
of the paper roll loaded in the printer and click OK.

5. Select a method for printing borderless

Select Fit Paper Size in Borderless Printing Method.
If the size of the document is different from the size of the paper you want to print on, select the paper
size you want to print on from Printer Paper Size.

6. Complete the setting process

Click OK.
If you print now, the document will be printed without margins to fit the paper size.

22 Important

« If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered
options in the Layout tab will be displayed in gray out and you will not be able to configure them.

» Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

» When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Automatic Cutting list. When you do so, the document will be
printed without the left and right margins. After the printed material has exited the printer and has been
cut, cut the upper and lower edges with a pair of scissors.

» When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

» The following roll paper supports borderless printing.

= Paper Sizes

+ If margins are formed on the left and right of the document, adjust the amount extending off paper
during borderless printing from the printer's operation panel.
See "Borders appear in borderless printing" for details on how to set the amount extending off paper.

»» Note

» When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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I Printing without Margins to Match Roll Paper Width

Procedure for printing borderless by enlarging/reducing documents to match roll paper width.

1. In the printer driver, open the settings screen

2. Select the paper source

From the Paper Source list on the Page Setup tab, select Roll Paper.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select borderless printing

Place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as that
of the paper roll loaded in the printer and click OK.
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5. Select a method for printing borderless

Select Scale to fit Roll Paper Width in Borderless Printing Method.

6. Complete the setting process

Click OK.
Job will print to the entire roll width without a white border.

32 Important

If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered
options in the Layout tab will be displayed in gray out and you will not be able to configure them.
Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Automatic Cutting list. When you do so, the document will be
printed without the left and right margins. After the printed material has exited the printer and has been
cut, cut the upper and lower edges with a pair of scissors.

When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

The following roll paper supports borderless printing.

= Paper Sizes
If margins are formed on the left and right of the document, adjust the amount extending off paper

during borderless printing from the printer's operation panel.
See "Borders appear in borderless printing" for details on how to set the amount extending off paper.

»» Note

When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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I Printing Full-Size without Margins

Iy

-

Procedure for printing borderless images in the same size as the original document without enlarging/
reducing them.

1. In the printer driver, open the settings screen

2. Select the paper source

From the Paper Source list on the Page Setup tab, select Roll Paper.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select borderless printing

Place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as that
of the paper roll loaded in the printer and click OK.

5. Select a method for printing borderless
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Select Print Image with Actual Size in Borderless Printing Method.

. Complete the setting process

Click OK.
If you print, the document is printed in the original size without white borders.

2% Important

+ If Amount of Extension is set to the second from the right, create the source document with a
size 2mm larger on each of the top, bottom, left and right sides than the size of the paper you wish
to print.

32 Important

If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered
options in the Layout tab will be displayed in gray out and you will not be able to configure them.
Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Automatic Cutting list. When you do so, the document will be
printed without the left and right margins. After the printed material has exited the printer and has been
cut, cut the upper and lower edges with a pair of scissors.

When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

The following roll paper supports borderless printing.

= Paper Sizes

If margins are formed on the left and right of the document, adjust the amount extending off paper
during borderless printing from the printer's operation panel.

See "Borders appear in borderless printing" for details on how to set the amount extending off paper.

»» Note

When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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I Three-sided Borderless Printing on Roll Paper

e

!
J
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In normal borderless printing, paper sizes that match the width of the roll paper are combined to print without
borders on all four sides.

If you use the three-sided borderless printing feature, you can combine paper sizes that don't match the

roll paper width, and print with no borders on three sides. However, if you perform three-sided borderless
printing, you need to cut the right side of the paper after printing.

I Three-sided Borderless Printing to Match Paper Size

The procedure for three-sided borderless printing by enlarging or reducing documents to match paper size
is described below.

1. Open the printer driver setup window

2. Select the paper source

From the Paper Source list on the Page Setup tab, select Roll Paper.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select borderless printing

In the Page Setup tab, place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as
that of the paper roll loaded in the printer and click OK.

. Click Borderless Setting

When the Borderless Setting dialog box is displayed, place a checkmark next to Three-sided
Borderless, and then click OK.
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. Select a method for printing borderless

In the Borderless Printing Method tab, place a checkmark next to the Fit Paper Size option.
If the size of the document is different from the size of the paper you want to print on, select the paper
size you want to print on from Printer Paper Size.

. Complete the setting process

Click OK.
If you print now, the document will be printed without margins on three sides to fit the paper size.

. Cut the right side of the paper

Cut the margin on the right side of the paper with scissors after printing. Cut slightly to the inside of the
margin as the document is enlarged to extend slightly beyond the specified size.

To get the document to standard size, it is recommended to take measurements and cut in the correct
positions.
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I Printing Full-Size without Margins on Three Sides

The procedure for three-sided borderless printing in the same size as the original document without
enlarging or reducing the size is described below.

1. Open the printer driver setup window

2. Select the paper source

From the Paper Source list on the Page Setup tab, select Roll Paper.

3. Select paper roll width

For paper roll width, enter the same value set in the printer under Roll Paper Width.

4. Select borderless printing

In the Page Setup tab, place a checkmark next to the Borderless Printing option.
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After the Information dialog is displayed, under Roll Paper Width, select the same paper width as
that of the paper roll loaded in the printer and click OK.

5. Click Borderless Setting

When the Borderless Setting dialog box is displayed, place a checkmark next to Three-sided
Borderless, and then click OK.
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6. Select a method for printing borderless

In the Borderless Printing Method tab, place a checkmark next to the Print Image with Actual Size
option.

7. Complete the setting process

Click OK.
If you print now, the document will be printed without margins on three sides while retaining the same
document size.

8. Cut the right side of the paper

Cut the margin on the right side of the paper with scissors after printing.
To get the document to standard size, it is recommended to take measurements and cut in the correct

positions.
L ) ' o L
2 &
22 Important

If you place a checkmark next to the Borderless Printing option, the Page Layout and Print Centered
options in the Layout tab will be displayed in gray out and you will not be able to configure them.
Depending on paper size, the length/width ratio of the paper may be different from that of the image,
making it impossible for the whole image to fit on the paper.

When this happens, crop the image with the application software to match paper size.

When printing borderless, printing may stop abruptly and the paper will be cut causing a slight color
unevenness on the edges of the paper. If you require exceptionally high quality, in the Roll Paper
Options dialog box select No from the Automatic Cutting list. When you do so, the document will be
printed without the left margin. After the printed material has exited the printer and has been cut, cut the
upper, lower, and right edges with a pair of scissors.

When printing borderless on paper with low ink-fixing properties, depending on frequency of use, the
cutter unit may come into contact with the paper surface scratching it and causing the paper to be
unevenly cut.

You may be able to improve the situation by clicking Specify... on the Main tab and, in the Paper
Detailed Settings dialog box, under Drying Time, set Between Pages to a higher value.

The following roll paper supports borderless printing.

= Paper Sizes
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+ If margins are formed on the left of the document, adjust the amount extending off paper during
borderless printing from the printer's operation panel.
See "Borders appear in borderless printing" for details on how to set the amount extending off paper.

»» Note

» When using applications like Microsoft Word which allow you to set margins, set margins to 0 mm.
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Printing Hanging and Horizontal Banners (Large-Format
Printing)

A drapery or banner up to 18.0m can be made by enlarging or reducing original documents made on
application software.

However, there are cases in which an 18.0 meter banner cannot be printed because the application
software used has limits on the document size that can be set.

The procedure for printing hanging and horizontal banners is as follows:

| Print for width of roll

1. Create document by using application software

2. Open the printer driver setup window

3. Select the paper size

Select the same original paper size created in the application soft in the Page Setup tab's Page Size.
In the event an optional size is set in the application software, select Custom Size from Custom
Paper Size in Page Size and designate size in the dialog box that appears.

4. Select roll width

Select the equivalent to the paper width of the roll set in the printer under Roll Paper Width.

5. Set Enlarged/Reduced Printing

Check Enlarged/Reduced Printing and select Fit Roll Paper Width.
When the Information dialog box appears, select the equivalent to the paper width of the roll set in
the printer.
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6. Complete the setup

Click OK.
When printing is executed, a drapery or banner can be printed according to the roll.

I Enlarge and print

1. Register user-defined paper

Register both the actual desired print size (user-defined paper 1) and original document size created
in application (user-defined document size 2) in the Size Options... under the Page Setup tab.

»» Note

» Please set user-defined paper 2 to the same aspect ratio as user-defined paper 1. If the aspect

ratio differs, the enlarged image may not turn out to be the expected size.
After creating user-defined paper 1, if user-defined paper 2 is created after checking Fix the
Ratio of the Width to Height, settings can be set to the same aspect ratio.
Also set user-defined paper 2 to a size that doesn't exceed the maximum size supported by the
application.

For example, when printing on paper 600mm wide and 3,000mm long, use the following
settings.

(when setting length to 1/6 the user-defined paper)

— User-defined paper 1: Width 600mm, Height 3,000mm

— User-defined paper 2: Width 100mm, Height 500mm

2. Create original document in application software

Use the registered user-defined paper 2 size to create original document using an application.
3. Open printer driver settings screen

4. Select Paper Size

Select registered user-defined paper 1 from Custom Paper Size in Page Setup tab's Page Size.

5. Complete the setup

Click OK.
When you print, the hanging or horizontal banner is printed by using the user-defined size.

»» Note

+ Maximum printable length is 18.0m. In the event the enlarged length exceeds 18.0m, the part of the
image exceeding the length will not be printed.

« If printing cannot be performed correctly, you may be able to improve printing by using the Special
Settings dialog box on the Layout tab to change FineZoom Settings to Yes.

453



I Printing by Dividing/Joining Documents

» Inputting Multiple-file Documents into Free Layout plus
» Lining Up and Printing Multiple Documents to Cut Sheets

» Printing by Connecting Multiple Pages

¥

Printing Multiple Pages All on One Page

» Dividing and Printing Posters
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I Lining Up and Printing Multiple Documents to Cut Sheets

You can line up multiple documents that were created separately and print them together on one page.
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You must install imagePROGRAF Printer Driver Extra Kit to use this function. Go to the Canon website,
download imagePROGRAF Printer Driver Extra Kit, and then install it

The procedure for lining up and printing multiple documents to cut sheets is as follows:

1. Open the printer driver setup window

2. Select Free Layout

On the Layout tab, select the Page Layout check box, and then from the pull-down menu, select Free
Layout.
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3. Complete the setup

Click OK.
When you print, Canon imagePROGRAF Free Layout starts. Canon imagePROGRAF Free Layout
allows you to edit and rearrange images.
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»» Note

» To lay out multiple application software documents onto one page, repeat steps 1 to 3 without
closing the Canon imagePROGRAF Free Layout window.
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I Printing by Connecting Multiple Pages

Print documents with several pages as one continuous document. When you do this, the spaces between
the pages will be removed.

The procedure for printing by connecting multiple pages is as follows:

1. Open the printer driver setup window

2. Select the paper source

For Paper Source on the Page Setup tab, select Roll Paper.
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3. Set roll paper options

Click Roll Paper Options to display the Roll Paper Options dialog box.
Select the Banner Printing check box, and then click OK.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.
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4. Complete the setup

Click OK on the Page Setup tab.
When you print, the document is printed with the print conditions you set.
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I Printing Multiple Pages All on One Page

The page layout printing function allows you to print more than one page image on a single sheet of paper.

The procedure for printing multiple pages all on one page is as follows:

1. Open the printer driver setup window

2. Select the print paper size

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.
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3. Set number of pages to be printed per sheet

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select 2 Pages/
Sheet, 4 Pages/Sheet, 6 Pages/Sheet, 8 Pages/Sheet, 9 Pages/Sheet, or 16 Pages/Sheet.
The current settings are displayed in the settings preview on the left side of the window.
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. Set the number of pages to be printed on one sheet and the page order

If necessary, click Set..., specify the following settings in the Page Layout Printing dialog box, and click
OK.
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Page Order
To change the page arrangement order, select a placement method from the list.

Page Border
To print a page border around each document page, select something other than None from the list.

. Complete the setup

Click OK on the Layout tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in the
specified order.

2» Important

* When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on the
Page Setup tab, Page Layout is grayed out and cannot be set.

« If Spooling at Printer Driver in Special Settings dialog box is set to No (Use RAW Spooling),
Page Layout is grayed out and cannot be set.
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| Dividing and Printing Posters

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. You can also paste the pages together to create a large print like
a poster.

The procedure for dividing and printing posters is as follows:

I Setting for Dividing and Printing Posters

1. Open the printer driver setup window

2. Select the print paper size

From the Page Size list on the Page Setup tab, select the size of the paper loaded in the printer.
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3. Set number of divisions

On the Layout tab, select the Page Layout check box, and from the pull-down menu, select Poster (1
x 2) or Poster (2 x 2).
The current settings are displayed in the settings preview on the left side of the window.
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4. Complete the setup

Click OK on the Layout tab.
When you execute print, the document will be divided into several pages during printing.

3% Important

* When there is a checkmark next to Banner Printing under Roll Paper Options dialog box on
the Page Setup tab, Page Layout is grayed out and cannot be set.

+ If Spooling at Printer Driver in Special Settings dialog box is set to No (Use RAW
Spooling), Page Layout is grayed out and cannot be set.

I Printing Only Specific Pages

If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the
procedure below:

1. Display Pages to Print dialog box

For Page Layout, click Set... to display the Pages to Print dialog box.

2. Set print range

Clear the check boxes of the pages you do not want to print.

In the setting view, the pages that you cleared are deleted and only the pages to be printed are
displayed.

Check the pages to be printed, and then click OK.
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3> Note
* In the setting view on the left side of the Pages to Print dialog box, you can also clear the
display by clicking the pages you do not want to print.

To redisplay a cleared page, click that page again.
» To switch the pages to display/hide, click Invert in the Pages to Print dialog box.

3. Complete the setup

Click OK on the Layout tab.
When you print, only the specified pages are printed.

22 Important
« If you partition and print as a poster, the source document will be printed in enlarged form, so the print

results may become rough.
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I Printing Document in Center of Paper

When you want to position the source document in the middle of the cut paper and print, or print with even
margins on the right and left in relation to the width of the roll paper, use the Print Centered function.

The print results when setting with Print Centered are as follows. Normally, if Print Centered is set when
printed as in (A), it will be printed as in (B) for cut paper and (C) for roll paper.
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»>» Note

* When setting the magnification using Scaling from Enlarged/Reduced Printing on the Page Setup
tab and printing, the start point for enlarge/reduce will always be fixed based on the top left corner of
that page. For that reason, for reduced printing, the bottom and right margins of the paper will increase.
At this time, if you place a checkmark next to Print Centered on the Layout tab, the top, bottom, left
and right margins can all be printed evenly.

The procedure for printing in the center of the paper is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select the paper size

Select the size of the paper you want to print from Page Size on the Page Setup tab.
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4. Set magnification as necessary
Where necessary, attach a checkmark next to Enlarged/Reduced Printing, and set according to the

objective.

5. Select the paper source

For Paper Source, select the setting that matches your purpose.

6. Select roll paper width
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If you selected a roll paper for Paper Source, set Roll Paper Width to the width of the roll paper loaded
in the printer.

7. Print document in the center of paper

Select the Print Centered check box on the Layout tab.
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8. Complete the setup

Click OK.
When you print, the document is printed in the center of the paper.
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I Printing by Saving Roll Paper

» Saving Roll Paper by Rotating Document 90 Degrees

» Saving Roll Paper by Eliminating Upper and Lower Margins on Document
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I Saving Roll Paper by Rotating Document 90 Degrees

When printing a portrait document on roll paper, you can save paper by rotating the document 90 degrees
and printing the document so that it is oriented horizontally relative to the paper.

The procedure for saving paper by rotating the document 90 degrees is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select the paper size

Cator
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From the Page Size list on the Page Setup tab, select the same size as that of the document that was

created with the application software.

4. Select the paper source

In Paper Source, select Roll Paper.

5. Selecting Paper Saving

Select the Rotate Page 90 degrees check box.

The current settings are displayed in the settings preview on the left side of the window.
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6. Select roll paper width
For Roll Paper Width, select the width of the roll paper loaded in the printer.
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7. Complete the setup

Click OK.
When you print, you can rotate a portrait document 90 degrees to save paper.

22 Important
» When there is a checkmark attached to Banner Printing on the Page Setup tab, Rotate Page 90

degrees is grayed out and cannot be set.
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* When selecting paper in portrait format as the Page Size from the Page Setup tab, if the length in the
vertical direction is longer than the width selected in Roll Paper Width, even if a checkmark is placed
next to Rotate Page 90 degrees, the page will not be rotated.
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Saving Roll Paper by Eliminating Upper and Lower Margins on
Document

When printing on roll paper, you can save paper by reducing the upper and lower margins when printing

The procedure for saving paper by reducing the upper and lower margins is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select the paper size

From the Page Size list on the Page Setup tab, select the same size as that of the document that was
created with the application software.
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4. Select the paper source

For Paper Source, select Roll Paper.

5. Select roll paper width

For Roll Paper Width, select the width of the roll paper loaded in the printer.

6. Selecting Paper Saving

On the Layout tab, select the No Spaces at Top or Bottom check box.
The current settings are displayed in the settings preview on the left side of the window.
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7. Complete the setup
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Click OK.
When you print, the upper and lower margins are reduced so that you can save paper.
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I Switching the Paper Source to Match the Purpose

This printer has two paper sources: Roll and Cut Sheet.
You can facilitate printing by selecting a paper source setting that matches your media type or purpose.

The procedure for setting paper source is as follows:

1. Open the printer driver setup window

2. Select the media type

Select the type of paper loaded in the printer from the Media Type list on the Main tab.

3. Select the paper source

From the Paper Source list on the Page Setup tab, select the paper source that matches your purpose.
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Roll Paper
Feeds paper using roll paper.

Cut Sheet
Feeds paper using the cut paper.

4. Complete the setup

Click OK.
When you execute print, the printer uses the specified paper source to print the data.

»» Note

« |If the paper settings in the printer driver differ from the paper information registered on the printer,
an error message may appear on the printer's operation panel. You can still print but you may not
be able to obtain correct print results.
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I Displaying the Print Results before Printing

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.
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3. Complete the setup

Click OK.
When you execute print, the Canon imagePROGRAF Preview opens and displays the print results.

I Related Topic

= Canon imagePROGRAF Preview
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I Link with PosterArtist to print with bright colors

With PosterArtist, you can import the data you want to print, and then edit fluorescent spot colors and check
print results using the preview function.

1. Open printer driver's setup screen

2. Link with PosterArtist
Add a checkmark to Edit fluorescent spot colors in PosterArtist in the Main sheet.
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3. Start PosterArtist

Click OK.
When you start printing, PosterArtist will start, and the Page Capture window will open.

4. Select Pages to Import with PosterArtist

5. Edit the page in PosterArtist

Follow the instructions displayed on the PosterArtist screen to operate.
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I Specify Fluorescent Colors and Print

You can set specific RGB values in advance for text and figures that are painted over (single-color painting)
with the color palette of the application you are using, and print the specified sections of posters with bright
colors using fluorescent ink.

1. Select Advanced Settings
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2. Add a checkmark to Fluorescent Spot Color Set becomes active.

Set becomes active.

3. Click Set

The color palette will be displayed.
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You can print the color palette from the printer operation panel. Print to the paper of your choice, and set
the RGB values as you check the colors.

= Test print
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. Add a checkmark to the color of the fluorescent ink you want to print with

Print

The color that you added the checkmark for will be brightly printed.
We recommend that you add a checkmark to Preview before printing to confirm how the color you
checked will appear when printed.

»» Note

When printing by specifying fluorescent colors, the RGB values set by the application software must be
retained when being input to the printer driver. If color management is performed during printing by the
application software, the RGB values are not retained, and therefore may not produce the desired print
results. If this happens, configure the settings on the application software as follows.

For detailed instructions on settings, see the user's guide of the application software you are using.

— Disable color management and color adjustment functions during printing.

— Configure settings so that color management during printing is performed by the printer.

— For color management during printing, specify the same profile as the document profile.

Under the following conditions, printing may not produce the desired results.
— Text or shapes that have been shaded, rotated, or anti-aliased
— Data with specified RGB values that were saved in GIF format

Sections that are close to the specified RGB values will also be printed with bright colors.
If you want to print gradations using fluorescent ink, configure Poster (Fluorescent) in Print Target
under Easy Settings.
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I Other Convenient Settings

» Stamp Printing
» Setting a Page Size and Orientation
» Registering a Frequently Used Printing Profile

» Cutting Roll Paper after Printing
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I Stamp Printing

The Stamp function allows you to print a stamp text over or behind document data.
"DRAFT," "CONFIDENTIAL," and other stamps that are used often in companies are pre-registered.

The procedure for printing with a stamp is as follows:

1. Open the printer driver setup window

2. Select stamp

On the Layout tab, select the Stamp check box, and then select the stamp to use from the list.
The current settings are displayed in the settings preview on the left side of the Layout tab.
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3. Complete the setup
Click OK.

When you execute print, the data is printed with the specified stamp.

22 Important

» Depending on your usage environment, you may not be able to use the Stamp function. In this case,
set Spooling at Printer Driver in the Special Settings dialog box to Yes.
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I Registering a Stamp

You can create and register a new stamp. You can also change and re-register some of the settings of an
existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:

I Registering a New Stamp

1. Open the printer driver setup window

2. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
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The Define Stamp dialog box opens.
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3. Set stamp details

Click Add to add a new stamp (Untitled) to the list.

In Name, enter the name of the stamp to register, and in Text, enter the character string you want as
the stamp.

Change the Font, Style, Size, and Color settings as necessary.

4. Set the other items

Set the following items as necessary.

Outline

Selects a frame that encloses the stamp text string.

Print Style
Select the stamp print method.

Select Transparent to print the stamp on the back of the document, and select Overlap to print it
on the front.

Position
Specifies the stamp position on the page.
Enter numbers in X and Y to set the coordinates, or drag the horizontal and vertical slide bars to
the left/right or up/down to change the settings.

Angle
Set the stamp placement angle.
Enter a number in Set Angle to set the angle, or drag the slide bar to the left/right to change the
setting.
Set the angle by entering a number in range of -180 to 180.

Stamp first page only
To print the stamp on the first page only, select this check box.
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5. Complete the setup

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

I Changing and Registering Some of Stamp Settings

1. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp for which the settings are to be changed

From Stamps, select the title of the stamp you want to change the settings for.
3. Configure each setting while viewing the preview

4. Complete the setup

Click OK to return to the Layout tab.
The registered title appears in the Stamp list.

»» Note

» The stamp registered as the default setting cannot be changed.

I Deleting an Unnecessary Stamp

1. Select stamp

On the Layout tab, select the Stamp check box, and click Define Stamp....
The Define Stamp dialog box opens.

2. Select the stamp to be deleted

Select the title that you wish to delete from the Stamps and click Delete.
Click Yes when the confirmation message appears.

3. Complete the setup
Click OK to return to the Layout tab.
3> Note

» The stamp registered as the default setting cannot be deleted.
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I Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size
and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the
application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size
and orientation is as follows:

1. Open the printer driver setup window

2. Select the paper size

Select a page size from the Page Size list on the Page Setup tab.
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3. Set Orientation

Select Portrait or Landscape for Orientation. Check Rotate Page 90 degrees check box when you
want to perform printing with the original being rotated 90 degrees.

4. Complete the setup

Click OK.
When you execute print, the document will be printed with the selected page size and the orientation.
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I Registering a Frequently Used Printing Profile

You can register the frequently used printing settings to Favorites. Unnecessary printing profiles can be
deleted at any time.

The procedure for registering a printing profile is as follows:
I Registering a Printing Profile

1. Open the printer driver setup window

2. Set the necessary items
On the Main tab, the Page Setup tab, and the Layout tab, specify the print settings you want to
register.

3. Display Add dialog box

On the Favorites tab, click Add....
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4. Register favorite setting
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In Name, enter the name of the favorite. Set the Icon and Comment fields as necessary, and then
click OK.

The name and the icon appear in the Favorites list.

To check the settings of the registered favorite, click Settings Details.

»» Note

» To save the settings of the favorite to a file, click Export... on the Favorites tab.

I Printing Using Favorite Settings
1. Open the printer driver setup window

2. Apply favorite

From the Favorites list on the Favorites tab, select the favorite you want to use.
Click Apply Favorite to replace the registered print settings.

3. Complete the setup

Click OK.
When you print, the document is printed with the settings of the registered favorite.

I Deleting Unnecessary Printing Profile

1. Select favorite to be deleted

Select the favorite you want to delete from the Favorites list on the Favorites tab.

2. Delete setting

Click Delete. When the confirmation message appears, click OK.
The selected favorite is deleted from the Favorites list.

»>» Note

* Printing profiles that are registered in the initial settings cannot be deleted.

» The settings of the favorite being applied to the current print settings cannot be deleted. To delete
that favorite, select another favorite from the Favorites list, click Apply Favorite to apply the settings
of that other favorite, and then delete the target favorite.
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I Cutting Roll Paper after Printing

The procedure for cutting roll paper automatically and printing cut guidelines is as follows:

1. Open the printer driver setup window

2. Select the paper source

For Paper Source on the Page Setup tab, select Roll Paper.

= Canon Priefting Preferences }‘"
Man  Page Setp Lpend  Favodtes  Lbity

Bl poge 5w Letier 355117 =

[ Bordadass Prrting
Lstier (25" 0117 &L - = g
ESbimxiidhin S 43 Page S

Letier (B.5%117) [T

EShinz 1100 n

A @ roan A CiLansicnpa

o
T DlRotme Page 90 degrees

I?mﬂul.me- Rl Paper - I
Fodl Pagsr ek 24 i Riod §E09 fmm) bt
Faoll Paper Optiores_
Chatnd Masthad S Cptons. Defmits

ok ][ cones | [ omw te

3. Display Roll Paper Options dialog box

Click Roll Paper Options to display the Roll Paper Options dialog box.

Roll Paper Optazns x
Sutoritic Cutting Tea -
[l Barrer Prrting

Cancal Delbts Help

4. Set auto cut

From Automatic Cutting, select the item that matches your purpose.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

* Yes

The roll paper is cut automatically after printing.
* No

The roll paper is not cut after printing.
* Print Cut Guideline

Cut guidelines are printed for cutting the roll paper manually after printing.
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»» Note

» The default setting for automatic cutting is Yes.
After completing the setting, click OK to return to the Page Setup tab.

5. Complete the setup

Click OK on the Page Setup tab.
When you print, the status after printing is set to whatever was set in Automatic Cutting.
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I Printing from Printer

» Printing Data Saved on USB Flash Drive
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I Printing Data Saved on USB Flash Drive

You can print photo data (JPEG file) or document data (PDF file) saved on the USB flash drive easily.
¥>» Note
* Restrictions on printable PDF/JPEG files
— PDF file:
Files which conforms to V 1.7
-Does not support overprint or some of transparent processing.

-Font embedding is recommended. If a font is not embedded, it is replaced with one of the built-in
fonts below.

Times-Roman, Helvetica, Courier, Symbol, Times-Bold, Helvetica-Bold, Courier-Bold,
ZapfDingbats, Times-lItalic, Helvetica-Oblique, Courier-Oblique, Times-Boldltalic, Helvetica-
BoldOblique, Courier-BoldOblique

— JPEG file:
Files which conforms to JFIF 1.02
Supports the files with the following conditions.
-Processing method: Basic DCT
-Color mode: RGB/GrayScale
-Number of colors: 24bit/8bit
-Number of pixels: 38400 or less vertically and horizontally

Does not support some samplings

1. Load paper.

= Loading Rolls in the Printer
= | oading Sheets in the Printer

2. Insert USB flash drive into USB flash drive port.

3. Tapon (Print from USB flash drive) displayed on the top right of the HOME screen.
»» Note

* When the message informing you that the operation restriction is enabled, ask the administrator of
the printer you are using.

+ If no printable data is saved on the USB flash drive, There are no files that can be printed. is
displayed on the touch screen.

4. In the list, tap folder or data to print.
Tapping a folder displays the data list. Tap the data to print.
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»» Note

« If no printable data is saved on the folder you tapped, There are no files that can be printed. is
displayed on the touch screen.

The following screen is displayed.

A
@ .
Sky.jpg
[ Settings l Start print
| c

A. Number of copies

Tap to display the screen below and specify the number of copies.

1 &
Skyjpg L1 )L 2 )| 3
4 5 6
73 8 9
Sett 0 OK
B. Preview

Tap to preview an image of the printout on the preview screen.

C. Settings

Tap to display the Settings screen. You can check and change the print settings.

Print settings
Color Color {saturation)
Print glty 3
Target Photo
Apply

5. Tap Start print.

The following screen is displayed.
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Please select something to print.

All pages
Specify page
All pages

Tap to start printing all pages.

Specify page
Tap to specify a page to print. Tap OK to start printing the specified page.

»» Note

» Tapping Yes on the displayed screen returns to step 4. Tapping No returns to HOME screen.
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I Printing from Smartphone/Tablet

For more on printing from a device, refer to the device's or application's instruction manual.

» Print Easily from a Smartphone or Tablet with Canon PRINT Inkjet/SELPHY

» Printing from iOS Device (AirPrint)
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I Enlarging Copy with imageRUNNER ADVANCE

Copy scanned with imageRUNNER ADVANCE can be sent to the printer via FTP.

I Enable FTP from Remote Ul.

1. Start up Remote UI.

= Start up Remote Ul

2. Select System info and LAN settings.
3. Select LAN settings.

4. Select Advanced setup.

5. Confirm displayed message and tap Yes.

6. Select FTP settings.

Advanced setup

Prirter sistus Seb printer nams
Urtilithes TCPAP settings
Printer settings VWD settings
RirPrint sattings Banpour setbngs
Job mansgement LPD print
Security SHIAP Jettings

Sysiem info and LAN ssttings SNTF semings

o

Langisege sebection IPF Settings
Banual [Onsing) CHMP sellings
Downiload furmmware NS Butangs

P Enering

MAL sddress SHering seflings

Reset LAN settings

7. Select Enable.
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FTP settings

Disablas
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8. Select Use authentication check box and Set/change password check box, and then
enter a user name and password.

The user name and password you enter in this step are used for FTP authentication.

Enter the same value for FTP settings of imageRUNNER ADVANCE.

9. Select OK.

Please wait momentarily appears and returns to the startup screen.

10. Close web browser.

I Perform enlarge settings on the operation panel.

&

1. TapL__— | (Setup) on HOME screen.

= Home Screen Menu Composition

2. Tap Printer settings.
3. Tap Print settings.
4. Tap Direct print settings from FTP.

5. Select the number to set and tap.
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Direct print settings from FTP

Print settings 1
Print settings 2

Print settings 3

Print settings 4

See the following two types of enlargement setting methods.

= Fitting to Paper Width
= Specifying Magnification Level

I Scan and enlarge copy

1. Place the copy on the platen glass or feeder of imageRUNNER ADVANCE.

2. Select Scan and Send.

4. Tap File.
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5. Tap FTP from the Protocol drop-down list.
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Enter the printer's IP address as the Host Name.

»» Note

» We recommend that you set a fixed IP address for your printer.
Enter "./folderN" in Folder Path. ("N" represents the print setting number specified in the Direct print

settings from FTP screen on the printer.) For example, to enter the pathname for Print settings 1,
enter "./folder1". For Print settings 2, enter "./folder2".

Use the same User Name and Password that you set for FTP authentication in the Remote UI.
7. Tap OK.

8. Tap the setting button for file format.
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9. Select File Format.

Select PDF or JPEG.

ali b s i bl
Yo Y bt 2, e P e it v

W PTG T e A el
ot (o ik A e 10 e
el £
= E' o e
- [ i, | et - ——
L e (] e
Al e
- ————
iy [T Lol
o | .:;‘I.q.
j | Svede g x, Fende &Y
Uy rpge * % Sl s * ey b
= Eans - o = [ = o

»» Note

« If you select PDF, remove the check from the Compact and Encrypt check boxes.

10. Specify the settings as necessary.

Er
PRI

32 Important
» Select 300x300 dpi or 600x600 dpi as the resolution.

11. Press @' (Start).

If you are placing your originals on the platen glass, press @ (Start) to scan each original.

12. When scanning is complete, tap Start Sending.
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Scanned originals are sent to the printer and printing starts.

¥ Note

* It is recommended to register the setting contents in Favorite Settings.
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| Fitting to Paper width

1. Tap Paper settings.

Print settings 1

Print quality settings

[Paper settings

Line & pen manager

Processing options

2. Tap Enlarge/Reduce.

Paper settings

Save paper
Rotate

Auto rotation

[ Enlarge/Reduce sy ]

3. Tap Fit paper size.

—= Fit paper size

Save Same size

Rotar Scaling

Auto

»» Note

+ Change the image quality in Print quality settings if necessary.
* You can specify the orientation of the image from Rotate.
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I Specifying Magnification Level

I Setting Input resolution

1. Tap Print quality settings.

Print settings 1

[Print guality settings ]

Paper settings
Line & pen manager

Processing options

2. Tap Input resolution.

Print quality settings

Color mode

Print quality

[Input resolution

Print target

Select the input resolution that matches your output requirements.

600 dpi
Select when printing at 600 dpi.

300 dpi
Select when printing at 300 dpi.

Specify print job
Select to match the input resolution of the printer with the scanning resolution when scanning the
original in JPEG format.

32 Important

* When scanning the original in JPEG format with imageRUNNER ADVANCE, match the
scanning resolution with the input resolution of the printer. If the resolution is different, it will
not be printed at the specified magnification level.

I Setting scale percentage

1. Tap Paper settings.
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Print settings 1

Print quality settings

[ Paper settings

Line & pen manager

Processing options

2. Tap Enlarge/Reduce.

Paper settings

Save paper
Rotate

Auto rotation

[ Enlarge/Reduce ;., __»_\]

3. Tap Scaling.

T Fit paper size

Save
Same size
Rotat
[ Scaling
Auto

4. Tap A on the displayed screen.

Scaling

(25-400)%

(o

| OK

5. Enter the scale percentage, and then tap OK.

501



Scaling 2 8

L= | R B

For commonly used magnification conversions, refer to Reference for Magnification.

6. Select OK on the displayed screen.

Scaling

(25-400)%

283

ok |

»» Note

* Change the image quality in Print quality settings if necessary.
* You can specify the orientation of the image from Rotate.

Reference for Magnification
* ISO A format

Original size
A4 A3
A4 100% 71%
A3 141% 100%
Output size A2 200% 141%
A1 283% 200%
A0 400% 283%
* ANSI format
Original size
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Letter Legal Ledger
8.5"x 11" 8.5" x 14" 11" x 17"
C 200% 157% 129%
Output size D 258% 242% 200%
E 400% 314% 258%
* ARCH format
Original size
A B
A 100% 66%
B 133% 100%
C 200% 133%
Output size
D 266% 200%
E 400% 266%
E1 333% 233%
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I Printing with Fluorescent Ink

Create items such as posters in bright and vivid color tones using fluorescent ink.

I Using Vivid Color Tones

There are two ways to make your item vivid.

Printing the Entire Item Vividly (Vivid mode)
Make all warm colors bright and vivid.

This is recommended when a photo or illustration contains multiple warm colors such as pink and
orange.

Printing Colors of Specific Areas Vividly (Spot mode)
Make specific colors bright and vivid using pink or orange fluorescent ink.

This is recommended when you want to enhance text or shapes.

504



o

- Happy

I Creating Vivid Items

In Windows, you can use PosterAtrtist, an application for creating professional-looking posters even
without professional knowledge or technique; simply select a design from a variety of templates and then
insert and edit text, photos, clipart, and other materials.

Use PosterArtist to quickly create a bright and vivid item by selecting a template and specifying colors for
text and shapes. There is also a function for previewing only the area that will be vivid. For details, see
Creating Vivid Posters Using Fluorescent Colors.

23> Note

» Even for items you created in your application, you can use PosterArtist to make them vivid by
specifying pink or orange fluorescent ink for specific portions. For details, see Link with PosterArtist to
print with bright colors.

* You can also open the printer driver from your application and specify the setting for making color
tones vivid in the print settings screen. For details, see Printing By Setting Print Purpose or Specify
Fluorescent Colors and Print.

* If using macOS, create an item in your application, and then see Printing with Easy Setup or Specify
Fluorescent Colors and Print and print.
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I Printer Driver

» Windows Printer Driver

» macOS Printer Driver

506



I Windows Printer Driver

» Overview of the Printer Driver
» Printer Driver Description

» Updating the Printer Driver

507



I Overview of the Printer Driver

>

>

Canon IJ Printer Driver

Changing the Print Options

Canon imagePROGRAF Preview

How to Open the Printer Driver Setup Window
Updating Media Information in Printer Driver
Setting Accounting Information

Set a PIN Code for Print Jobs

Deleting the Undesired Print Job

Canon |J Status Monitor

Instructions for Use (Printer Driver)
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I Canon |J Printer Driver

The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for
printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can
understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific
model you are using.

I Installing the Printer Driver

To install the printer driver, install the driver from the Setup CD-ROM or our website.

I Specifying the Printer Driver

To specify the printer driver, open the Print dialog box of the application software you are using, and
select "XXX" (where "XXX" is your model name).

I Displaying the Manual from the Printer Driver

To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

I Related Topic

= How to Open the Printer Driver Setup Window

509



I Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Check this check box if part of the image data is cut off, the paper source during printing differs from the
driver settings, or printing fails.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click Special Settings... on the Layout tab

== Cancn Primting Preferences x

Man  Page Setp LEd  Frvodes  Lbity

I Fage Lapoa: ﬁ Posier (Fu 2

&
I

[ seame: CONFIDENTIAL

Define Stamp.

Letier (B.5X117) .
£SO 1100 n _|| ] Pt Certarnd
=R

4+ Acsiual Size
Letier (E5°%117)
B0y 11008 H_J'ﬁ [[] Astare 180 dogrees

s
_‘J I Ma Spaces o Top o Bomom

{

[ ]
ﬂhw:lmLHPapu

Page Dptiors... Defrtn

oK Cancel Foply Help

The Special Settings dialog box opens.

Special Settings *
Cstiings Summan
Paramater Setud
Spooing = Prnter Dever
FineZoom Sefings Aol
Presiene Swichang o
Apobeaten Color Mptching Pricety On
Fasl Graphs: Pracess On
Duzabia tha color profiie setting of the applcation software OF
Zpeciy Pattem Fleschition e
Spockng ot Frnter Driver:
[ve v
G Detnts re

3. Change the individual settings

If necessary, change the setting of each item, and then click OK.

The Layout tab is displayed again.
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I Canon imagePROGRAF Preview

The Canon imagePROGRAF Preview is an application software that displays what the print result will look
like before a document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main
tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.

I Related Topic

= Displaying the Print Results before Printing
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I How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

I Open the Printer Driver Setup Window through the Application Software

Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)

The printer driver setup window appears.

»» Note

» Depending on application software you us